
StockMarketEye User’s Guide
Release 4.2

Keep Your Eye On Your Investments

www.stockmarketeye.com

©2017 TransparenTech LLC

November 16, 2017

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=titlepage&utm_campaign=sme




CONTENTS

1 Introduction to StockMarketEye 5

2 Installation Instructions Index 9

3 Ticker Symbols and Data Providers 17

4 Portfolios - Tracking Your Investments 59

5 Watchlists - Monitoring the Markets 187

6 Stock Alerts 207

7 Stock Charts 223

8 General Features and Documentation 231

9 Other Features and Documentation 283

i



ii



www.stockmarketeye.com StockMarketEye User’s Guide, Release 4.2

• Introduction to StockMarketEye New users start here!

Additional getting started info for Canadian, UK, Australian, Euro and other non-US users.

• Ticker Symbols and Data Providers

– Ticker Symbol Lookup and supported Data Providers

– ...More about ticker symbols...

• Portfolios - Tracking Your Investments

– Manage Your Portfolios

* Creating and Deleting a Portfolio

* Portfolio Properties

* Getting Current Quotes for your Portfolio

* Managing your Cash Balance

* Buying and Selling

* Tracking Bonds and Other Non-Quoted Securities

* Entering Dividends, Capital Gains and Return of Capital

* Entering a Stock Split

* Recording Mergers and Acquisitions

* Recording a Corporate Action (i.e. Spin-Off)

* Handling a Stock Delisting

– Importing Data from a Brokerage

* Brokerage Import and our Best Practices

* Placeholder Transactions and How To Handle Them

* Getting the Latest Transactions from your Account

* Supported Brokerages

– Measuring Investment Performance

* Individual Investment Performance Metrics

* Comparing Performance to a Benchmark

* Cost Basis Calculations

– Reports

* The Transactions Report, including editing and deleting transactions, and exporting to CSV .

* The Summary Report

* The Gain/Loss Report

* The Back-in-Time Report

– Portfolio Groups and Investment Categories

* Managing Grouped Portfolios

* Using Grouped Portfolios

* Investment Categories

CONTENTS 1

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

– Other Portfolio Related Topics

* Rebuild Your Portfolio From Its Transactions

* Changing A Holding’s Ticker Symbol

* Changing A Holding’s Currency

* Transaction Accuracy and Completeness

• Watchlists - Monitoring the Markets

– Creating and Deleting a Watchlist

– Bulk Add Symbols To A Watchlist

– Resetting Watchlist Values

– ...More watchlist documentation...

• Stock Alerts

– Stock Alert Management

– ...More stock alerts documentation...

• Stock Charts

– Comparison Charting

– Importing Historical Quotes

– Reload Chart Data

• General Features and Documentation

– Backup / Restore

* Backing Up and Restoring Your Data

* Automatic Backup

– On-Line Sync

* On-line Synchronization

* Synchronizing Data in the Desktop Version with the iOS Version

* Synchronizing Data in the Desktop Version with the Android Version

* Synchronizing Data Between Two Desktop Versions

* Synchronizing Data from one iOS Device to Another

– Editing Data

* Editing Values In-Line

* Overiding The Last Price

* Changing The Name Of A Security

– Configuring Columns

* Configuring Columns

* Available columns...

– Preferences

* Password Protecting Your StockMarketEye Data

2 CONTENTS

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


www.stockmarketeye.com StockMarketEye User’s Guide, Release 4.2

* Changing the Font Size

– Other Features

* Installing Your StockMarketEye License Key

• Other Features and Documentation

– The StockMarketEye Log File

– Changing the Location of Your Data Files

– Moving Your Data to a New Machine

– Starting From Scratch Using a Backup File

– “We have detected another instance of StockMarketEye running on your computer.”

– Recovering from Fatal Errors

– How To Run From A Portable/External Drive

– ...MORE advanced features and documentation...

CONTENTS 3

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

4 CONTENTS

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


CHAPTER

ONE

INTRODUCTION TO STOCKMARKETEYE

StockMarketEye is a powerful, yet easy-to-use application for tracking your investments and following the changes in
your favorite stocks. Its simple, elegant and intuitive interface saves you time when doing market and stock analysis,
while its investor friendly tools give you the information you need to make informed investment decisions.

In this section, you’ll discover the key features of StockMarketEye so that you can get started quickly.

• The StockMarketEye Window
• The First Time You Run StockMarketEye
• What is a Portfolio?
• What is a Watchlist?
• What is a Stock Chart?
• What are Stock Alerts?
• Views of your Data
• Stock Symbols and Quotes

1.1 The StockMarketEye Window

The first time you run StockMarketEye, you will see a window similar to this one:

There are 3 main sections in the StockMarketEye window.

5



StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

1. Folders : The left side of the window is the folders section. It lists your portfolios and watchlists. When you
click on one of the Portfolio or Watchlist names in the folders section, that folder will be displayed in the upper
portion of the right side of the StockMarketEye window.

2. Active Folder : The upper portion of the right side of the StockMarketEye window displays the active portfolio
or watchlist. At the top of this area is a toolbar which allows you to switch between the various views (prices,
fundamentals, reports) as well as buttons to quickly access often used features. Under the toolbar is the watchlist
or portfolio itself, including the stocks, ETFs, funds, options and currency pairs that are part of this list. When
you click on one of the items in the list, the chart for that item is displayed in the lower portion of the window.

3. Chart Area : The lower portion of the right side of the StockMarketEye window displays the active chart. At
the top of this area, just under the active folder area, is a toolbar where you can select the time range of the chart
as well as menus for adding technical indicators and configuring the type of chart (line, candlestick, etc.).

1.2 The First Time You Run StockMarketEye

The first time you start StockMarketEye, 1 Portfolio and 3 Watchlists are automatically created for you.

• Portfolios

– My 401k - A Portfolio to track the holdings of your 401(k).

• Watchlists

– Indexes - A Watchlist of important market indexes. It has been pre-populated with the Dow Jones In-
dustrial Average, the NASDAQ Composite, the S&P 500 Index, the Russell 2000 Index and a number
of other indexes from major world exchanges.

– Overweight - An example Watchlist of stocks that you rate as “Overweight”.

– Underweight - An example Watchlist of stocks that you rate as “Underweight”.

You may decide to keep these Portfolios and Watchlists, rename them or even delete them completely.

1.3 What is a Portfolio?

A Portfolio is a collection of assets, similar to an account at a brokerage. In StockMarketEye, an asset is an investment
in a stock, mutual fund, exchange traded fund (ETF), option or cash. Assets can also be non-quoted items such as
bonds, preferred stock, property, etc, but the pricing of these assets must be entered manually. The value of each
asset in a portfolio is determined by the asset’s current market price multiplied by the number of shares owned. The
Portfolio’s value is the total of all of its asset values.

Use Portfolios to track the performance of your investments.

In addition to individual portfolio tracking, StockMarketEye provides a portfolio summary folder, accessible by click-
ing on the “Portfolios” item in the folders area. The portfolio summary shows you the totals of all your portfolios and
investments. A sum total view is available to see the grand total of all your portfolios, while a combined portfolio view
shows you the individual investments from all your portfolios, combined into one large portfolio.

You can read more about Portfolios in the section Portfolios - Tracking Your Investments.

1.4 What is a Watchlist?

A Watchlist is a collection of securities such as stocks, mutual funds, ETFs, options or currency pairs. Each security
in a Watchlist has a starting “watch” price (“Watch Start”). This is the base-line price from which the Watchlist will

6 Chapter 1. Introduction to StockMarketEye
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track the price movement of the security.

Use Watchlists to help keep your eye on the market.

You can read more about Watchlists in the section Watchlists - Monitoring the Markets.

1.5 What is a Stock Chart?

A Stock Chart depicts the historical prices of a security. You can view a security’s chart by clicking on the security
in your Watchlist or Portfolio. The historical price chart will then be displayed in the chart area.

Use Stock Charts to gain perspective on market movement.

More than one security can be displayed in the chart, allowing you to visually compare performance. Intraday quotes
are available for 1-day and 5-day periods, while end-of-day charts are available for longer time periods.

StockMarketEye’s charts can also display technical indicators such as EMA, Bollinger Bands, MACD, Stochastic
and others. StockMarketEye even remembers how you have setup your charts to save you time next time you use
StockMarketEye.

1.6 What are Stock Alerts?

Stock Alerts keep you informed of important activity in your watchlists and portfolios. You can quickly setup alerts
for any item based on a broad range of factors including last price, volume, PE and more. Alerts are displayed visually
within the StockMarketEye window as well as on your desktop through integration with Growl.

Use Stock Alerts to be notified of important activity.

1.7 Views of your Data

Each Watchlist and Portfolio offers multiple “views” of your data to give you more perspective. Watchlists and
Portfolios have a standard “Prices” view where you can see the current prices for the securities in which you are
interested. They also have a “Fundamentals” view where you can get a quick look at some basic valuation information
such as P/E, 52-Week High, and Dividend, among many others.

Portfolios have a separate “Reports” view where you can see things such as the historical record of the activity
(buys/sells/etc) that has take place in this portfolio and the gain/loss on your trades.

You can also configure what data is displayed in each view. You’ll find more information on this topic in the Config-
uring Columns section.

1.8 Stock Symbols and Quotes

StockMarketEye uses stock symbols, also known as ticker symbols, to track securities in your watchlists and portfo-
lios. If you already know the stock symbols for the securities you are interested in, you can enter them directly into
StockMarketEye.

StockMarketEye also provides a symbol lookup feature. You can type the name of the company or partial symbol
into the “Symbols Search” box in the upper-right portion of the active folder area. The available stock symbols are
displayed just below the search box. Double-clicking on one of the symbols will add the symbol to your watchlist or
portfolio.

1.5. What is a Stock Chart? 7
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Stock quotes are available from most major world exchanges, including the USA, Canada, UK, Australia, India,
Singapore, France, Germany, and more.

Each watchlist and portfolio is initially setup to automatically download quotes every 5 minutes. You can also down-
load quotes for an individual watchlist or portfolio on-demand by clicking on the “Get Quotes” button in the toolbar.

Quotes are available for stocks, ETFs, mutual funds, options and currency pairs through 2 data providers, Yahoo!
Finance and Google Finance. Yahoo! Finance covers a broad range of securities from most major world stock markets.
Quote data from Yahoo Finance is delayed, usually between 15-20 minutes. Google Finance covers fewer markets, but
provides real-time quotes for US, Indian and Chinese markets as well as covering some securities that Yahoo! Finance
does not (such as Canadian mutual funds).

You can read more about stock quotes and stock symbols in the section Ticker Symbols and Data Providers.

8 Chapter 1. Introduction to StockMarketEye
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CHAPTER

TWO

INSTALLATION INSTRUCTIONS INDEX

2.1 Installing on Windows

StockMarketEye is free to use for 30-days. To continue using StockMarketEye after the trial period, you can purchase
a license on our website.

2.1.1 Downloading StockMarketEye

If your StockMarketEye download has not yet started, or you need a version for a different operating system, you can
get it directly from the download page on our website:

http://www.stockmarketeye.com/download

2.1.2 Installing StockMarketEye

1. Before downloading starts, Internet Explorer will ask if you want to run or save the downloaded file. Choose
“Run”.

After download, if Internet Explorer does not run the installer for you, you can also double click on the down-
loaded file (called StockMarketEye-<version>-Setup.exe) to start the installer.

2. When the installer starts, you’ll see the following window.

9
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3. Next you will be asked to agree to our End User License Agreement.

4. Then choose the install location. The default selection is sufficient in most circumstances.

10 Chapter 2. Installation Instructions Index

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme
http://www.stockmarketeye.com/eula


www.stockmarketeye.com StockMarketEye User’s Guide, Release 4.2

5. The installer will extract and install StockMarketEye.

6. When the installer is finished, it will also offer to run StockMarketEye.

2.1. Installing on Windows 11
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7. Later, you can run StockMarketEye from the ‘StockMarketEye’ menu or from the shortcut on the desktop (if
you choose to install the shortcut).

• 10/8/7: Start -> All Programs -> StockMarketEye -> StockMarketEye

2.1.3 Other Installation Notes

• The default installation location is C:\Users\<your-user>\AppData\Local\StockMarketEye.

2.1.4 Uninstalling StockMarketEye on Windows

To remove StockMarketEye, run the “Uninstall StockMarketEye” from the Start -> All Programs -> StockMarketEye.

To completely remove any data saved by StockMarketEye, move the following folder to the trash:

Windows 10/8/7/Vista C:\Users\<your user>\AppData\Roaming\StockMarketEye40
Windows XP C:\Documents and Settings\<your user>\Application Data\StockMarketEye40

2.2 Installing on Mac OS X

StockMarketEye is free to use for 30-days. To continue using StockMarketEye after the trial period, you can purchase
a license on our website.

Note: We are a registered Apple developer and have signed StockMarketEye so as to not have any problems with the
Mac OS X Gatekeeper.
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2.2.1 Downloading StockMarketEye

If your StockMarketEye download has not yet started, or you need a version for a different operating system, you can
get it directly from the download page on our website:

http://www.stockmarketeye.com/download

2.2.2 Installing StockMarketEye

StockMarketEye is being downloaded and should complete in a few seconds.

When downloading is complete, double click on the downloaded file to open it. You will then be presented with the
StockMarketEye End User License Agreement. Running StockMarketEye on your computer implies that you have
read and agree to this license.

After agreeing to the End User License Agreement, you will see this Finder window.

2.2. Installing on Mac OS X 13
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Click-and-drag the StockMarketEye application to the right and drop it on the Applications folder.

You can now start StockMarketEye from the Applications folder by double-clicking it.

2.2.3 Uninstalling StockMarketEye on Mac OS X

To uninstall StockMarketEye, simply drag the StockMarketEye application to the trash.

To completely remove any data saved by StockMarketEye, move the following folder to the trash:

Mac OS X: /Users/<your user>/Library/Application Support/StockMarketEye40

2.3 Installing on Linux

StockMarketEye is free to use for 30-days. To continue using StockMarketEye after the trial period, you can purchase
a license on our website.

Note: StockMarketEye will run on any Linux distribution with a recent version of Java installed.

2.3.1 Downloading StockMarketEye

If your StockMarketEye download has not yet started, or you need a version for a different operating system, you can
get it directly from the download page on our website:

http://www.stockmarketeye.com/download

2.3.2 Installing StockMarketEye

1. Download the installer jar file to your hard drive. The downloaded file is called

StockMarketEye-<version>-Linux-Install.sh.

14 Chapter 2. Installation Instructions Index
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2. When the download has finished, change the file permissions on the downloaded installer so that it is executable.
You can do this by right-clicking on the StockMarketEye-<version>-Linux-Install.sh file and
checking the “Allow executing file as program” option.

or via the command line:

chmod 755 StockMarketEye-<version>-Linux-Install.sh

3. Then run the installation file by double-clicking on it or from the command line with:

./StockMarketEye-<version>-Linux-Install.sh

4. Follow the instructions in the installer window. By installing StockMarketEye, you are implicitly agreeing to
our End User License Agreement.

5. When the installation is complete, you can run StockMarketEye from the application menu (under the Office
category), or from the command line like:

$HOME/StockMarketEye/StockMarketEye.sh

NOTE: Your Linux distribution may not have installed Java by default. Java 8 is required to run StockMarketEye. On

2.3. Installing on Linux 15
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Ubuntu you can install Java with the following command:

sudo apt-get install openjdk-8-jre

2.3.3 Other Installation Notes

• The default installation location is $HOME/StockMarketEye.

• By default, an Application menu entry for StockMarketEye will be added in the Office category. This entry will
be removed if you uninstall StockMarketEye.

• On Ubuntu, if you also have Java 6 or Java 7 installed, you may need to run sudo update-alternatives
--config java to set the default to Java 8. Alternatively, you can edit the StockMarketEye.sh script
to change the JAVAEXE variable.

2.3.4 Uninstalling StockMarketEye on Linux

To uninstall StockMarketEye, execute the following command in a terminal. Replace
STOCK_MARKET_EYE_INSTALL_DIR with the path to your install location (by default
$HOME/StockMarketEye).:

<STOCK_MARKET_EYE_INSTALL_DIR>/StockMarketEye-uninstaller

Follow the instructions in the uninstaller window. When it has finished, click the ‘Quit’ button.

To completely remove any data saved by StockMarketEye, delete the following directory:

Linux: $HOME/.StockMarketEye40
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CHAPTER

THREE

TICKER SYMBOLS AND DATA PROVIDERS

A ticker symbol (also referred to as a stock symbol) is an abbreviation that identifies the shares of a company on a
stock market. For example, the ticker symbol for Apple Inc. on the NASDAQ is AAPL. For Johnson & Johnson on
the New York Stock Exchange, it is JNJ.

Ticker symbols are the basis of your StockMarketEye watchlists and portfolios. You’ll use ticker symbols for many
different operations, such as adding to a watchlist, purchasing a stock for your portfolios, viewing charts or setting
alerts.

Market data, such as current price quotes, fundamental data and historical prices, comes from data providers and is
based on the ticker symbols you use. StockMarketEye support 2 data providers: Yahoo! Finance and Google Finance.
Yahoo! and Google have slightly different ticker symbol nomenclature. For example, AAPL works for Yahoo!, but
with Google it is NASDAQ:AAPL.

In this section you will learn how to find the ticker symbols for the securities you are interested in, as well as more
details on the data providers supported by StockMarketEye.

3.1 Ticker Symbol Lookup

StockMarketEye provides built-in symbol search technology that can help you get started quickly. You’ll find the
“Symbol Search” field in the upper right side of the StockMarketEye window.

Just start typing the name of a company or ticker symbol in this field and StockMarketEye will display a list of the 10
most likely, existing ticker symbols. The search results are displayed just below the symbol search field.

17
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The search results display the symbol, full name of the security and the exchange on which it trades. There is also

an icon that represents the data provider for this symbol, either Yahoo! Finance ( ) or Google Finance ( ). If a
symbol is listed twice, once for Yahoo and once for Google, you have the choice of which data provider you’d like to
use for this symbol.

If the search results show the ticker symbol you’re looking for, simply double-click it to add it to your Watchlist or
Portfolio.

3.1.1 When You Can’t Find the Right Symbols

Sometimes “Symbol Search” does not offer any ticker symbols that match what you are really looking for. There are
2 typical reasons for this. The first is that this can happen when the symbol or company you are looking for no longer
exists. StockMarketEye’s symbol search only returns currently active ticker symbols. If shares of the company you
are looking for no longer trade on any exchange (due to a buy-out, de-listing or any other reason), StockMarketEye
will not be able to find a corresponding symbol.

The second reason is that StockMarketEye’s symbol search gives priority to US-exchange listed symbols. If you are
looking for ticker symbols of stocks that trade on non-US exchanges, they are also available in StockMarketEye. You
can read more about them in the section on Data Providers and in the individual country information pages.

Note: Not finding the ticker symbol you are looking for is not necessarily a problem. StockMarketEye can only
retrieve current price data for existing ticker symbols. However, if you don’t want or need current price data (say,
because you are entering old, closed-out positions; or because you are adding a non-quoted item to your portfolio such

18 Chapter 3. Ticker Symbols and Data Providers
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as a CD or bond), you do not need an existing ticker symbol. In this case, you can ignore StockMarketEye’s warning
about an invalid symbol.

3.2 Data Providers

StockMarketEye downloads stock quotes, historical data and other investment related data from free resources on the
Internet. The 2 resource sites used by StockMarketEye are Yahoo! Finance and Google Finance.

• Yahoo! Finance
• Google Finance

In your watchlists and portfolios, you can use either Yahoo or Google or both within the same list. StockMarketEye
will use the stock symbol to determine from which provider it will retrieve the data. Google ticker symbols have
an exchange prefix attached to the stock’s ticker symbol (such as NYSE:JNJ), while Yahoo ticker symbols have an
exchange suffix for non-US securities (such as LLOY.L) or simply the stocks normal ticker symbol (such as JNJ) for
stocks that trade on the main US exchanges. The sections below provide more details on our data providers.

3.2.1 Yahoo! Finance

Yahoo! Finance covers a broad range of securities from most major world stock markets. They provide delayed current
quote data, historical quote data, dividend data, current foreign exchange quotes and historical foreign exchange data.
Current quote data from Yahoo Finance is delayed, usually between 15-20 minutes.

The best way to find Yahoo! Finance ticker symbols is to use StockMarketEye’s built-in symbol search. Search results

that have the Yahoo! icon ( ) in the first column will get their data from Yahoo!.

If the symbol search does not return any symbols that match what you were looking for, you can also use any ticker
symbol that you find on the Yahoo! Finance website in StockMarketEye.

3.2. Data Providers 19
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Simply copy-paste it from the Yahoo! Finance web page into the “Watchlist Symbol Details” window or the portfolio
“Buy or short-sell a stock” window.

Yahoo! Finance Stock Symbol Conventions

Securities that trade on exchanges in the United States use the standard exchange symbol. For example, Apple Inc. is
AAPL and Microsoft is MSFT.

Securities that trade on non-US exchanges have an exchange suffix added by Yahoo! Finance in order to differentiate
them from securities on other exchanges that have the same symbol.

Here are some of the most common exchanges, their suffix and a couple of example ticker symbols.

• .TO - Canada - Toronto Exchange (TSX)

– CWB.TO - CND Western Bank

20 Chapter 3. Ticker Symbols and Data Providers
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– SU.TO - Suncor

– PWT.TO - Penn West Energy Trust

• .V - Canada - Canadian Venture Exchange (CNDX)

– ALE.V - Alange Energy

• .L - UK - London Stock Exchange

– LLOY.L - Lloyds Banking Group PLC

– BSY.L - British Sky Broadcasting Group

– TSCO.L - Tesco PLC

• .AX - Australia - Australian Stock Exchange

– QAN.AX - Quantas FPO

– FGL.AX - Fosters FPO

– BHP.AX - BHP Billiton Limited

• .NZ - New Zealand - New Zealand Stock Exchange (NZX)

– TEL.NZ - Telecom Corporation of New Zealand

– AIR.NZ - Air New Zealand Limited

• .SI - Singapore - Singapore Stock Exchange

– Z74.SI - SingTel

– AJ1.SI - StraitsAsia

• .BO - India - Bombay Stock Exchange

– RNRL.BO - Reliance Natural Resources

– WLPACKP.BO - Well Pack Papers & Containers

• .NS - India - National Stock Exchange of India

– BHARTIART.NS - Bharat Rasayan LTD

– UNITECH.NS - Unitech LTD

3.2.2 Google Finance

Google Finance covers fewer markets than Yahoo! Finance. They provide current quote data and historical quote
data. Current quote data is real-time for US, Indian and Chinese markets. Additionally, they cover some securities that
Yahoo! Finance does not (such as Canadian mutual funds).

The best way to find Google Finance ticker symbols is to use StockMarketEye’s built-in symbol search. Search results

that have the Google icon ( ) in the first column will get their data from Google.

If the symbol search does not return any symbols that match what you were looking for, you can also use any ticker
symbol that you find on the Google Finance website in StockMarketEye.

3.2. Data Providers 21
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Simply copy-paste it from the Google Finance web page into the “Watchlist Symbol Details” window or the portfolio
“Buy or short-sell a stock” window.

22 Chapter 3. Ticker Symbols and Data Providers
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Google Finance Stock Symbol Conventions

All Google Finance symbols are prefixed with an exchange prefix, including symbols for securities that trade on
exchanges in the United States.

Here are some of the most common exchanges, their prefix and a couple of example ticker symbols.

• TSE: - Canada - Toronto Exchange (TSX)

– TSE:CWB - CND Western Bank

– TSE:SU - Suncor

– TSE:PWT - Penn West Energy Trust

• CVE: - Canada - Canadian Venture Exchange (CNDX)

– CVE:ALE - Alange Energy
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• LON: - UK - London Stock Exchange

– LON:LLOY - Lloyds Banking Group PLC

– LON:BSY - British Sky Broadcasting Group plc

– LON:TSCO - Tesco PLC

• ASX: - Australia - Australian Stock Exchange

– ASX:QAN - Quantas FPO

– ASX:FGL - Fosters FPO

– ASX:BHP - BHP Billiton Limited

• BOM: - India - Bombay Stock Exchange

– BOM:500325 - Reliance Industries Limited

– BOM:531249 - Well Pack Papers & Containers

• NSE: - India - National Stock Exchange of India

– NSE:BHARATRAS - Bharat Rasayan LTD

– NSE:UNITECH - Unitech LTD

3.3 Stock Option Symbols

StockMarketEye can track stock option prices using the option symbols from Yahoo! Finance. You can include options
in your portfolios or watchlists.

• Finding Option Symbols
• Portfolio : Adding Option Contracts
• Watchlist : Tracking Option Prices

3.3.1 Finding Option Symbols

Stock options symbols are not available via the built-in symbol search. You can, however, find option symbols on the
Yahoo! Finance website in 2 places:

1. Via the “Options” link on the company specific page.
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2. Via the Yahoo! Options Center

Once you’ve found the options page for a particular stock, you can use the “Symbol” column directly in a StockMar-
ketEye watchlist or portfolio. Examples of option symbols from the image below are: AAPL110521C0017000,
AAPL110521C0017500 and AAPL110521C0018000.
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3.3.2 Portfolio : Adding Option Contracts

You can track option contracts in your portfolio. The following steps should help get you started.

1. Find the stock option symbol on Yahoo Finance. Follow the section above for more details.

2. You should now have the option symbol you’re interested in. For example, the January 2012 Put option for
Johnson & Johnson (JNJ) at a strike price of $65 is: JNJ120121P00065000

3. Open StockMarketEye and select the portfolio where you want to record the stock option.

4. Click on the “Buy Stock” button. This will open a new window called “Buy or Short-sell a stock”.

5. Paste the option symbol into the “Symbol” field.

6. Select the date you purchased the option in the “Date Added” calendar. Select the “Trade Type” as “Buy”.

7. “Number of shares” - Yahoo Finance, like most financial websites, reports option prices for individual options.
However, options are normally sold in lots of 100. So the value of one option lot is the option’s price (as reported
by Yahoo Finance) times 100. For example, 1 lot (100 options) priced at 0.52 of the above mentioned JNJ Put
option would be worth: 0.52 * 100 = $52. If you had 5 lots, they would be worth (0.52 * 5 * 100) = $260.

Note that the number of shares controlled by one option lot is 100 for standard options. However, for “mini”
option contracts, there are only 10 shares associated with the lot. In the Yahoo ticker symbol, a mini-option
contract is denoted by a “7” just after the ticker symbol. For example, AAPL140606C00615000, is a normal
option ticker symbol. But AAPL7140606C00615000 (note the “7” directly after AAPL) is a mini-option.

When using StockMarketEye, what this means is that when entering the “Number of Shares”, you should mul-
tiply the number of lots you purchased by the number of shares controlled by that lot. If you have a normal
option, multiply by 100. If you’re using a mini-option, multiple by 10. For example, say you bought 5 normal
JNJ Put options, you would then enter 500 shares (5 x 100) in the “Number of Shares” field.

8. “Buy Price” - The buy price should be the price of an individual option, not the price of the entire lot. If you
only have the total price you paid, you can first divide it by the number of lots, then divide it by the number of
shares controlled by the lot (100 or 10) to get the individual option price.

For example: if you bought 5 normal lots of the JNJ Put option for $250, you can divide that by 5 to get the
amount for one lot, then divide that by 100 to get the price for one option. 250 / 5 / 100 = 0.5

9. Enter any transaction costs or fees associated with this option’s purchase in the “Transaction Costs” field. If the
costs of this purchase should be deducted from the portfolio’s cash balance, check the “Update the cash balance”
box.

10. Click “OK” to add the option holding to your portfolio.

Now, when StockMarketEye updates the prices for the items in your Portfolio, the value of the option contract
will also be updated and you’ll see the exact value of your option holdings.

3.3.3 Watchlist : Tracking Option Prices

To track option prices in a watchlist, simply copy-paste the option symbol from the Yahoo! Finance web page into the
“Watchlist Symbol Details” window as shown below.
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3.4 Tracking Foreign Exchange Market (Forex) Prices

StockMarketEye can track foreign exchange (forex) prices using the currency pair symbols from Yahoo! Finance. You
can include currency pairs in your portfolios or watchlists.

Currency pair symbols are not available via the built-in symbol search. You can, however, find the Yahoo! Finance
currency pair symbols directly on the Yahoo! Finance Currencies Center.

Click on one of the currency pairs to go to the currency pair’s Yahoo! Finance web page. In this page you’ll find the
currency symbol that you can use in StockMarketEye.

Simply copy-paste the currency pair symbol from the Yahoo! Finance web page into the “Watchlist Symbol Details”
window or the portfolio “Buy or short-sell a stock” window.
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If your currency pair is not one of the standard currency pairs displayed on the Currencies Center main page, you can
still get price information for your currency pair by building and entering the currency pair by yourself.

Currency pair symbols are of this form: “<currency #1><currency #2>=X”. For example:

• EURUSD=X - Euro to US Dollar

• USDCHF=X - US Dollar to Swiss Franc

• CHFJPY=X - Swiss Franc to Japanese Yen

• SGDEUR=X - Singapore Dollar to Euro

• GBPAUD=X - British Pound to Australian Dollar
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3.5 Canadian Markets Information

StockMarketEye supports Canadian securities from the Toronto Exchange (TSX) and the Canadian Venture Exchange
(CNDX). You can also setup your Portfolios to be denominated in Canadian dollars.

• Ticker Symbols for Canadian Stocks
• Setup Portfolios for Canadian Dollars
• Setup Portfolios for Average Cost Basis (ACB)

3.5.1 Ticker Symbols for Canadian Stocks

You can search for ticker symbols of the securities you want to track using StockMarketEye’s Symbol Search field in
the upper-right corner of the window. Although the first entry in the search results is often from a US exchange, you
can use the “Exchange” results column to see on which exchange the symbol trades. If you find the stocks you’re
looking for in the search results, double-click it to add it to your portfolio or watchlist.
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Yahoo! Finance Symbols

Ticker symbols for securities that trade on non-US exchanges have an exchange suffix added by Yahoo! Finance in
order to differentiate them from securities on other exchanges that have the same symbol.

In the case of Canadian securities, those that trade on the TSX are suffixed with a “.TO”, while those that trade on the
Venture exchange are suffixed with a “.V”. For example, Suncor, whose ticker symbol on the TSX is “SU”, on Yahoo!
Finance is “SU.TO”. Canadian Western Bank on the TSX is “CWB” but on Yahoo! Finance is “CWB.TO”. Alange
Energy Corporation, which trades on the Venture exchange as “ALE”, is “ALE.V” on Yahoo! Finance.

If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Yahoo!
Finance Canada website and use any symbol you find there directly in StockMarketEye. See the section on Data
Providers on where to find the ticker symbol on Yahoo! Finance.

Google Finance Symbols

Google Finance adds an exchange prefix to ticker symbols in order to differentiate them from securities on other
exchanges that have the same symbol.

In the case of Canadian securities, those that trade on the TSX are prefixed with “TSE:”, while those that trade on
the Venture exchange are prefixed with “CVE:”. For example, Suncor, whose ticker symbol on the TSX is “SU”, on
Google Finance is “TSE:SU”. Canadian Western Bank on the TSX is “CWB” but on Google Finance is “TSE:CWB”.
Alange Energy Corporation, which trades on the Venture exchange as “ALE”, is “CVE:ALE” on Google Finance.
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If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Google
Finance website and use any symbol you find there directly in StockMarketEye. See the section on Data Providers on
where to find the ticker symbol on Google Finance.

Canadian Mutual Funds

Quotes for Canadian mutual funds are only available through Google Finance.

The prefix, “MUTF_CA:”, is used for Canadian mutual funds. For example, Royal Bank of Canada’s “Canadian
Dividend” fund can be added to StockMarketEye using the ticker symbol, “MUTF_CA:RBF266”.

3.5.2 Setup Portfolios for Canadian Dollars

In StockMarketEye, each portfolio has a currency in which the total value of the portfolio is displayed. Within the
portfolio, you can have items denominated in different currencies. StockMarketEye will convert the value of those
items to the currency of the portfolio, when calculating the portfolio’s total value.

To change a portfolio’s currency, select your portfolio in the Folders list, then use the menu: Portfolio -> Properties...
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In the Properties window, go to the “Currency” tab. Here you can change the currency from US Dollars to Canadian
Dollars. Scroll up and select Canadian Dollar (CAD) in the list.
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Click OK for the changes to take effect.

Note: It is best to change the currency of the portfolio before adding any stocks to the portfolio. Changing the
currency after you already have stocks added may lead to inconsistent values due to exchange rate differences. If this
happens to you, you can verify the currency and exchange rates of all your transactions in the Transactions report and
then modify them if necessary. Finally, you may then need to rebuild the portfolio from the transactions.

Default StockMarketEye Currency Settings

By default, StockMarketEye creates portfolios with US Dollars as the currency. You can change this as well as the
currency used in the Portfolios Summary view to use Canadian Dollars.

Open the StockMarketEye “Preferences” window. On a Mac you can do this from the menu: StockMarketEye ->
Preferences. . . . On Windows or Linux, use the menu: File -> Preferences. . . .
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In the “General” tab, you’ll see the “Currency Settings” block. There are 2 settings here you can change. The first
is the “Currency for ‘Portfolio Totals’ view”. Click on the button labeled “Choose. . . ” and the “Select Currency”
window will open.
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As you did in the Portfolio Settings dialog, scroll up in the list and select Canadian Dollar (CAD), then click OK.
Now do the same for the “Default initial currency for Portfolios”. Finally click OK in the Preferences window for the
settings to take effect.

If you now click on the “Portfolios” item in the list on the left-hand side of the StockMarketEye window, you’ll see
the Portfolios summary group’s Totals view. Note that it now uses Canadian Dollars (C$), rather than US Dollars ($).
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3.5.3 Setup Portfolios for Average Cost Basis (ACB)

By default, StockMarketEye calculates the cost basis of your positions using the specific lot basis. However, you can
change your portfolio to use the average cost basis (ACB) instead.

To do this, open the portfolio’s Properties window, select the “Portfolio” tab, then check the option “Use the Average
Cost Basis (ACB) calculation for cost basis reporting”.
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3.6 UK Markets Information

StockMarketEye supports UK securities from the London Stock Exchange (LSE). You can also setup your portfolios
to be denominated in British Pounds.

• Ticker Symbols for UK Stocks
• Setup Portfolios for British Pounds

3.6.1 Ticker Symbols for UK Stocks

You can search for ticker symbols of the securities you want to track using StockMarketEye’s Symbol Search field in
the upper-right corner of the window. Although the first entry in the search results is often from a US exchange, you
can use the “Exchange” results column to see on which exchange the symbol trades. If you find the stocks you’re
looking for in the search results, double-click it to add it to your portfolio or watchlist.

Yahoo! Finance Symbols

Ticker symbols for securities that trade on non-US exchanges have an exchange suffix added by Yahoo! Finance in
order to differentiate them from securities on other exchanges that have the same symbol.

In the case of UK securities that trade on the LSE, their ticker symbols are suffixed with a “.L”. For example, Lloyds
Banking Group, whose ticker symbol on the LSE is “LLOY”, on Yahoo! Finance is “LLOY.L”. British Sky Broad-
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casting Group on the LSE is “BSY” but on Yahoo! Finance is “BSY.L”. Tesco PLC on the LSE is “TSCO”, but on
Yahoo! Finance is “TSCO.L”.

If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Yahoo!
Finance UK & Ireland website and use any symbol you find there directly in StockMarketEye. See the section on
Data Providers on where to find the ticker symbol on Yahoo! Finance.

Google Finance Symbols

Google Finance adds an exchange prefix to ticker symbols in order to differentiate them from securities on other
exchanges that have the same symbol.

In the case of UK securities, those that trade on the LSE are prefixed with “LON:”. For example, Lloyds Banking
Group, whose ticker symbol on the LSE is “LLOY”, on Google Finance is “LON:LLOY”. British Sky Broadcasting
Group on the LSE is “BSY” but on Google Finance is “LON:BSY”. Tesco PLC on the LSE is “TSCO”, but on Google
Finance is “LON:TSCO”.

If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Google
Finance website and use any symbol you find there directly in StockMarketEye. See the section on Data Providers on
where to find the ticker symbol on Google Finance.

3.6.2 Setup Portfolios for British Pounds

In StockMarketeye, each portfolio has a currency in which the total value of the portfolio is displayed. Within the
portfolio, you can have items denominated in different currencies. StockMarketEye will convert the value of those
items to the currency of the portfolio, when calculating the portfolio’s total value.

To change a portfolio’s currency, select your portfolio in the Folders list, then use the menu: Portfolio -> Settings...
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In the Settings window, go to the “Currency” tab. Here you can change the currency from US Dollars to British
Pounds. Scroll up and select British Pounds (GBP) in the list.
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Click OK for the changes to take effect.

Note: It is best to change the currency of the portfolio before adding any stocks to the portfolio. Changing the
currency after you already have stocks added may lead to inconsistent values due to exchange rate differences. If this
happens to you, you can verify the currency and exchange rates of all your transactions in the Transactions report and
then modify them if necessary. Finally, you may then need to rebuild the portfolio from the transactions.

Default StockMarketEye Currency Settings

By default, StockMarketEye creates portfolios with US Dollars as the currency. You can change this as well as the
currency used in the Portfolios Summary view to use British Pounds.

Open the StockMarketEye “Preferences” window. On a Mac you can do this from the menu: StockMarketEye ->
Preferences. . . . On Windows or Linux, use the menu: File -> Preferences. . . .
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In the “General” tab, you’ll see the “Currency Settings” block. There are 2 settings here you can change. The first
is the “Currency for ‘Portfolio Totals’ view”. Click on the button labeled “Choose. . . ” and the “Select Currency”
window will open.
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As you did in the Portfolio Settings dialog, scroll up in the list and select British Pounds (GBP), then click OK. Now do
the same for the “Default initial currency for Portfolios”. Finally click OK in the Preferences window for the settings
to take effect.

If you now click on the “Portfolios” item in the list on the left-hand side of the StockMarketEye window, you’ll see
the Portfolios summary group’s Totals view. Note that it now uses British Pounds (£), rather than US Dollars ($).
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3.7 Australian Markets Information

StockMarketEye supports Australian securities from the Australian Stock Exchange (ASX). You can also setup your
portfolios to be denominated in Australian Dollars.

• Ticker Symbols for Australian Stocks
• Setup Portfolios for Australian Dollars

3.7.1 Ticker Symbols for Australian Stocks

You can search for ticker symbols of the securities you want to track using StockMarketEye’s Symbol Search field in
the upper-right corner of the window. Although the first entry in the search results is often from a US exchange, you
can use the “Exchange” results column to see on which exchange the symbol trades. If you find the stocks you’re
looking for in the search results, double-click it to add it to your portfolio or watchlist.
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Yahoo! Finance Symbols

Ticker symbols for securities that trade on non-US exchanges have an exchange suffix added by Yahoo! Finance in
order to differentiate them from securities on other exchanges that have the same symbol.

In the case of Australian securities that trade on the ASX are suffixed with a “.AX”. For example, Quantas, whose
ticker symbol on the ASX is “QAN”, on Yahoo! Finance is “QAN.AX”. Fosters on the ASX is “FGL” but on Yahoo!
Finance is “FGL.AX”. BHP Billiton Limited on the ASX is “BHP”, but on Yahoo! Finance is “BHP.AX”.

If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Yahoo!
Finance Australia website and use any symbol you find there directly in StockMarketEye. See the section on Data
Providers on where to find the ticker symbol on Yahoo! Finance.

Google Finance Symbols

Google Finance adds an exchange prefix to ticker symbols in order to differentiate them from securities on other
exchanges that have the same symbol.

In the case of Australian securities that trade on the ASX are prefixed with “ASX:”. For example, Quantas, whose
ticker symbol on the ASX is “QAN”, on Google Finance is “ASX:QAN”. Fosters on the ASX is “FGL” but on Google
Finance is “ASX:FGL”. BHP Billiton Limited on the ASX is “BHP”, but on Google Finance is “ASX:BHP”.

If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Google
Finance website and use any symbol you find there directly in StockMarketEye. See the section on Data Providers on
where to find the ticker symbol on Google Finance.

3.7.2 Setup Portfolios for Australian Dollars

In StockMarketEye, each portfolio has a currency in which the total value of the portfolio is displayed. Within the
portfolio, you can have items denominated in different currencies. StockMarketEye will convert the value of those
items to the currency of the portfolio, when calculating the portfolio’s total value.

To change a portfolio’s currency, select your portfolio in the Folders list, then use the menu: Portfolio -> Settings...
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In the Settings window, go to the “Currency” tab. Here you can change the currency from US Dollars to Australian
Dollars. Scroll up and select Australian Dollars (AUD) in the list.
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Click OK for the changes to take effect.

Note: It is best to change the currency of the portfolio before adding any stocks to the portfolio. Changing the
currency after you already have stocks added may lead to inconsistent values due to exchange rate differences. If this
happens to you, you can verify the currency and exchange rates of all your transactions in the Transactions report and
then modify them if necessary. Finally, you may then need to rebuild the portfolio from the transactions.

Default StockMarketEye Currency Settings

By default, StockMarketEye creates portfolios with US Dollars as the currency. You can change this as well as the
currency used in the Portfolios Summary view to use Australian Dollars.

Open the StockMarketEye “Preferences” window. On a Mac you can do this from the menu: StockMarketEye ->
Preferences. . . . On Windows or Linux, use the menu: File -> Preferences. . . .
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In the “General” tab, you’ll see the “Currency Settings” block. There are 2 settings here you can change. The first
is the “Currency for ‘Portfolio Totals’ view”. Click on the button labeled “Choose. . . ” and the “Select Currency”
window will open.
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As you did in the Portfolio Settings dialog, scroll up in the list and select Australian Dollars (AUD), then click OK.
Now do the same for the “Default initial currency for Portfolios”. Finally click OK in the Preferences window for the
settings to take effect.

If you now click on the “Portfolios” item in the list on the left-hand side of the StockMarketEye window, you’ll see
the Portfolios summary group’s Totals view. Note that it now uses Australian Dollars (AU$), rather than US Dollars
($).
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3.8 European Markets Information

StockMarketEye supports Euro securities from many of the European stock exchanges (Milano, Paris, Frankfurt,
Madrid, Lisbon, Amsterdam... just to name a few). You can also setup your portfolios to be denominated in Euros.

• Ticker Symbols for European Stocks
• Setup Portfolios for Euros

3.8.1 Ticker Symbols for European Stocks

You can search for the ticker symbols of the securities you want to track using StockMarketEye’s Symbol Search field
in the upper-right corner of the window. Although the first entry in the search results is often from a US exchange, you
can look in the “Exchange” results column to see on which exchange the symbol trades. If you find the stocks you’re
looking for in the search results, double-click it to add it to your portfolio or watchlist.
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Yahoo! Finance Symbols

Ticker symbols for securities that trade on non-US exchanges have an exchange suffix added by Yahoo! Finance in
order to differentiate them from securities on other exchanges that have the same symbol.

In the case of Euro securities, this can be any of the suffixes for any of the European markets. For example, stocks
that trade in Paris are suffixed with “.PA”. For example, BNP Paribas, whose ticker symbol on the Paris exchange is
“BNP”, on Yahoo! Finance is “BNP.PA”. Unione di Banche Italiane Scpa on the Milano exchange on Yahoo! Finance
is “UBI.MI”. Siemens Aktiengesellschaft on the XETRA exchange on Yahoo! Finance is “SIE.DE” (or “SIE.F” on
the Frankfurt exchange).

Here are some of the most common European exchange suffixes:

• .PA - Paris

• .MI - Milano
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• .DE - XETRA

• .F - Frankfurt

• .AS - Amsterdam

• .LS - Lisbon

• .MA - Madrid

If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Yahoo!
Finance website and use any symbol you find there directly in StockMarketEye. See the section on Data Providers on
where to find the ticker symbol on Yahoo! Finance.

Google Finance Symbols

In contract to Yahoo! Finance, Google Finance adds an exchange prefix to ticker symbols in order to differentiate them
from securities on other exchanges that have the same symbol.

In the case of Euro securities, the prefix can be any one of those for any of the European markets. For example, stocks
that trade on the Paris exchange, have the “EPA” prefix - the ticker symbol for BNP Paribas on Google Finance is
“EPA:BNP”. Unione di Banche Italiane Scpa on the Milano exchange on Google Finance is “BIT:UBI”. Siemens AG
on the XETRA exchange on Google Finance is “ETR:SIE” (or “FRA:SIE” on the Frankfurt exchange).

Here are some of the most common European exchange prefixes:

• EPA: - Paris

• BIT: - Madrid

• ETR: - XETRA

• FRA: - Frankfurt

• AMS: - Amsterdam

• ELI: - Lisbon

• BME: - Madrid

If you are having problems finding your ticker symbols with the built-in symbol search, you can go to the Google
Finance website and use any symbol you find there directly in StockMarketEye. See the section on Data Providers on
where to find the ticker symbol on Google Finance.

3.8.2 Setup Portfolios for Euros

In StockMarketEye, each portfolio has a currency in which the total value of the portfolio is displayed. Within the
portfolio, you can have items denominated in different currencies. StockMarketEye will convert the value of those
items to the currency of the portfolio, when calculating the portfolio’s total value.

To change a portfolio’s currency, select your portfolio in the Folders list, then use the menu: Portfolio -> Settings...
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In the Settings window, go to the “Currency” tab. Here you can change the currency from US Dollars to Euros. Scroll
up and select Euros (EUR) in the list.
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Click OK for the changes to take effect.

Note: It is best to change the currency of the portfolio before adding any stocks to the portfolio. Changing the
currency after you already have stocks added may lead to inconsistent values due to exchange rate differences. If this
happens to you, you can verify the currency and exchange rates of all your transactions in the Transactions report and
then modify them if necessary. Finally, you may then need to rebuild the portfolio from the transactions.

Default StockMarketEye Currency Settings

By default, StockMarketEye creates portfolios with US Dollars as the currency. You can change this as well as the
currency used in the Portfolios Summary view to use Euros.

Open the StockMarketEye “Preferences” window. On a Mac you can do this by going to the “StockMarketEye” menu
and choose “Preferences. . . ”. On Windows or Linux, go to the File menu and choose “Preferences. . . ”.
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In the “General” tab, you’ll see the “Currency Settings” section. There are 2 settings here you can change. The first
is the “Currency for ‘Portfolio Totals’ view”. Click on the button labeled “Choose. . . ” and the “Select Currency”
window will open.
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As you did in the Portfolio Settings dialog, scroll up in the list and select Euro (EUR), then click OK. Now do the
same for the “Default initial currency for Portfolios”. Finally click OK in the Preferences window for the settings to
take effect.

If you now click on the “Portfolios” item in the list on the left-hand side of the StockMarketEye window, you’ll see
the Portfolio Totals view. Note that it now uses Euros (C), Rather than US Dollars ($).
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3.9 Other Markets

StockMarketEye supports securities from any exchange supported by Yahoo! Finance or Google Finance. You can
read more about finding ticker symbols for these exchanges in the Data Providers section.

You can also create portfolios in any currency available through Yahoo! Finance. The documentation for UK Markets
Information can help get you started. Simply apply the information there to your own markets and currency.
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CHAPTER

FOUR

PORTFOLIOS - TRACKING YOUR INVESTMENTS

Use Portfolios to track the performance of your investments.

With StockMarketEye you can quickly and efficiently manage your investment portfolios, while getting the informa-
tion you need to make informed investment decisions.

In this section, you’ll learn how you can use the portfolio management capabilities of StockMarketEye’s portfolios to
track your investments and position yourself to make better investing decisions.

4.1 Managing Your Portfolios

4.1.1 Creating and Deleting a Portfolio

Adding your own portfolios helps you to efficiently track the performance of your investments. Create portfolios for
all of your brokerage accounts or even create “virtual” portfolios to test different investing strategies. There is no limit
on how many portfolios you can create, nor on how many stocks you can have in a portfolio.

Create a Portfolio

In StockMarketEye’s the main menu, select File -> New Portfolio.... This will open the “Portfolio Properties” window
as shown below:
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Type a name for your new portfolio in the field labeled Name. The name you use can be anything you want, but every
portfolio must be named differently. You may also add a description of your portfolio in the Description field, but this
is optional.

In the “Live Quotes” tab, you can specify how often the quotes in this portfolio are updated.

In the “Portfolio” and “Currency” tabs, you can specify other properties for this portfolio, including the base currency
of this portfolio.

Click “OK” to save your new portfolio.

Before you can use the portfolio, however, you must enter an initial deposit. The default amount is $10,000, but you
can change this to be any amount you want, including 0. It is also possible to add (or remove) cash later. See the
section Managing your Cash Balance for more details. Be sure to change the “Deposit Date” to an appropriate date.
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The new portfolio will now be available in “Portfolios” section of StockMarketEye.

You can modify the name of a portfolio by double-clicking on its name in the list on the left. This will display the
“Portfolio Properties” window where you can change the Name and Description of your portfolio.

You can read about the other properties available for portfolios on the Portfolio Properties page.

Delete a Portfolio

To delete a portfolio, select the portfolio in the folders area. Then use the main menu, Portfolio -> Delete Portfolio....
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When a portfolio is deleted, all of the stocks in that portfolio as well as all of its transactions are deleted. Deleting
can not be un-done, so you need to confirm that you want to delete the portfolio before StockMarketEye will actually
delete it.

62 Chapter 4. Portfolios - Tracking Your Investments

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


www.stockmarketeye.com StockMarketEye User’s Guide, Release 4.2

4.1.2 Portfolio Properties

In addition to the “General” (name and description) properties and “Live Quote” properties, a StockMarketEye port-
folio has a number of other properties that can be changed in the “Portfolio Properties” window.

You can open the portfolio’s Properties window using the menu: Portfolio -> Properties...

Portfolio Tab

In the “Portfolio Properties” window, the “Portfolio” tab allows you to configure some of the general aspects of the
portfolio.
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• Default Commissions - This value is the default costs/commissions that StockMarketEye will deduct for each
buy/sell transaction in this portfolio. Typically your brokerage will charge a per transaction commission every
time you buy or sell stock. This can be anywhere from $5 to $25 and you can set this value here.

You can also change this value when you enter the buy or sell transaction, in case the commissions are not fixed,
but calculated.

• Default number of shares in purchase: - This value will be used to set the default number of shares in the
buy transaction window. If the value is 0, the shares in the buy transaction window will not be set. The value
specified here in the Properties is only the value that is initially put in the Shares field of the buy transaction
window. The Shares field can be changed afterwards in the buy transaction window.

• Benchmark Symbol - Select which symbol you’d like to use for the benchmark symbol in this portfolio. The
benchmark symbol is used in the “Benchmark” columns. You can select one of the indexes in the list or enter
your own symbol (ex. SPY).

• Use the Average Cost Basis (ACB) calculation for cost basis reporting - See the section on Cost Basis
Calculations for more details.
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• Calculate the Portfolio’s value chart using the strict method - The market value chart of the portfolio is a
chart of the closing value of your portfolio over time. Movement in the chart is due to the price movement of
your holdings as well as any cash flows into/out of your portfolio.

By default, the daily values used in the chart are calculated by taking the current portfolio and working back-
wards in time. For each previous day, the value of the portfolio at close is calcualted using historical quotes,
then any transactions that occurred on that day are reversed.

With the “strict” method option selected, the daily values used in the chart are calculated by building a virtual
portfolio from scratch from the transactions. For each day, the transactions that occurred on that day are applied
to the portfolio and then the value of the portfolio at close is calculated using historical quotes.

The “strict” method is technically more accurate, but can result in large discrepancies if there are any missing
historical quotes for stocks or currencies used in the daily valuation. The default method can also be affected
by missing historical quotes, but does a better job of remaining more in-line with the current valuation of the
portfolio.

• Cash Balance - Each portfolio contains a cash balance line, just above the “Total” line. This value represents the
un-invested funds you have in your account. Some brokerages keep your un-invested funds in a money market
account, others will keep it in an interest bearing account. The “Cash” line represents the un-invested portion of
your portfolio, whether it is actually in a money market fund or an interest bearing account. You can read more
about the cash balance in the section, Managing your Cash Balance.

Un-check this option if you do not want to have a “Cash” line in your portfolio. In this case, the cash balance will
not be actively maintained. A portfolio that does not use the cash balance is referred to as an invested-capital
portfolio.

– Include a cash balance - This option tells StockMarketEye whether it should maintain and display the
cash balance line. You may want to uncheck this option if you are setting up a virtual portfolio without a
cash portion. Typically for a brokerage account, you will want to have this option checked.

– Update the cash balance with transaction proceeds? - This option tells StockMarketEye that it should
add/subtract the proceeds of transactions to/from the cash balance. You can also change this on a per trans-
action basis if needed, using the “Update the cash balance?” option in the buy/sell/dividend/etc windows.

Currency Tab

The “Currency” tab allows you to configure the currency used for the Total and Cash lines of the portfolio. Individual
items in the portfolio can be denominated in other currencies. However, the currency used for portfolio’s total and
cash values is determined with this property.

If you change this value, you may also want to change the “Currency Settings” found in the general Preferences
window.
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4.1.3 Getting Current Quotes for your Portfolio

StockMarketEye retrieves current quotes for the symbols in your Portfolios from free servers on the Internet. You can
decide, for each Portfolio, how often you would like to refresh the quotes. There are 2 possibilities:

1. “Streaming” Quotes - Update the current market price for the stocks in your Portfolio automatically at regular
intervals. This is the default method.

2. On-Demand - Update the current market price for the stocks in your Portfolio when you choose. You can
update the prices simply by clicking on the “Get Quotes” button in the Portfolio toolbar.

Changing the Live Quote Properties

By default, every Portfolio is initially set to use “Streaming” Quotes. You can switch your Portfolio to use On-Demand
quotes or modify the “Streaming” Quote setting in the “Portfolio Properties” window.
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To modify your Live Quote settings, in the main menu, select Portfolio -> Properties... The “Portfolio Properties”
window will appear. Then click on “Live Quotes”.

Under “Live Quotes”, select either the Streaming quote data option or the On-Demand quote data option.

• On-Demand quote data

Retrieves live quote data only when you click on the “Get Quotes” button in the toolbar or in the menu Watchlist
-> Get Quotes.

• Streaming quote data

Retrieves the live quotes automatically on the selected schedule. You can modify the “Update every” settings
to change the frequency at which the quotes will automatically be updated. A schedule anywhere between 15
seconds and 1440 minutes (i.e. 24 hours) is possible.

You can also tell StockMarketEye to reset the previous close values before the start of trade.

• Enable automatic reset of the previous close values before the start of trade

This option is enabled by default and typically it should be left enabled for normal portfolios.

4.1. Managing Your Portfolios 67

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

The data providers do not reset a security’s previous close value to the closing price from the previous day until
the first quote of the current trading day is received. This means columns such as the “Day %” and “Day Gain”
will have the previous day’s values until the current trading day starts.

For normal stocks and ETFs, this can cause a slight confusion around the start of the trading day. However for
mutual funds, it can be quite confusing as the previous day’s gain/loss will be shown throughout the current
trading day and will be included in your current day’s gain/loss.

With this option enabled, StockMarketEye will reset the previous close value to the closing price from the
previous day at 8am on the next weekday.

However, this option may not be ideal for some, especially if you have European mutual funds or other securities
that are quoted by the data providers 24 hours later. You can see when the last quote was received by adding the
“Last DateTime” column. If you see that the securities you follow have a last quote date over 24 hours in the
past, you may want to consider disabling this option (uncheck it) so that StockMarketEye will not perform the
reset of the previous close values.

Click on the “OK” button to save and activate the property settings.

4.1.4 Managing your Cash Balance

Like a real account with a brokerage, your StockMarketEye portfolio contains a pool of un-invested funds called the
cash balance. In a real brokerage account, these funds are usually held in a money market account or interest bearing
account. The “Cash” line of your portfolio (just above the “Total” line), represents this un-invested portion of your
portfolio, whether it is actually in a money market fund or an interest bearing account.

The cash balance of your StockMarketEye portfolio is where the proceeds of sales and dividends are deposited. It is
also where funds are deducted when needed for purchase.

Your StockMarketEye portfolio does not have to have a cash balance. If you are managing a virtual portfolio or
tracking a real portfolio that does not have a cash portion, you can change the portfolio’s settings to remove the “Cash”
line. See the section, Portfolio Properties for more details.

Adding and Removing Cash

You can add or remove funds from the cash balance of your StockMarketEye portfolio at any time using the menu:
Portfolio -> Add Cash Transaction.
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This will open the “Portfolio Cash Transaction” window as shown below.
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In this window, you can use one of 7 transaction types for specifying how the funds were added or removed:

1. Cash In

2. Cash Out

3. Interest In

4. Interest Out

5. Other In

6. Other Out

7. Fees

You should also specify a transaction Date and set the Amount of this cash transaction.

If you want the Total Value of this transaction to be added/removed from your current cash balance, be sure to select
“Update” for the Cash Balance field.

Adding and Removing Cash via In-Line Editing

If you want to set the cash balance to a specific value, you can edit the current value in-line to create a cash transaction
whose value is the difference between the current value and the new value you entered. For example, if the current
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balance is 9617.07 and you would like it to be 10000, you can edit the cash balance value in-line, setting it to 10000.
This will open the “Cash Transaction Details” window with the Amount set to 382.93.

To start the in-line editing, click in the Market Val cell of the Cash line. You can then enter the new cash balance value
as shown below. When you press return, the “Cash Transaction Details” window will be opened and you can finish
setting the details of the transaction, such as the Date.

Setting the Cash Balance without Recording a Transaction

Normally, you should record a cash transaction when changing the value of your portfolio’s cash balance. However,
in some circumstances, it is useful to specifically set the value of the cash balance, without recording a transaction. In
these rare cases, you can use the menu: Portfolio -> Set the Cash Balance...
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This opens the “Set the cash balance” window, where you can set the new value of the cash balance.
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Note that this will not record a transaction and thus there may be a discrepancy between your portfolio’s Prices view
and the transactions. See the section on Rebuild Your Portfolio From Its Transactions for more details on how you can
rebuild the Prices view, if necessary.

4.1.5 Buying and Selling

Build and manage your StockMarketEye portfolios so that you always have up-to-date information with which to make
your investment decisions.

StockMarketEye portfolios are managed just like a standard brokerage account. To add items to your portfolio, you
buy shares. To remove items, you sell shares. StockMarketEye can handle long and short positions, as well as the
transfer of shares in and out.

• Adding an Asset (Buy)
• Modifying an Existing Asset
• Removing an Asset (Sell)

Adding an Asset (Buy)

Your portfolios can contain short or long investments in stocks, mutual funds, ETFs and many other asset classes.

If you don’t know the ticker symbol of the security that you would like to add to your portfolio, you can use the
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built-in symbol search feature described in the Ticker Symbol Lookup section. Alternatively, the purchase window has
a “Search” button to help find the right ticker symbol.

When you would like to add a position to your portfolio, simply click on the “Buy Stock” button (green plus sign) in
the Portfolio toolbar. This will open the “Enter Purchase Details” window.

The ‘Enter Purchase Details’ Window

This window allows you to specify the details of the asset you are adding to your Portfolio.

Enter the ticker symbol for the security you are purchasing in the “Symbol” field. If you don’t know the exact ticker
symbol, you can click on the “Search” button at the right of the “Symbol” field to search for the ticker symbol you
need.

Once you have the ticker symbol, fill in the other fields of the dialog with values corresponding to this investment.

• Quantity - Enter the number of shares you are purchasing, shorting or transferring
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• Price - Enter the price paid per share in the “Price” field. You can use the “Get Price” button to use the closing
price of the security on the date selected in the “Date” field. If this is a transfer, enter the cost basis per share for
the shares you are receiving.

• Commissions - Enter any commissions associated with this purchase, short sale or transfer.

• Fees - Enter any fees associated with this purchase, short sale or transfer.

• Total Value - Total value of this transaction. You normally don’t need to modify this field as it will be automat-
ically computed from the fields above.

• Date - Select the day you purchased, shorted or transferred this asset.

• Type - Select either “Buy” if you are buying this asset, “Sell Short” if you are short selling it, or “Shares In” if
you are transferring shares in from another account.

• Cash Balance - Select “Update” if you want the Total Value subtracted from the Portfolio’s cash balance.
Typically this should be set to “Update”. However, it can be set to “Do not update” if the Total Value should not
be subtracted from the Cash balance. The default setting of this option is controlled by the setting, “Update the
cash balance with transaction proceeds?” in the “Portfolio” tab of the Portfolio’s Settings window.

Note that for “Shares In” transactions, the cash balance of your portfolio is never affected, no matter which
setting you select. However, for proper performance calculations, you should set it to “Update”, even if your
portfolio does not have a cash balance, unless the “Shares In” transaction that you are recording is part of a
spin-off. See the section on recording corporate actions for details on recording spin-offs.

• Currency - The currency of the security. Typically this is automatically set when entering the ticker Symbol,
but can be changed manually if necessary.

• Exchange Rate - The exchange rate used for this transaction. If the Currency of this security is the same as the
currency of the portfolio, the exchange rate will be 1.0. Otherwise, it will automatically be set to the closing
exchange rate on the selected Date. It can be changed manually if you have a specific exchange rate from your
brokerage.

• Comments - Add any comments or notes about this transaction.

Once you have filled in appropriate values for all of the fields, click on the OK button to add the asset to your Portfolio.
Your portfolio will then look something like this:

Modifying an Existing Asset

You can modify the details of an asset in your portfolio in a number of ways.

• Double-click on the asset to open the “Details of a stock in your Portfolio” window. From this window, you can
modify the details of this holding, including Quantity, Price, and Date. When you have finished, click “OK”
to update your portfolio.
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• You can also modify some of the details of your holding “in-line”. First select the item in your portfolio, then
click in the Shares or Buy Price cell of this line. You can then edit the value. Press ‘Return’ for your changes
to take effect or ‘Esc’ to cancel.

You can also modify the Last column in this way (also called ‘overriding’ the value) in order to visualize the
effects of a different asset price on the investment’s value. Note that if you modify the Last column in this way,
a small asterisk will be displayed in the cell and the price will no longer be updated. To remove the ‘override’
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and get the current price again, simply edit the Last cell, delete any value that is there and press ‘Return’.

• Finally, if neither of the above methods allow you to change the details sufficiently, you can also delete the item
from your portfolio and add it again.

To do this, select the item to delete and then use the menu: Portfolio -> Delete from Portfolio...

You will have to confirm that you want to delete this item and its corresponding transaction.
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Removing an Asset (Sell)

You can sell, cover a short position or transfer shares out of your portfolio by selecting the item and clicking on the
“Sell Stock” button in the toolbar.

This will open the “Enter Sale Details” window where you can specify the details of the transaction. When you have
finished entering the information, click the “OK” button and the asset will be removed from your portfolio and a
transaction will be added in the Transactions report. If you have selected to update the Cash balance, the proceeds
(less transaction costs) will be added to your Cash balance.
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Note that you can not undo a sell operation. You first need to delete the ‘sell’ transactions, then buy the security
again.

4.1.6 Tracking Bonds and Other Non-Quoted Securities

StockMarketEye can download current quote data for stocks, ETFs and mutual funds from most major world ex-
changes. It can also download current quotes for currencies and US stock options.

However, for some securities, StockMarketEye may not have access to current quote information. Securities such as
bonds and preferred stock as well as items such as real estate will not have quote data available.

You can still include these securities and investments in your StockMarketEye portfolios.

Steps to Adding a Non-Quoted Item

The following can be applied to any non-quoted security or investment.
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1. Choose a ticker symbol to represent the item in your portfolio. You are free to choose any ticker symbol you
want. We suggest choosing one that will easily remind you of the investment it represents.

The ticker symbol you choose must not be a recognized ticker symbol that is used for an actual security.
You can verify that the chosen ticker symbol is not already used for an actual security by entering it into the
“Symbol Search” box in the top-right corner of the StockMarketEye window. If there are no Search Results
found, that ticker symbol can be used.

2. Use the chosen ticker symbol to add an item to your portfolio, as you would with a normal stock.

Click on the “Buy Stock” button in the toolbar to open the “Enter Purchase Details” window. Then enter the
chosen ticker symbol and other pertinent data such as the quantity of shares and current market price. You can
add extra information about the item you are adding in the comments field. Click OK to add the item to your
portfolio.
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3. StockMarketEye will display a warning that it does not have access to any data for this symbol. We can safely
click OK as we will enter the current price ourselves.
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4. Your portfolio will now look something like the next image. We’ve also added a holding of Citigroup’s publicly
traded stock, C, to the portfolio for comparison.

5. (Optional) Notice that the “Name” column is empty for this item. You can add your own name by editing the
“Name” field.

See the section, Changing The Name Of A Security, for more details on editing the Name field.

To do this, select the item and then click in the “Name” cell of that line as shown in the next image.
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Then type the name you want to give this item. In this example, we’re using “Citigroup %5.375 2020”.

When you are done entering the name, press Return to have StockMarketEye remember it.
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6. Update the “Last” price of the item to the current price. StockMarketEye won’t be able to update the price
automatically, but you can set it manually.

See the section, Overiding The Last Price, for more details on editing the last price.

To do this, as in step #5 above, edit the item’s “Last” cell, entering the current price.

StockMarketEye will then recalculate the value of the holding based on the price you enter.
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Note that the asterisk next to the price denotes that this item’s “Last” value has been set manually.

You can update the “Last” cell in the same way any time you want to bring your item’s value up-to-date.

4.1.7 Entering Dividends, Capital Gains and Return of Capital

Companies return money to shareholders in a number of ways. The most common way of redistributing money to
shareholders is via dividends. However, capital gains payments (typically from a mutual fund) or return of capital
payments are also possible distribution methods.

Maintaining complete and accurate distribution transactions in your StockMarketEye portfolio is important for accu-
rate performance reporting. You can read more about the uses of your portfolio’s transactions in the section, Transac-
tion Accuracy and Completeness.

You can enter these distribution transactions in StockMarketEye by following the instructions below.

Note: If your StockMarketEye portfolio was imported from a brokerage, you most likely do not need to manu-
ally enter distribution transactions, as they will be included in your portfolio when retrieving your portfolio’s latest
transactions via the “Update from brokerage...” feature.

The Distribution Declaration Window

Open the StockMarketEye portfolio where the distribution occured.

Select the stock/fund/ETF that is declaring the dividend, capital gain or RoC distribution. If you have more than one
lot of the holding declaring the distribution, you should select the main, aggregate lot of the holding, rather than one
of the individual sub-lots. Then use the menu, Portfolio -> Record dividend, CapGain or RoC...
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This will open the “Distribution Declaration” window.
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In the “Distribution Declaration” window, set the “Type” field to the type of distribution you want to enter. This can
be one of:

• Dividend - Cash dividend distribution

• Reinvested Dividend - Dividend amount reinvested in shares of the declaring stock

• Capital Gain - Cash capital gain distribution

• Reinvested Capital Gain - Capital gain amount reinvested in shares of the declaring stock/fund

• Return of Capital - Cash return of capital (RoC) distribution

• Reinvested Return of Capital - RoC amount reinvested in shares of the declaring stock; StockMarketEye will
record 2 transactions: an RoC transaction and a Buy transaction

• Interest In - Interest paid by this holding; Note: interest paid by the portfolio, such as interest on your cash
balance, should be recorded using a cash transaction.

• Reinvested Interest In - Interest paid by this holding and used to purchase more shares of the holding

• Interest Out - Interest charged by this holding, such as for margin
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For cash distributions, the following fields should be filled in:

• Amount / Share - The amount of the distribution per share. Dividends are typically declared on a per-share
basis. The total amount of the dividend payment is the “Amount / Share” times the number of shares you own.

• Share Balance - The number of shares owned at the time of the distribution. This field is typically filled in by
StockMarketEye when you open the “Distribution Declaration” window with a stock selected.

• Distribution Total - The total amount of the distribtuion. This will typically be “Amount / Share” times “Share
Balance”.

The “Dividend Search” button can help with filling in these fields. When you click on this button, a new window
will open showing the known dividends declared in the past for this stock. Select on one of them from the list, then
click OK. The “Amount / Share” and “Distribution Total” fields will be automatically filled in based on the selected
dividend’s information.
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Note that the “Amount / Share” and “Share Balance” are not strictly necessary and you can simply fill in the “Dis-
tribution Total” amount. However, for transaction completeness, we recommend filling in the “Amount / Share” and
“Share Balance” fields when possible.

When you have selected one of the reinvested “Types”, an additional section, “Reinvestement Details”, will be shown.
In this section, you should fill in the details of the reinvestement.

• Quantity - The number of shares recieved from the reinvestment.

• Price - The price paid per share for the reinvested shares. “Quantity” times “Price” should be equal to the
“Distribution Total”.

• Commissions - Any fees or commissions paid due to the reinvestement. You can typically leave this field empty
or filled in with 0.
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The easiest way to enter the reinvestment details is to click on the “Get Price” button. This will retrieve the closing
price of the security on the selected “Date” and fill the “Price” field with that value. It will then also automatically
compute the “Quantity” from the “Price” and “Distribution Total” fields.

However, you can also fill in the “Reinvestment Details” with the specific numbers recieved from your brokerage.

Click on the “OK” button to record the distribution transaction. If this is a reinvested “Type”, a new sub-lot will be
added to your holding in the Prices view.

4.1.8 Entering a Stock Split

Stock splits can play out in a number of ways, but generally they are in one of 2 categories:

1. Standard stock split - A standard stock split is when you end up with more shares after the split than before.
For example, a common stock split is when every 1 share you own before the split is converted into 2 shares after
the split. So if you owned 100 shares before the split, after the split you would own 200 shares. This example
would be called a 2-for-1 stock split.

2. Reverse stock split - A reverse stock split is when you end up with less shares after the split than before. For
example, for every 2 shares you own before the split, you will have only 1 share after the split. So if you owned
500 shares before the split, after the split you would own 250 shares. This example would be called a 1-for-2
stock split.

Share splits not only affect the number of shares you own, but also the current trading price of the shares. In a standard
2-for-1 split, you will receive double the number of shares after the split as before, but the share price for that stock
will also be half the pre-split price.

In a typical, pure stock split, the total cost basis of the shares you own does not change. The cost basis per share
will have changed according to the split ratio, but the total cost basis of your holding in that stock after the split will
be the same as before the split.

You can enter and apply stock splits to holdings in your StockMarketEye portfolios by following the instructions
below.
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The Stock Split Window

Open the StockMarketEye portfolio where the split occurred and select the stock that is to be split. Then use the menu,
Portfolio -> Split Stock....

This will open the “Stock Split” window.
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The “Split Ratio” field in this window is where you enter the split details. If this is a standard stock split, the first field
will be larger than the second (ex. 2 for 1). If this is a reverse stock split, the second field will be larger than the first
(1 for 2).

Be sure to enter the official date of the split in the “Split Date” calendar. You can also enter any comments about this
split in the “Comments” field.

Press the OK button when you have filled in all of the details. StockMarketEye will then:

1. Apply the split to your current holdings in the Prices and Fundamentals views. The number of shares as well as
the buy price (and related columns) will be updated.

2. Add the SPLIT transaction to the Transactions report. The original BUY transactions for the items being split
will not be altered.

Applying Split to Individual Lots

StockMarketEye will apply the split to the lots you have selected in your portfolio. If you selected the aggregate item
of one of your holdings, the split will be applied to all sub-lots. If you only want the split to be applied to one of the
lots, select that lot before opening the “Stock Split” window.
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Stock Split Details in the Transactions Report

Once you’ve entered a stock split, you can see it in the Transactions report. Note that the “Shares” column for a
“Split” transaction represents the split ratio. For example, a 2-for-1 split would have a split ratio of 2.0 and a 1-for-2
reverse split would have a split ratio of 0.5.

You can change the details of a stock split after you have entered it by double-clicking on the “Split” transaction in
the Transactions report. Note that some changes to a split transaction can not be correctly propagated to the current
holdings. In this case, you should follow the suggestions in the “What To Do If There Are Problems” section below.

How To Handle Uneven Share Splits

Sometimes a stock split will produce an uneven number of shares. For example, if the company declares a 1-for-7
reverse stock split, and before the split you owned 100 shares, after the split you would own 14.2857 shares.

Depending on how the company and/or brokerage have elected to handle the fractional shares, in the example above,
you may only end up with 14 shares in your account. The fractional shares are often paid cash-in-lieu, which means
you receive the equivalent value of the fractional shares in cash instead.

To handle this type of situation in StockMarketEye, you can model it in essentially the same way that your brokerage
does:

1. Record the split transaction as described above. You then have a fractional number of shares in your portfolio.

2. Sell the fractional number of shares so you end up with the required whole number of shares. The proceeds
from the sale should be added to your cash balance.

What To Do If There Are Problems

If you are having problems correctly splitting your stock, the best option is to delete the problematic “Split” transaction.
Then follow the steps in the section, Rebuild Your Portfolio From Its Transactions, to rebuild the Prices view from the
Transactions. Afterwards, apply the stock split again.

4.1.9 Recording Mergers and Acquisitions

Mergers and acquisitions are 2 similar mechanisms that companies can use to combine their operations.

• Merger - 2 companies agree to combine their operations into a single company. Although mergers occur among
“equals”, the name and stock of one of the merged companies are typically retained for the new combined
company. The stock holders of the other company receive compensation for their shares, usually in the form of
shares of the new company. For example, as a share holder of the other company, you might receive 1 share in
the new company for every 3 shares in the old company you own.
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• Acquisition - Also known as a buyout. One company will purchase all of the shares of another company. The
payment can be in the form of cash, or in shares of the purchasing company.

Record a Merger

Let’s assume that company AAAA is merging with company XYZ. The new company will trade under the XYZ ticker
symbol and owners of shares in the AAAA company will receive 1 share in XYZ for every 2 shares of AAAA they
owned - a merger ratio of 0.5.

To record this event in StockMarketEye, follow these steps:

1. For your holdings in AAAA, create a “shares out” transaction. You can do this by clicking on the “Sell Stock”
button in the toolbar, then in the new “Enter Sale Details” window, change the Type field to be “Shares Out”.

The Price field should have the price of your original unit costs (i.e. cost basis per share). No commissions or
fees are needed for this transaction.

In general, the total value of this “Shares Out” transaction should be the same as your cost basis of the AAAA
holding.

Note that you should also set the “Cash balance” field to be “do not update”.
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2. For the new holdings in XYZ, add a “shares in” transaction. You can do this by clicking on the “Buy Stock”
button in the toolbar, then in the new “Enter Purchase Details” window, change the Type field to be “Shares In”.

The Quantity field should have the number of shares in XYZ that you will receive. That is, your number of
shares in AAAA times the merger ratio - in our example, this is 0.5 times the number of AAAA shares we
owned.

The Price field should have the price of your original unit costs, adjusted for the merger ratio. That is, your
original cost basis per share of AAAA times the merger ratio. No commissions or fees are needed for this
transaction.

In general, the total value of this “Shares In” transaction should be the same as your costs basis for the original
AAAA holdings.

Note that you should also set the “Cash balance” field to be “do not update”.
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3. After applying these 2 transactions, you should only have holdings in your Prices view for XYZ. The cost basis
of the XYZ shares should also correspond to the combined cost basis of all your XYZ shares.

Note that we suggest you verify the numbers, including ending cost basis, with what is reported by your broker-
age.
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4.1.10 Recording a Corporate Action (i.e. Spin-Off)

Corporate actions are special events that affect a company’s stock. An example of a corporate action is a corporate
spin-off, in which the parent company splits off part of itself (such as one of its divisions) into a separate business.

Corporate actions have repercussions on the company’s stock. In the case of a corporate spin-off, the change is
typically to the cost basis of the stock. Other types of corporate actions can affect the number of shares.

To handle these situations, StockMarketEye provides the Corporate Action transaction type. This transaction type
allows you to modify the cost basis of your holdings and/or change the number of shares you own. It is similar to a
stock split, but has the extra dimension of being able to change the cost basis.

Note: Although it is possible to record a stock split using a Corporate Action transaction, we recommend that actual
stock splits (2-for-1, 1-for-7 reverse split, etc.) be recorded with a stock split transaction, rather than as a corporate
action. See the documentation on recording a stock split for more details.

How A Corporate Spin-Off Works

In a typical corporate spin-off, the company splits itself into 2 separate entities - the original parent company and
the newly spun-off company. Shares in the newly spun-off company are given to owners of the parent company’s
stock. If you owned shares of the parent company at the time of the spin-off, you would end up owning shares of both
companies after the spin-off.

The total value of your investment in the parent company before the spin-off is the same as the value of your investment
in both the parent company and the spun-off company after the spin-off. This is because, even though the number of
shares you own in the parent company does not change, the cost basis of those shares changes by the value of the
spun-off company.

For example, let’s say you owned 100 shares of Company A. On Monday, Company A is trading at $10 per share so
your investment in Company A is worth $1000.

On Tuesday, Company A spins-off one of its divisions into Company B. Company A says that for each 10 shares of
Company A that you own, you will be given 3 shares in Company B. It also says that Company B made up 30% of its
total value so the value of Company A’s shares will be reduced by 30%.

Due to the 30% reduction in Company A’s value, their shares on Tuesday trade at $7 per share. Your investment in
Company A is now worth $700. Company B’s shares on Tuesday trade at $10 per share. You received 30 shares in
Company B, which are now worth $300. The total value of your investment is still $1000, but is now divided between
Company A’s and Company B’s shares.

Recording A Corporate Spin-Off

Follow the steps below to record a corporate spin-off or other corporate action in StockMarketEye.

1. Select the stock in your portfolio that is performing the corporate action. Then use the menu, Portfolio -> Record
Corporate Action....
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2. In the Enter Corporate Action Details window, enter the percentage change in cost basis in the “Cost Basis
Change (%)” field. From the example above with Company A, you would enter 30 here.
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3. If there was also a change in the number of shares, enter that in the “Shares Change (%)” field. If there was no
change in the number of shares, enter 100 in this field.

4. Be sure to set the proper date of the action in the “Date” field.

5. Click ‘OK’ to record and apply the corporate action to your holding.

6. The shares received for the spun-off company (Company B in the example above) should be recorded as a shares
in transaction. You can do this via the menu, Portfolio -> Buy Stock....

7. In the Enter Purchase Details window, change the “Type” option to “Shares In”. Be sure to set the “Cash
Balance” to “Do not update” as this is required to properly calculate performance of the spun-off shares.
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8. Then enter the “Symbol”, “Quantity” and “Price” fields according to the new shares you are receiving. You will
need to consult with either your brokerage or with the parent company for the exact details of the shares your
receive. You can leave the “Commissions” and “Fees” fields empty.

9. Be sure to set the “Date” field to be the same date as you recorded for the Corporate Action transaction.

10. Click ‘OK’ to add the shares of the new company to your portfolio.

Modifying A Corporate Action Transaction

You can modify a corporate action transaction just as you would any other transaction in StockMarketEye. Simply
double-click on the transaction in the Transactions report to open the Details window.

After you have modified the transaction, you may need to re-build your portfolio (Prices view) from the transactions.
This is because undoing and re-doing the effects a corporate action can, depending on the changed values, cause
discrepancies between the Prices view and the Transactions.

To rebuild the Prices view from the Transactions, follow the steps in the section Rebuild Your Portfolio From Its
Transactions.
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4.1.11 Handling a Stock Delisting

A stock can be delisted from an exchange for a number of reasons, including voluntarily for restructuring reasons, or
forced delisting for failure to file quarterly or yearly reports, passing below the minimum price per share or even below
the minimum number of shareholders.

Delisting from a major exchange often means that the stock will move to one of the less regulated exchanges, the
over-the-counter or pink-sheets exchange. This may involve a ticker symbol change, but the stock will still trade and
StockMarketEye will usually be able to get quotes for it. On the otherhand, if the stock no longer trades on any
exchange, because of Chapter 11 bankruptcy for example, the shares are generally worthless as shareholders are far
down the list of those that get paid out in a bankruptcy.

Delisting Moves to Another Exchange

If the stock has been delisted and now trades on a different exchange, there are 2 possible scenarios:

1. The ticker symbol for the stock did not change. In this case, you don’t need to make any changes in StockMar-
ketEye.

You may wish to verify that the ticker symbol has not changed by searching for the company in the “Symbol
Search” box or on the sites of our data providers.

2. The ticker symbol changed. Often when moving to a different exchange, the ticker symbol will change. In this
case you can follow the steps in the section, Changing A Holding’s Ticker Symbol to update your holding in
StockMarketEye in order to continue to receive updated quotes.

Shares No Longer Trade

In the case of a bankruptcy, you should sell the shares in StockMarketEye to remove the holding from your portfolio.
In rare cases, you may receive some value for your shares, but generally, you do not. You should record the Sell
transaction in StockMarketEye with a sale price in the amount, if any, you received for the shares. If you do not
receive any amount for the shares, you should enter a share price of 0 in the sell transaction.

See the section on Removing an Asset (Sell) for infomation on selling a holding.

4.2 Importing Data from a Brokerage

4.2.1 Brokerage Import

You can import your investment data directly from supported brokerages. Brokerages provide both your current
holdings as well as historical transaction data from your account.

You may also be interested in reading the section on Brokerage Import - Best Practices.

HowTo Import from Brokerage

1. Open StockMarketEye and use the menu: File -> Import Portfolio -> Import from a supported Brokerage...
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2. Select your brokerage from the supported “Brokerages”. Our Brokerage List section details which brokerages
are currently supported by StockMarketEye. If your brokerage is not listed, contact us to see if we will be able
to support it in a future version.

Next, enter the “Username” and “Password” you use to access your brokerage’s website. When you have entered
your access information, click on the “Next” button to download the list of your accounts at this brokerage.
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You can also fill in the “Account Number” field, if you would like to import just a single account from your
brokerage. See the section, Importing A Single Account, below.

If you leave the “Account Number” field blank, StockMarketEye will present a list of all your accounts at the
brokerage. You can then choose the ones you wish to import into StockMarketEye.

Note: Depending on the brokerage, StockMarketEye may not be able to retrieve the list of your accounts from
your brokerage. If this is the case, you will need to fill in the “Account Number” field with the number of the
specific account that you want to import. See Importing A Single Account below.

Note: Your brokerage access information is only used to download your account list, current holdings and
transactions. StockMarketEye does not store your brokerage password. However, your account number and
username are saved to facilitate future interaction with the brokerage.

3. After downloading the list of your accounts from the brokerage, you can choose which accounts to import.
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Check the box next to the accounts you wish to import.

Each account you select will be imported into a new StockMarketEye portfolio. The name of the new portfolio
will be account-number @ brokerage. For example, if your account number at Vanguard is 1234567890, the
new portfolio will be called “1234567890@vanguard.com”. You can change this name after the import.

Click on the “Next” button to start the import.

4. When the import has completed, you will be shown a list of the new accounts created by the import.
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Note: Brokerages often limit the historical transactions that can be retrieved. For example, a brokerage may
limit the transactions to only those that have occurred in the past 90 days. Some limit transactions to those
from the past 1 or 2 years, while others provide data since you opened the account. Our Brokerage List section
explains the specific limitations of each brokerage supported by StockMarketEye.

After the import is finished, you can edit any of the data downloaded from the brokerage. In addition to being
able to change the portfolio’s name, you can change transaction dates, symbols, purchase prices, transaction
costs, etc.

You should also be aware of the placeholder transactions that StockMarketEye may have created. You can read
more about placeholder transactions in the section, Brokerage Import - Placeholder Transactions.
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Importing A Single Account

If your brokerage does not allow the retrieval of the list of your accounts, or you know the account number of a specific
account you would like to import, you can import an individual account if you know the account number.

To import a single account, follow step #1 above. In step #2 above, enter your brokerage “Username” and “Password”
as well as the “Account Number” you would like to import. Click “Next” to download the data for this account.

When StockMarketEye has finished processing the data downloaded from the brokerage, you have the opportunity to
preview that data before it is imported into a StockMarketEye portfolio. Click on either of the “Preview” buttons to
view your current holdings and the historical transactions that the brokerage has made available.

Note: Brokerages often limit the historical transactions that can be retrieved. For example, a brokerage may limit
the transactions to only those that have occurred in the past 90 days. Some limit transactions to those from the past 1
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or 2 years, while others provide data since you opened the account. Our Brokerage List section explains the specific
limitations of each brokerage supported by StockMarketEye.

When you click “Finish”, the downloaded data will be saved in a new StockMarketEye portfolio. This portfolio is, by
default, given the name of your account number ‘@’ your brokerage name. For example, if your account number at
E*Trade is 123456789, the new portfolio will be called “123456789@etrade.com”. You can modify this once
the import is finished.

After the import is finished, you can edit any of the data downloaded from the brokerage. In addition to being able to
change the portfolio’s name, you can change transaction dates, symbols, purchase prices, transaction costs, etc.

You should also be aware of the placeholder transactions that StockMarketEye may have created. You can read more
about placeholder transactions in the section, Brokerage Import - Placeholder Transactions.

4.2.2 Brokerage Import - Best Practices

The following information is useful to know when using StockMarketEye to import your investment data from a
supported brokerage.
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• Each time you “Import from a supported Brokerage”, a new portfolio will be created and your current holdings
as well as all transactions that the brokerage makes available are imported and included in the new portfolio.

• The brokerage import will retrieve transactions as far back as the brokerage allows. StockMarketEye works
best when it has a complete set of transactions going back to the beginning of your portfolio. However, most
brokerages limit how far back you can get your transactions. Some limit it to as few as 90 days (such as E*Trade)
where as others (such as Vanguard) allow you to pull all of the transactions since the beginning of your account.

• After the initial import, you can use the menu: Portfolio -> Update from Brokerage... to get any changes since
the original import or last time you updated from the brokerage. This just updates that portfolio and does not
create a new one.

• When you “Update from Brokerage...” in an existing portfolio, StockMarketEye will only add new transactions
that it gets from the brokerage. That is, it will only add the transactions that do not already exist in that portfolio.
It determines which ones are new based on a special number that your brokerage assigns to each transaction. If
that number already exists in this StockMarketEye portfolio, we don’t add that transaction to the portfolio.

• When you “Update from Brokerage..” the new transactions are applied to the portfolio so that the Prices view
stays current with the activity in your brokerage account. If, in your brokerage account, activity took place for
which no transaction was included in the downloaded data, the Prices view of your portfolio may be out-of-sync
with what your brokerage reports.

• You can edit the imported transactions, including changing/modifying their comments.

Typical Usage

Here are the typical steps you use to import your data and keep that up-to-date with the brokerage.

1. Import your portfolio from the brokerage.

2. Modify any “Placeholder” transactions to include the correct purchase date and purchase price. See the section
on Brokerage Import - Placeholder Transactions for more details.

3. Copy any missing transactions from the portfolios you previously created in StockMarketEye into the newly
imported portfolio. Be sure that these transactions are not applied to the portfolio, but simply added.

4. Use the “Update from brokerage” feature to periodically get the latest transactions from your brokerage. Typi-
cally you’d want to do this after you have purchases/sales in the actual brokerage account. But at a minimum,
every 90 days, so you don’t lose any transactions in case your brokerage has a 90-day limit.

5. Do not manually add transactions to an imported portfolio. Only use the “Update from brokerage” to get
the latest transactions. Adding transactions manually (apart from the copying of transactions from #3) can throw
off the totals in your portfolio.

4.2.3 Brokerage Import - Placeholder Transactions

Brokerages often limit the historical transactions that can be downloaded for your account. For example, some bro-
kerages limit the transactions to only those that have occurred in the past 90 days. Some only allow 1 or 2 years of
transactions to be downloaded, while others allow you to download all transactions that have occurred in your account
since it was opened.

Because the transactions downloaded from your brokerage may not be the complete transaction history of your ac-
count, those transactions may not cover all of your account’s current holdings. For example, if you purchased a stock
5 years ago, but your brokerage only provides the last 1 year of transactions, no purchase transaction for that stock
would be downloaded.

StockMarketEye makes every effort to reconcile the downloaded transactions with the downloaded current holdings,
matching purchase transactions with currently held positions wherever possible. However, if the brokerage did not
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provide matching purchase transactions for a currently held position, StockMarketEye will create a “placeholder”
transaction for consistency. For example, if the brokerage only provides 1 year of transactions, but one of your cur-
rently held stocks was purchased 5 years ago, StockMarketEye will create a placeholder purchase (BUY) transaction
for it.

As StockMarketEye does not have any record of the actual purchase date and purchase price for these stocks, the
placeholder transactions must set them to default values. These default values are:

1. Purchase Date is set to one day before the date of the first transaction that was downloaded.

2. Purchase Price is set to 0.

After import, you should modify the placeholder transactions to set the correct purchase date and purchase price.
These fields are used to compute gains and losses, so having appropriate values will allow StockMarketEye to make
correct calculations.

The following sections show how you can modify the placeholder transactions to set the purchase date and price to
their appropriate values.

Modifying a Transaction from the Prices View

1. Locate an item in your portfolio that is linked to a placeholder transaction. You can tell which items are linked
to placeholder transactions because they will have a “Buy Price” value of 0.

2. Select the item, then click on the “Details” button in the toolbar. The Enter Purchase Details window will open
and you can see the details of the transaction.
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3. At your brokerage, locate the purchase date and purchase price of this holding. You may be able to find this on
the broker’s website, or you may have to look in your past brokerage statements.

(a) If the holding was purchased all at once on one day (as a single lot), change the “Date” and “Price” fields
in the Details window to match the data from your brokerage.

(b) If the holding was purchased on multiple days for multiple prices (as multiple lots), use the average pur-
chase price of those shares in the “Price” field. For the “Date” field, you would typically use the date of
the most recent purchase of that holding.
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4. You may also wish to set the “Commissions” and “Fees” fields, based on the information you find at your
brokerage.

5. Click on the window’s “OK” button to save the modified details. The data in the Prices view will be updated
and the correct gain/loss will be shown.
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Modifying a Transaction from the Transactions Report

1. Open the Transactions Report and locate the placeholder transactions. The placeholder transactions will be the
first ones in the list and have a “Price” column value of 0.

2. Select the placeholder transaction, then click on the “More” menu at the far right of the StockMarketEye window
and select the “Show transaction details...” item. The Enter Purchase Details window will open and you can
see the details of the transaction.

3. At your brokerage, locate the purchase date and purchase price of this holding. You may be able to find this on
the broker’s website, or you may have to look in your past brokerage statements.

(a) If the holding was purchased all at once on one day (as a single lot), change the “Date” and “Price” fields
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in the Details window to match the data from your brokerage.

(b) If the holding was purchased on multiple days for multiple prices (as multiple lots), use the average pur-
chase price of those shares in the “Price” field. For the “Date” field, you would typically use the date of
the most recent purchase of that holding.

4. You may also wish to set the “Commissions” and “Fees” fields, based on the information you find at your
brokerage.

5. Click on the window’s “OK” button to save the modified details. The data in the Prices view will be updated
and the correct gain/loss will be shown.
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Modify Fields of a Transaction In-Line

You can also change individual fields of a transaction, either in the “Prices” view or in the “Transactions” view,
without opening the Enter Purchase Details window. The following steps show an example of modifying the “Buy
Price” in-line in the portfolio’s “Prices” view.

1. Select the item you want to modify.

2. Click in the “Buy Price” cell of that item.

3. Enter the new purchase price and press return.
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4. The price is saved and gains/losses can be correctly calculated.

Note: The purchase date can only be changed from within the Enter Purchase Details window.

4.2.4 Brokerage Update

Once you have imported your accounts from a brokerage, you should periodically update the corresponding Stock-
MarketEye portfolios with the most recent transactions from your brokerage. To do this, you can use the brokerage
update feature, which downloads all recent transactions and applies them to your portfolio.

The brokerage update feature can be run individually on each separate portfolio (via the menu: Portfolio -> Update
from Brokerage), or on all your imported portfolios at once, using the method described below.

HowTo Update All Imported Portfolios

1. Open StockMarketEye and use the menu: File -> Update from Brokerages...
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2. The “Update all portfolios from brokerage” window will be displayed.

3. In the “Update all portfolios from brokerage”, select the brokerages/accounts from which you wish to update.
Checking the box next to the brokerage name will select all of the accounts from that brokerage. You can also
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expand the brokerage items to see and select/unselect individual accounts from that brokerage.

4. When you check the box next to a brokerage, if you have not already entered your password for the brokerage,
you will be asked to enter it.

5. In the “Update all portfolios from brokerage” window, mark the option “Remember brokerage passwords” to
have StockMarketEye save the passwords so you don’t have to enter them each time. The first time you do this,
you will see the following informational message about password saving.

Note: Your brokerage information (username, password, account number, etc) is not copied by the on-line
synchronization service.

6. Click the “Start Update” button to begin the download process. StockMarketEye will then connect directly to
your brokerage accounts and download all of your recent transactions.
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7. As each download process completes, a “Preview Update” button is shown. Clicking on this button will open a
window showing the transactions that were downloaded from the brokerage.

8. When the download process has completed for all brokerages, click on the “Finish Update” button to apply
the downloaded transactions to your portfolios. If you do not want to apply the transactions downloaded for a
particular portfolio, uncheck the box for that portfolio.
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9. Depending on how many brokerages and portfolios you have, the applying of the transactions may take a few
seconds. When it is completed, your portfolios will be up-to-date.

4.2.5 Brokerage Import - Supported Brokerages

With StockMarketEye, you can import your current portfolio holdings and select transactions directly from a brokerage
account. You can get more information on how this works in our Brokerage Import and Brokerage Import - Best
Practices sections.

Note: StockMarketEye uses the Open Financial Exchange (OFX) standard for downloading data from brokerages.
OFX is a secure (i.e. encrypted) means of reading data from your brokerage account. Other financial software calls
this the ‘Direct Connect‘ feature.

Unfortunately, not all brokerages support the Direct Connect feature. If you do not see your brokerage listed below,
please contact us to see if support for your brokerage can be included in a future version of StockMarketEye.

General Limitations

Unfortunately, there are not many (if any) non-US brokerages that support the brokerage import (“Direct Connect”)
feature. As an alternative, you can often download your data from your brokerage’s website in an OFX/QFX or QIF
formatted file. StockMarketEye can import the data from these types of files. See the sections on Importing from
OFX/QFX Files and Importing from QIF Files for more information.
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The following list shows the level of support in StockMarketEye for the listed brokerages. If you have used the
brokerage import successfully for one of the brokerages below that has not yet been marked “user validated”, don’t
hesitate to let us know so we can update this documentation for other users.

Direct Brokerage Import Support in StockMarketEye

Brokerage Name StockMarketEye Support Additional Information
American Century Brokerage
American Century Investments Yes (User validated) Use your social security number

(SSN) without the dashes as the user-
name. Use your American Century
Investments Personal Access Code
(PAC) as the password. You can view
or change your PAC on the American
Century website under the MyProfile
link.

American Funds Use your SSN as the username and
the same password that you use to
login on the American Funds web-
site. Leave the Account Number field
empty and let StockMarketEye get
the account numbers directly from
American Funds.
Current holdings and transactions go-
ing back 1 year.
Note that American Funds reports
each individual fund you own as a
separate account. This means that
StockMarketEye will create a sepa-
rate portfolio for each fund.

Ameriprise Financial Services, Inc. Not Supported! Ameriprise does not allow 3rd party
applications, except for Quicken, to
download your data. You should con-
tact them directly and request that
they change their policy.
However, you may be able to down-
load OFX or QIF formatted files from
your account at Ameriprise. These
files can be imported into StockMar-
keteye.

Ameritrade Institutional Services
Capital One Investing

Continued on next page
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Table 4.1 – continued from previous page
Charles Schwab YES (User validated) Login information is the same as log-

ging into your Schwab web account.
That is, the login name can’t be a
social security number or federal Id,
and the password must be at least 8
characters.
Current holdings and transactions go-
ing back 2 years.
Note: Also works with Schwab’s
“Security Token” account access.

Chase Investments YES (User validated) Current holdings and transactions go-
ing back 2 years.

Dodge and Cox Funds
DWS Investments
E*Trade YES (User validated) Username and password are those

that you use to login to the E*Trade
website.
Current holdings and 3 months of
transactions.

EdVest College Savings Plan
Edward Jones YES (User validated)
Fidelity Investments YES (User validated) Use the login and password you nor-

mally use to access the Fidelity web-
site.
Current holdings and 2 years worth of
transactions.
If you receive an error message with
“Invalid date range”, it may be a tem-
porary problem at Fidelity. Try again
in a few hours. If the problem per-
sists, contact our support team and in-
clude your StockMarketEye log file.

Fidelity NetBenefits YES (User validated) Do not enter your account number.
Just enter your username and pass-
word and StockMarketEye will re-
trieve the account number(s) from
NetBenefits.
If you receive an error message with
“Invalid date range”, it may be a tem-
porary problem at Fidelity. Try again
in a few hours. If the problem per-
sists, contact our support team and in-
clude your StockMarketEye log file.

First Clearing, Inc YES (User validated) Current holdings and about 4 months
of transactions.

Franklin Templeton Investments
Continued on next page
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Table 4.1 – continued from previous page
Hewitt Associates YES (User validated) Current holdings and 12 months of

transactions.
After initial import, the “Last” prices
of Hewitt managed funds and proxy
funds (i.e. funds with prices
not available on Yahoo Finance or
Google Finance) will be updated
when using the “Update from Broker-
age” feature.

ING Institutional Plan Services
Interactive Brokers Not Supported! Interactive Brokers unfortunately

does not support the “direct connect”
standard. However, you may be able
to download OFX or QIF formatted
files from your account at IB. These
files can then be imported into
StockMarketEye.

Janus Unverified: use your Social Security
Number (SSN) without dashes in the
“Username” field and your Janus Per-
sonal Identification Number (PIN) in
the “Password” field.

J.P. Morgan Securities
Mercer
Merrill Lynch Yes (User validated) Merrill Edge also supported.
Morgan Stanley Yes (User validated) Use your standard Morgan Stanley

account number, username and pass-
word.
Note that the account number should
not contain dashes. Use only the first
9 digits of the account number, if the
full account number does not work.

Morgan Stanley (Smith Barney)
myStreetscape Not Supported! myStreetscape does not allow

3rd party applications, except for
Quicken and TurboTax, to download
your data. You should contact them
directly or have your investment
advisor contact them to request that
they change their policy.
However, you may be able to down-
load OFX or QIF formatted files
from your account at myStreetscape.
These files can be imported into
StockMarketeye.

Continued on next page
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Table 4.1 – continued from previous page
NetXInvestor Yes (User validated) May not work for all brokerages cov-

ered by NETXInvestor.
Capital Securities Management and
InvestFinancial have been verified.
You will need to enter your cur-
rent NetXInvestor User ID preceded
by the Financial Institution Number
(A88) in the Username field while
logging in to setup NetXInvestor ac-
counts in StockMarketEye. For ex-
ample, if your ID is “johndoe”, you
will need to enter this information as
“A88johndoe” in the Username field.
For the Password field, you can enter
the same information as you would
enter in the password field on the
NetXInvestor website.
Other NetXInvestor covered broker-
ages may require a special Password
for use with “direct connect” applica-
tions like StockMarketEye.

NMIS, LLC
Oppenheimer & Co. Inc. Yes (User validated) Use your standard Oppenheimer lo-

gin along with your Oppenheimer ac-
count number.
Retrieves current holdings and trans-
actions dating back to at least 2007.

OppenheimerFunds Inc.
OptionsExpress Yes (User validated) Retrieves current holdings and at

least 6 months of transactions.
OptionsHouse Not Supported OptionsHouse does not support the

“direct connect” standard. You may
be able to download your data in
OFX, QFX, QIF or CSV formats,
then import that data into StockMar-
ketEye.

Pershing Advisor Solutions
PNC Bank
Prudential Retirement YES (User validated) Use your username and password that

you use to login to their website. The
password format is special and is de-
scribed on the documents on their
website.
Current holdings and transactions go-
ing back about 13 months.

Raymond James YES (User validated) Current holdings and transactions go-
ing back 24 months.

RBC Dain Rauscher YES (User validated) Also known as RBC Wealth Manage-
ment.
Current holdings and transactions go-
ing back 24 months.

Continued on next page
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Table 4.1 – continued from previous page
Robert W. Baird & Co.
Scottrade YES (User validated) Use your Scottrade account number

in both the “Account Number” and
“Username” fields. Password should
be the same that you use to login to
the Scottrade website.
Current holdings and transactions
back about 18 months.
Note: transactions downloaded from
Scottrade do not seem to include
‘split’ transactions or ‘shares out’
transactions. You can add these trans-
actions after the download so that the
transactions will sync with the Prices
view.

Schwab - The 401k Company
Schwab Retierement Plan Services
ShareBuilder YES (User validated) In the “Password” field, enter your

secure access code. See the Share-
Builder website for details.
At least 1 years worth of transactions
and current holdings.

Stifel Nicolaus YES (User validated) Current holdings and transactions go-
ing back XX months.

T. Rowe Price (Brokerage) YES (User validated) For T. Rowe Price brokerage ac-
counts.
Current holdings and some transac-
tions.

T. Rowe Price (Retail) NO, not supported. For non-brokerage and non-
retirement plan accounts.

T. Rowe Price Retirement Plans YES (User validated) For retirement plan accounts.
Current holdings and 12 months of
transactions.

TD Ameritrade YES (User validated) Current holdings and transactions go-
ing back 2 years.
If your usual username/password do
not work, try using your account
number in both the “Account Num-
ber” and “Username” fields, and use
your 4-digit Ameritrade PIN as the
password. You may also try with the
username all in lowercase.

Continued on next page
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Table 4.1 – continued from previous page
TD Ameritrade Institutional [a.k.a.
Advisor Client] (use “TD Ameri-
trade” in brokerage import - See ad-
ditional info)

YES (User validated) Current holdings and transactions go-
ing back about 2 years.
Your AdvisorClient account needs to
be enabled by TD Ameritrade In-
stitutional for electronic download-
ing into Quicken. This is quickly
done with a telephone call to TD
Ameritrade Institutional support, ask-
ing them to enable your Advisor-
Client accounts for Quicken’s direct
connect. They will give you a user-
name and password that you can use.
If they offer to walk you through set-
ting up the accounts in Quicken, you
can decline ans say you’ll do it your-
self.
Use the “TD Ameritrade” brokerage
in StockMarketEye with the user-
name/password given you by the TD
Ameritrade Institutional support.

TIAA-CREF YES (User validated) Retirement accounts.
TIAA-CREF Brokerage Services Brokerage accounts only.
TradeKing Not Supported! TradeKing unfortunately does not

support the “direct connect” stan-
dard. However, you may be able
to download OFX or QIF formatted
files from your account at TradeKing.
These files can then be imported into
StockMarketEye.

UBS Financial Services Inc. YES (User validated) UBS requires that you import each
account separately. This means, you
will need to enter the account num-
ber, along with your username and
password. Then repeat that process
for each account.

USAA Investments YES (User validated) Use your USAA id number as the
“Username” and your USAA Per-
sonal Identification Number (PIN)
for the “Password”.
Up to 18 months of data.

Utah Educational Savings Plan YES (User validated) Use your account number and the
username and password that you use
to login to their website.
Current positions and about 4 - 5
months of transactions.

Continued on next page
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Table 4.1 – continued from previous page
The Vanguard Group YES (User validated) Username and password are those

that you use to login to the Vanguard
website.
Current holdings and transactions go-
ing back 18 months.
Note: Typically, you should turn off
the “cash balance” in the imported
StockMarketEye portfolio, since
Vanguard does not use a cash balance
(your available cash balance is in the
Money Market fund [VMMXX]).
You can do this in the portfolio’s
Settings window, in the “Portfolio”
tab. Uncheck the option, “Include a
cash balance”.

Voya Financial Advisors, Inc.
Voya Institutional Plan Services
Wedbush Bank Unverified May not work.
Wells Fargo Advisors YES (User validated) May require a wait of 2 business days

after the first attempt before data can
be downloaded.

Wells Fargo Investments

4.3 Importing Data from Other Sources

4.3.1 Importing Investment Data from an OFX/QFX File

You can transfer your investment data into StockMarketEye via Open Financial eXchange (OFX) files. OFX files
contain information about your current holdings as well as historical transactions that have occurred in your account.
Many brokerages and other financial institutions allow you to download your data in the OFX format, often referring
to it as a data format for Intuit’s Quicken or for Microsoft Money.

StockMarketEye can also load QFX (Quicken Financial eXchange) formatted files. QFX files are similar to OFX
files in that they contain current holdings information and historical transaction data. Some brokerages and financial
institutions will allow you to download your data in the QFX format, rather than the OFX format.

In addition to brokerages and other financial institutions, OFX files may be obtained from some financial software
packages. If you are currently using another financial software, but would like to transfer your investment data to
StockMarketEye, you may be able to have your financial software create an OFX file with that data. If your financial
software does not create OFX files, it may be able to create QIF files instead, which can then be imported into
StockMarketEye.

HowTo Import OFX/QFX Files

1. Open StockMarketEye and use the menu: File -> Import Portfolio -> Import from OFX/QFX...
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2. Select the OFX/QFX file that you downloaded from your brokerage or exported from another financial software.
Click “Next” to start processing the file.

3. When StockMarketEye has processed the file, you’ll have the opportunity to preview the data.
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To complete the import, you must first select a portfolio into which the data will be imported. Select one of the listed
portfolios or create a new portfolio by clicking on the “New Portfolio” button.

What data is imported into the selected portfolio is controlled by the “Import Mode” section. The following import
modes are available:

1. New portfolio with holdings, cash and transactions (standard) - all data from the OFX/QFX file will be
added to the selected portfolio. This option is typically used if you are importing into a new portfolio.

2. New portfolio with holdings, cash and transactions (alternative) - all data from the OFX/QFX file will be
added to the selected portfolio. This option is typically used if you are importing into a new portfolio. Use this
option if the first option (standard) made changes to your Prices view vs what you expected from your brokerage.
The first method with try to match current holdings to downloaded transactions, but in some cases may result in
differences in the number of shares held. Use this second (alternative) method if this happens and is not what
you want.

3. Apply only new transactions - the transactions from the OFX/QFX file, which are not currently in the selected
portfolio, will be applied to (i.e. executed in) that portfolio. StockMarketEye determines if a transaction already
exist in the portfolio by comparing a unique identifier that is specified for each transaction in the OFX/QFX file.
If this unique identifier is not already present in this portfolio, the transaction will be applied to the portfolio.

4. Apply all transactions - all of the transactions from the OFX/QFX file will be applied to (i.e. executed in) the
selected portfolio.

5. Import all transactions without applying them - All of the transactions from the OFX/QFX file will be added
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to the Transaction report of the selected portfolio, but will not be applied to (i.e. executed in) that portfolio.

To finish the import, click on the “Finish” button.

Note: You can modify all of the data after the import has been completed.

4.3.2 Importing Investment Data from a QIF File

You can transfer your investment data into StockMarketEye via Quicken Interchange Format (QIF) files. QIF files
contain information about the transactions that have occurred in your portfolio. You can use QIF files to transfer
your portfolio information from one financial application to another (for example, from Microsoft Money Plus to
StockMarketEye).

StockMarketEye supports QIF files from Quicken, Microsoft Money Plus, ShareBuilder and others.

Note: Quicken Users: when exporting your investments to a QIF file, be sure to select “Security Lists” from the
“Include in Export” section. This will make it possible for StockMarketEye to automatically find most of the correct
symbols in step #3 below. See the page, How To Export Quicken Data, on Quicken’s site for details on exporting your
transactions from Quicken.

Note: Former Microsoft Money Plus Users: You may be interested in reading our guide on how to export your
investment data from Money Plus to a QIF file, suitable for import in StockMarketEye.

1. Open StockMarketEye and use the menu: File -> Import Portfolio -> Import from QIF...

2. Select the QIF file containing the investment data that you want to import into StockMarketEye.

This data will be imported into a new or existing StockMarketEye portfolio that you select in Step #4.

Once you have entered an existing QIF investment data file, click on the “Next” button to move to the next step.
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3. Map the symbols found in the import file to symbols known to StockMarketEye.

Stock (or ticker) symbols often differ between applications. In this step you can convert the stock symbols that
were found in the import file into symbols known to StockMarketEye.

Before moving to the next step, you must accept each symbol mapping by checking its “Accepted” box.

If the box is initially checked, it has been mapped automatically by StockMarketEye.

If the box is initially unchecked, there was no direct match to a StockMarketEye symbol.

You can modify the mapped, StockMarketEye symbol by clicking on the “Modify” button. This will open the
Symbol Search window where you can search for the correct symbol. Clicking “Ok” in the Symbol Search
search window will use the selected “Search Result” as the mapped, StockMarketEye symbol. If you click
“Ok”, but have not selected one of the “Search Results”, the search query itself will be used as the mapped,
StockMarketEye symbol. This allows you to enter and use unrecognized ticker symbols.

Note that you don’t need to have a valid ticker symbol for each entry, but you do need to accept all of the
mappings before continuing. Unrecognized symbols (ex. obsolete or non-existent ticker symbols) are OK to
include in the mapping and are often useful for including items in your portfolio which do not have a ticker
symbol (ex. bonds, preferred stock, etc). Note, however, that StockMarketEye will not be able to get historical
or current quotes for these symbols which can affect performance calculations and the Portfolio’s historical
value chart.

You can reset the mapped, StockMarketEye symbol to its original, unmapped symbol using the “Reset” button.
This will uncheck the symbol’s “Accepted” button and reset the StockMarketEye symbol to the symbol from
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import.

When all of the symbols have been mapped and accepted, click on the “Next” button to move to the final step.

4. Finish the import of the investment data by selecting a portfolio into which the data will be added. You can
either select an existing portfolio, or create a new one.

Click on the “Finish” button to complete the import.
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5. The investment data has now been imported into the selected portfolio.
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4.3.3 How to export your investment portfolios from Microsoft Money Plus into QIF

The Money Plus application from Microsoft allows you to export your investment portfolios into Quicken Interchange
Format (QIF) files. QIF files contain information about the transactions that have occurred in your portfolio. You can
use QIF files to transfer your portfolio information to other financial applications.

After reading this guide, you may also be interested in learning how your investment data can be transferred to
StockMarketEye using the exported QIF files.

1. Open Microsoft Money Plus and click on the “File” menu, then select “Export...”.

2. In the “Export” window, select “Loose QIF” or “Strict QIF”. The format you select here depends on where you
will be using the exported QIF file.

If you will be using the exported QIF file in StockMarketEye, you can select “Loose QIF”.

Click the ‘OK’ button to continue.
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3. Choose the file name and folder where the exported QIF data should be saved.

Each portfolio that you have in Microsoft Money Plus will be exported separately and in its own file. You should
therefore choose a name that corresponds to the portfolio you will be exporting.

Click the ‘OK’ button when you have entered the file name and directory.
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4. In the “Export” window, select “Investment” as we are only interested in exporting investment transactions.

Click the ‘OK’ button to continue.

5. In the “Select Export Account” window, click on the name of the investment portfolio/account that you would
like to export.

Click the ‘Continue’ button to finish the export.

6. Your investment portfolio has now been exported. The exported data is in the file you selected in Step #3.

Click the ‘OK’ button to finish.

Now that you’ve exported your portfolio data into a QIF formated file, learn how you can import your QIF data
into StockMarketEye and get back on top of the market today!
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Your next step...

Learn more about how you can use StockMarketEye to keep your eye on the stock market and monitor your investment
portfolios. Or just try it out yourself with our free, 30-day trial.

4.3.4 Importing Investment Data from a CSV File

You can transfer your investment data into StockMarketEye via Comma-separated values (CSV) files. You can create
CSV files via most spreadsheet applications such as Microsoft Excel or OpenOffice.org Calc. StockMarketEye can
also create a CSV file in this format. See the “Exporting to CSV” section.

CSV Import Format

StockMarketEye reads your investment data from the CSV file, one transaction per line. The data contained in each
line of the CSV file must meet the specifications described in the sections below.

• All columns must be present in each line of the CSV file.

• Column values are mandatory for the columns in bold in the “Column Order” table below.

• Column values for the other columns are optionally required, depending on the type of transaction being
recorded. See the “Column Descriptions” table below for details.

• The order of the columns in the CSV file must be the same as that specified in the “Column Order” table below.
See the example file if you are unsure.

• You may include a “header” line, but it is not required. If the header line is included, the first cell must contain
the word “date”.

Column Order

Trans-
ac-
tion
Date

Trans-
ac-
tion
Type

Sym-
bol

SharesPrice/ShareCostsFees To-
tal

Dis-
tri-
bu-
tion
Amount

Shares
Af-
fected

Cur-
rency

Ex-
change
Rate

Cash
Af-
fected

NameCom-
ment

BrokeageIdTaxesCred-
its

Ex-
chang-
eR-
ate-
Cur-
rency

ACB

You can download an example CSV investment transactions file here.

In your spreadsheet application, the file to import will look something like this:
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Column Descriptions

The following table describes the columns of the CSV file in greater detail.
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Column Usage Description
Transaction Date Value is mandatory The date of the transaction.

Available date formats are:
• MM/DD/YY or

MM/DD/YYYY (ex.
07/4/2010 for July 4th,
2010)

• YYYY-MM-DD (ex. 2010-07-
04)

• MMM D, YYYY (ex. July 4,
2010)

This column is mandatory and must
always have a value specified.

Transaction Type Value is mandatory The type of the transaction.
Available transaction types are:

• BUY
• SELL
• SELL SHORT
• COVER SHORT
• CASH IN
• CASH OUT
• DIVIDEND
• DIVIDEND REINVEST
• INTEREST IN
• INTEREST OUT
• SHARES IN
• SHARES OUT
• SPLIT
• CAPGAIN
• CAPGAIN REINVEST
• RETURN OF CAPITAL
• OTHER IN
• OTHER OUT
• FEES

This column is mandatory and must
always have a value specified.

Symbol Value is mandatory The symbol connected with this
transaction.
You must specify a symbol for ev-
ery transaction unless the transac-
tion type is cash related (CASH IN,
CASH OUT, INTEREST IN, IN-
TEREST OUT, OTHER IN, OTHER
OUT, FEES). If the transaction type
is cash related, this column can
be empty or can contain the word
“Cash”.

Shares Value is optional The number of shares associated with
this transaction. Whole and decimal
numbers are accepted.
This column is not used when the
transaction type is cash related or
for DIVIDEND, CAPGAIN or RE-
TURN OF CAPITAL transactions.
For SPLIT transactions, this column
must contain the split ratio as a deci-
mal number (i.e 2-for-1 split is 2.0).

Price/Share Value is optional The price per share of this transac-
tion.
This column is not used when the
transaction type is cash related or for
DIVIDEND, CAPGAIN, RETURN
OF CAPITAL or SPLIT transactions.
If this column is empty, StockMar-
ketEye will lookup the price of the
stock on the transaction date and use
the closing price from that date as the
price/share.

Costs Value is optional This column specifies any costs
or commissions associated with the
transaction.
If this column is empty, the costs for
this transaction are set to 0.

Fees Value is optional This column specifies any fees asso-
ciated with the transaction.
If this column is empty, the fees for
this transaction are set to 0.

Total Value is mandatory for cash transac-
tions.

The total amount of the transaction,
including costs and fees.
A value in this column is manda-
tory for CASH IN, CASH OUT, DIV-
IDEND, RETURN OF CAPITAL,
CAPGAIN, INTEREST IN, INTER-
EST OUT, OTHER IN, OTHER
OUT, and FEES transactions.
This column is not used when the
transaction type is SPLIT.
For all other transactions, if no value
is specified, the value will be com-
puted from the price/share, shares,
costs and fees columns.

Distribution Amount Value is optional The amount of the distribution per
share.
This column is only used for dis-
tribution transactions such as DIV-
IDEND, CAPGAIN, RETURN OF
CAPITAL and their re-investment
equivalents. It is for informational
purposes and can be left blank.

Shares Affected Value is optional The number of shares affected by a
distribution or SPLIT transaction.
This column is for informational pur-
poses and can be left blank.

Currency Value is optional The currency of the transaction. If
this field is left blank, the import will
determin the currency based on the
symbol (if this is a symbol specific
transaction) or take the currency of
the portfolio (if this is a cash trans-
action).

Exchange Rate Value is optional The exchange rate between the cur-
rency of this transaction and the Port-
folio’s currency on the date of the
transaction. If your transactions and
Portfolio are in the same currency,
this column can be left blank. De-
faults to 1 if left blank.

Cash Affected Value is optional Were the proceeds of this transaction
added/deducted from the Portfolio’s
cash balance? Can be specified with
‘yes’ or ‘no’ (or ‘true’ / ‘false’). If
this field is empty, the import func-
tion will determine the proper value.

Name Value is optional The full name of the company whose
stock this transaction concerns. If
this field is empty, the import func-
tion will search for a name.

Comment Value is optional Any comments you want to remem-
ber about this particular transaction,
up-to a limit of 2048 characters.
This column is optional and can be
left blank.

Brokerage Id Value is optional The ID of this transaction at the bro-
kerage.

Taxes Value is optional The taxes associated with this trans-
action.

Credits Value is optional The credits associated with this trans-
action.

Exchange rate currency Value is optional The currency to which the exchange
rate converts. Typically this is the
currency of the portfolio.

ACB Value is optional The Average Cost Basis value of this
transaction. Use for sell transacitons.
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Old CSV Format

Prior to StockMarketEye 3, a slightly different CSV format was produced and imported by StockMarketEye. The
old CSV format can still be imported, but StockMarketEye will no longer create CSV files in this format. You are
encouraged to update any of your old StockMarketEye CSV files to the current format.

Importing a CSV Investment Transaction File

Once you have created a CSV file containing your investment transactions, you can import it into StockMarketEye
with the following steps.

1. Open StockMarketEye and use the menu: File -> Import Portfolio -> Import from CSV...

2. In the “Import CSV Investment Transactions” window, click on the “Browse” button to help select the CSV file
containing the investment data that you want to import. Once you have found the file, select it and click OK.
The file’s name should now be in the “CSV Investment Transactions File” field.

CSV Columns Format - You can also select the format of the CSV file you are importing. The default “Stock-
MarketEye format” is the format described above. You can also import from the Investoscope 3 CSV format by
selecting it from the format dropdown.

Date Format - Normally you should leave the date format on “Auto” and StockMarketEye will detect the
format automatically. However, there are some formats that StockMarketEye can not detect automatically (such
as European-style date formats that conflict with US-style formats). If the dates in your CSV file have one of
these formats, select it from the dropdown, otherwise leave the dropdown on “Auto”.

It is also possible to change the advanced CSV options, such as which record separator character to use. Some
CSV files use a semicolon as a separator rather than the default comma. This can be selected with the “Advanced
CSV Options” button.

Once you have entered an existing CSV investment data file, click on the “Next” button to move to the next step.
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3. Map the symbols found in the import file to symbols known to StockMarketEye.

Stock (or ticker) symbols often differ between applications. In this step you can convert the stock symbols that
were found in the import file into symbols known to StockMarketEye.

Before moving to the next step, you must accept each symbol mapping by checking its “Accepted” box.

If the box is initially checked, it has been mapped automatically by StockMarketEye.

If the box is initially unchecked, there was no direct match to a StockMarketEye symbol.

You can modify the mapped, StockMarketEye symbol by clicking on the “Modify” button. This will open the
Symbol Search window where you can search for the correct symbol. Clicking “Ok” in the Symbol Search
search window will use the selected “Search Result” as the mapped, StockMarketEye symbol. If you click
“Ok”, but have not selected one of the “Search Results”, the search query itself will be used as the mapped,
StockMarketEye symbol. This allows you to enter and use unrecognized ticker symbols.

Note that you don’t need to have a valid ticker symbol for each entry, but you do need to accept all of the
mappings before continuing. Unrecognized symbols (ex. obsolete or non-existent ticker symbols) are OK to
include in the mapping and are often useful for including items in your portfolio which do not have a ticker
symbol (ex. bonds, preferred stock, etc). Note, however, that StockMarketEye will not be able to get historical
or current quotes for these symbols which can affect performance calculations and the Portfolio’s historical
value chart.
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You can reset the mapped, StockMarketEye symbol to its original, unmapped symbol using the “Reset” button.
This will uncheck the symbol’s “Accepted” button and reset the StockMarketEye symbol to the symbol from
import.

When all of the symbols have been mapped and accepted, click on the “Next” button to move to the final step.

4. Finish the import of the investment data by selecting a portfolio into which the data will be added. You can
either select an existing portfolio, or create a new one.

Click on the “Finish” button to complete the import.
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5. The investment data has now been imported into the selected portfolio.
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4.4 Measuring Investment Performance

4.4.1 Individual Investment Performance Metrics

The Prices/Fundamentals view of a Portfolio shows your current, open positions. All values, gains/losses and amounts
in the columns of the Prices/Fundamentals view are only related to the current, open positions. Closed positions have
no effect on values, gains/losses or amounts shown in the Prices/Fundamentals view.

You can measure the unrealized gain/loss on your current holdings in the Prices/Fundamentals views using the follow-
ing columns.

• Gain / Gain % - The gain or loss in this investment since purchase, including transaction costs.

• TR / TR % - The total return gain or loss in this investment since purchase, including transaction costs and any
recorded dividends, capital gains, return-of-capital or interest payments.

• Ann TR % - The annualized TR % value. Calculated as: TR% ^ (daysHeld/365) - 1 * 100.

• CAGR - The Compounded Annual Growth Rate of this investment since purchase. This is an annualized value.

• TWRR - The compounded annual Time Weighted Rate of Return (TWRR). For single lots holdings, the TWRR
is the same as CAGR. For multiple-lot holdings, the calculation uses all currently held lots (including those from
dividend re-investment) as cash flows. This is an annualized value.

For the Total line of the portfolio, the calculation uses all currently held lots of all current holdings as cash flows.
It does not include any cash transactions in the calculation.

• IRR - The Internal Rate of Return (IRR) (also known as the Dollar/Money-Weighted Return). For single lots
holdings, the IRR is the same as CAGR. For multiple-lot holdings, the calculation uses all currently held lots
(including those from dividend re-investemnt) as cash flows. This is an annualized value.

For the Total line of a portfolio, the calculation uses all currently held lots of all current holdings as cash flows.
It does not include any cash transactions in the calculation.

Note: You can add columns to your portfolio’s view as described in the Configuring Columns section.

The list of columns available in each view is available in the General Features and Documentation section, under
“Configuring Columns”.

Closed Position Gain/Loss

Realized gains/losses on individual investments can be viwed in the Gain/Loss Report. You can learn more about
viewing the gain/loss on closed positions in the The Gain/Loss Report section.

Portfolio Performance Metrics

The Summary Report calculations the performance of your portfolio over any time period. All transactions recorded
in your portfolio’s Transactions report are used in the calculation of the Summary Report.

You can learn more about viewing the performance of your portfolio in the The Summary Report section.
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4.4.2 Comparing Performance to a Benchmark

Gauging the performance of your investments is an important part of the investment process. But knowing an invest-
ment’s gain or loss is only part of the picture. Comparing that gain or loss to what’s happening in the broader market,
gives you another important perspective and another data point in your decision making process.

For example, an investment that has improved 10% over the last 6-months sounds good. However, if the broader
market, as defined by an index or an ETF that mirrors the index, has improved by 15%, your investment’s 10%
improvement may not be as good as you think.

To help give you this important perspective on your investments, StockMarketEye provides “Benchmark” columns
to help compare your investment’s performance with the broader market. You can use any ticker symbol as your
comparison benchmark and you can use a different benchmark for each portfolio.

Setting the Benchmark Symbol for a Portfolio

By default, the benchmark columns will use the S&P 500 index, ^GSPC, as the comparison benchmark. You can
change this symbol in the Portfolio’s Settings window, in the “Portfolio” tab as seen in the image below. A number of
world indexes have been included in the list, but you can also enter your own symbol. For example, you may wish to
use the SPY, an ETF that corresponds to the price and yield performance of the S&P 500 and pays dividends (which a
pure index symbol, such as ^GSPC, does not).

Note: Indexes do not pay dividends themselves because they are not tradable securities. ETFs or mutual funds that
mirror indexes however can (and often do) pay dividends. You may want to use one of these ETFs or mutual funds as
your benchmark symbol, rather than the index itself as the ETF represents something you can actually invest in and
receive dividend payments from, making the comparison more realistic.

For example: DIA is an ETF that mirrors the Dow Jones Industrial Average; SPY is an ETF that mirrors the S&P 500
Index; and QQQ is an ETF that mirrors the NASDAQ-100.
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Comparison Benchmark Columns

StockMarketEye provides the following columns that can be added to your portfolios, allowing you to compare your
investment’s performance vs the chosen benchmark. See the section, Configuring Columns, for how you can add these
columns to your portfolio.

• Benchmark Symbol - The currently configured benchmark comparison symbol. In a Portfolio, this symbol will
also be shown in the column header of each benchmark column. You can specify the ticker symbol to use as the
benchmark comparison symbol in the Portfolio’s Settings window, in the “Portfolio” tab. You can use any ticker
symbol you like as well as having a different symbol for each portfolio.

• Benchmark Shares - The number of shares in the benchmark that would be owned if this item’s initial invest-
ment amount was used to purchase the benchmark symbol and all dividends paid by the benchmark since the
purchase date were re-invested.

• Benchmark TR (aka. Total Return) - The total return, including transaction costs and dividends, that this item’s
initial investment amount would have returned if it was invested in the benchmark and all dividends paid by the
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benchmark since the purchase date were re-invested.

• Benchmark TR % (aka. Total Return Percentage) - The total return percentage, including transaction costs and
dividends, that this item’s initial investment amount would have returned if it was invested in the benchmark and
all dividends paid by the benchmark since the purchase date were re-invested.

• Benchmark CAGR - The Compounded Annual Growth Rate (CAGR) that this item’s initial investment amount
would have returned since purchase if it was invested in the benchmark. Includes transaction costs and re-
invested dividends.

• Benchmark TWRR - The compounded annual Time Weighted Rate of Return (TWRR) that this item’s initial
investment amount would have returned since purchase, if it was invested in the benchmark. Includes transaction
costs and re-invested dividends. The calculation is performed using only the currently held, non-re-investment
lots as cash flows.

• Benchmark IRR - The Internal Rate of Return (IRR) (also known as the Dollar/Money-Weighted Return) that
this item’s initial investment amount would have returned since purchase, if it was invested in the benchmark.
Includes transaction costs and re-invested dividends. The calculation is performed using only the currently held,
non-re-investment lots as cash flows.

Note about Benchmark Values

• We suggest using a benchmark symbol that you can actually invest in, rather than a pure index symbol. Symbols
you can actually invest in provide a more “real-life” benchmark, including paying dividends, which a pure index
symbol will not.

For example, use SPY rather than ^GSPC; or QQQ rather than ^IXIC.

• The benchmark symbol’s dividends paid since the item’s purchase date are re-invested. All benchmark column
values are computed with those re-invested dividends taken into account.

• 2 investments purchased on exactly the same day may have slightly differing benchmark (TR%, CAGR, etc)
values. This is because transaction costs are included in the benchmark value calculations. As the transaction
costs are usually slightly different percentages of the initial purchase amount, that difference is also reflected in
the benchmark column values.

4.4.3 Cost Basis Calculations

Ths cost basis of your investment is its original value, including commisions and fees, adjusted for splits and distribu-
tions. The cost basis value is often referred to as “tax basis” value because it is used to determine your tax obligations.

Re-invested distributions (dividends and capital gains) change your cost basis by adding new lots to your holding.
The cost basis value of previously purchased lots of a holding does not change, but the new lots purchased with the
distribution proceeds raise the cost basis of your entire investment.

Calculation Methods

StockMarketEye supports 2 methods of cost basis calculation:

1. Specific Lot Basis - This is the default way cost basis is calculated in StockMarketEye. Each lot of an invest-
ment, whether purchased directly or through re-investment, is priced individually.

2. Average Cost Basis (ACB) - This method adds the cost basis values of each lot to arrive at a total value. The
ACB per share value is calculated by dividing the total value by the total number of shares. Adding new lots
(through normal purchase or re-invested purchase) changes the current ACB per share calculation. At the time
of a sale, the current ACB per share value is used to calculate the cost basis of the sold shares.
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Choosing the Calculation Method for a Portfolio

By default, a portfolio uses the Specific Lot basis calculation method. You can change to use the Average Cost Basis
(ACB) calculation method by marking the option in the portfolio’s Properties window.

Available Cost Basis Columns

General Columns

These columns show the cost basis values using the currently selected calculation method (either standard or ACB)
for the current portfolio.

• Cost Basis - The total cost basis for the position. It will either be the standard cost basis (SCB) or the average
cost basis (ACB), depending on the method selected for this portfolio.

• Cost Basis Per Share - The cost basis per share of the position. It will use either the standard cost basis (SCB)
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or the average cost basis (ACB), depending on the method selected for this portfolio.

Standard Specific Lot Method Columns

These columns show the cost basis values using the default, specific lot calculation method.

• SCB

• SCB Per Share

Average Cost Basis (ACB) Method Columns

These columns show the cost basis values using the average cost basis (ACB) calculation method.

• ACB

• ACB Per Share

4.5 Reports

4.5.1 The Transactions Report

A transaction is a record of activity in your portfolio. Each transaction represents an action that occurred in your
portfolio, such as a buy, sell, dividend or deposit.

The StockMarketEye Transactions report contains a list of all of the transactions that have occurred in your portfolio.
It is the history of your portfolio; what happened and when it happened.

Note: The Portfolio’s Prices view (i.e. your current holdings) shows what you currently own in this portfolio. It is
related to the Portfolio’s transactions, in that the actions represented by the transactions (buys, sells, splits, dividends,
etc) built the Prices view. But the items in the Prices view are not transactions. They are your current holdings that
were built from the actions represented by the transactions.

You can access the Transactions report by clicking on the “Reports” button in the toolbar and selecting the “Transac-
tions” Report type.

You can filter which transactions are visible in the report by using the filtering tools to the right of the Report type
selector.

• Range - allows you to specify a standard date range (“This Month”, “Last 3 Months”, “Year to Date”, etc) for
the transactions that should be shown in the report.
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• “From” and “To” - allow you to specify a precise range of dates for the transactions that should be shown in the
report.

• “Symbol” - allows you to show only the transactions for a specific ticker symbol.

• “Type” - allows you to show only the transactions for a specific type of transaction (Buy, Sell, Dividend, etc).

You can set all of the filtering tools back to their default settings by clicking on the “Reset filters” menu found in the
“More” menu on the right of the toolbar.

Showing Transaction Totals

You can enable a “Total” line in the Transactions report that shows the totals of certain columns, just like you would see
in a spread sheet. This can be particularly useful when used in combination with some of the other filters. For example,
you can show just the dividends paid over a specific time period, and then see the total value of those dividends in the
Total line.

To enable the “Total” line in the Transactions report, use the “More” menu on the right-hand side of the toolbar. Then
select “Other Filter Options”, and then “Show Totals”.

You will then see a total line at the bottom of the list of transactions.

Editing Transactions

You can modify the details of a transaction after it has been added. Changes that you make in a transaction’s details
that are relevant to an existing position are automatically reflected in the Prices/Fundamentals view.

There are several ways to modify the details of a transaction.
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1. Double-click on the transaction, or select it and then open the “More” menu on the far right of the toolbar, then
select the menu “Show transaction details”.

A window specific to the type of transaction being edited will open. In this window you can modify many details
of the transaction including date and price.

2. You can also edit some of the transaction’s details in-line in the table. To do this, first select the transaction to
edit, then click in the cell of that line that you would like to edit. You can now change the value there and press
‘Return’ for the change to take effect.

Moving and Copying

You can move or copy transactions from one portfolio to another.

1. First select the transactions you want to move or copy.

2. Use the “More” menu to select either “Move...” or “Copy...”. Alternatively, you can right-click (ctrl-click on
Mac) on the selected transactions, then select either “Move...” or “Copy...” from the popup menu.
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3. In the move or copy window, choose the portfolio to which the selected transactions should be copied or moved.

Note that moving a transaction that has a corresponding position currently in the Prices view, does not move that
position to the other portfolio. Only the transaction is moved, causing the Prices view to become out of sync
with the transactions. A warning message will be displayed at the bottom of the move window if this is the case.
In this situation, if you also want to move the position from the prices view, it is best to perform the move from
the Prices view, as from there the corresponding transaction will also be moved.

4. Press OK for the transactions to be moved or copied.

Delete a Transaction

It is also possible to delete transactions. Deleting a transaction will remove any portfolio item created by this transac-
tion as well as adjusting the cash balance to negate the effects of this transaction.

To delete a transaction, select the transaction, then use the “More” menu or context popup menu to select “Delete from
Transactions...” You must confirm that you want to delete the transaction.
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Exporting to CSV

You can export your transactions to CSV for use in a spreadsheet like Microsoft Excel or OpenOffice Calc.

1. Use the “More” menu to select the “Export to CSV...” menu.

2. In the “Transactions Export” window, select the file to which the transactions will be written.

3. Then select the view option to export:

• “Transactions report” - this will include all of the currently configured columns in the CSV file.

• “Transactions report with import compatible columns” - this will include all of the columns that are nec-
essary for StockMarketEye to use this file as a CSV import file.
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4. Press OK to export the transactions to CSV. Clicking on the file’s link in the finished window will open the file
in your spreadsheet application.
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4.5.2 The Summary Report

The Summary Report provides an overview of your portfolio’s performance as well as the details of the activity in
your portfolio over a specified time period. It is meant to provide similar information to what you would receive in
an account statement from your brokerage. Performance metrics, benchmark comparisons, activity totals, starting and
ending holdings, and the transaction log are included in the report.

To access the Summary Report, click on the “Reports” button in the toolbar and select the “Summary” Report type.

You can setup the Summary statement using the filtering tools to the right of the Report type selector.

• Range - allows you to select a standard time period (“This Month”, “Last 3 Months”, “Year to Date”, etc) for
the report.

• From and To - allow you to specify a precise time period for the report.

• Benchmark - specify the benchmark ticker symbol to use for the “Benchmark” line in the Value Summary and
Period Returns sections.

You can set all of the filtering tools back to their default settings by clicking on the “Reset filters” menu found in the
“More” menu on the right of the toolbar.

Note that the dates selected for the report, either via the Range or From/To selectors, will be adjusted to dates for
which the markets were open. That is, if the selected start or end date is on a weekend or market holiday, the date used
in the report will be moved forward to the next trading day.

• Value Summary Section
• Period Returns Section
• Cash, Distributions and Purchases Sections
• Portfolios and Transactions

Value Summary Section

The Value Summary section displays the value of your portfolio on the starting and ending dates of the selected time
period. The values are from the close of trade on the starting date through the close of trade on the ending date.
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Portfolio Line

The Portfolio line contains the values of your actual portfolio, based on the transactions that are recorded in the
Transactions report.

The starting and ending dates are taken from the “Range” or “From”/”To” filter in the toolbar. The market value of the
portfolio at the close on the selected dates is displayed for the starting and ending portfolio values. These values are
calculated by using the transactions recorded in the Transactions report to re-build the portfolio on the corresponding
date (similar to the way the Back-In-Time report is produced).

• Starting Market Value - The market value of the portfolio at the close on the starting date.

• Ending Market Value - The market value of the portfolio at the close on the ending date.

• Net Change - The difference between the starting market value and the ending market value. This value is
influenced by the performance of your investments as well as any cash flows (in or out) that occurred in the
portfolio during the selected time period.

Benchmark Portfolio Line

The Benchmark Portfolio line represents an imaginary portfolio that has 100% of its value invested in the selected
benchmark symbol. The starting value of the imaginary benchmark portfolio is the same as the starting value of the
actual portfolio on the given date. The ending value is based on the performance of the benchmark symbol over the
given time frame.

In order to be able to compare the benchmark portfolio’s ending value with the ending value of the actual portfolio,
cash flows (in or out) that occurred in the actual portfolio are also applied to the imaginary benchmark portfolio. These
cash flows increase or decrease the value of the benchmark portfolio and thus the amount invested in the benchmark
symbol.

For benchmark symbols that pay dividends, such as the SPY (SPDR S&P 500), those dividends are re-invested.

The Net Change value of the imaginary benchmark portfolio is the difference between its starting value and the ending
value.
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Period Returns Section

The Period Returns section displays the performance of your portfolio and the benchmark portfolio over the selected
time period.

Time-Weighted Rate of Return

The Time-Weighted rate of return, or TWRR, represents the performance of your portfolio and benchmark over
the entire selected time period. Time weighted returns are not affected by cash flows (i.e. deposits, withdrawals, etc)
or their timing (i.e. when they occurred). It is a pure investment performance measure, showing how effective the
investment decisions of the portfolio’s manager were. Time weighted returns are the standard returns reported by the
investment industry.

The Annualized Time-Weighted rate of return, or TWRR (Ann) value, represents the annualized performance of
your portfolio and benchmark over the selected time period.

The benchmark portfolio’s TWRR is typically equal to the actual price change of the benchmark symbol over the
selected time period. However, when using a benchmark symbol that pays dividends, for example, the SPY (SPDR
S&P 500), the dividends are re-invested in the imaginary benchmark portfolio, so the TWRR and TWRR (Ann) values
will be higher than the the simple price change percentage of the benchmark symbol over the selected period.

Dollar-Weighted Rate of Return

The Dollar-Weighted rate of return, or IRR value, represents your portfolio’s internal rate of return over the entire
selected time period. Dollar weighted (also referred to as money-weighted) returns measure the absolute, overall
growth of the portfolio, including price gains/losses and cash flows, including the timing of those cash flows.

The IRR (Ann) value, or Annualized Dollar-Weighted rate of return, represents your portfolio’s annualized internal
rate of return over the selected time period. The annualized IRR calculation is equivalent to Excel’s XIRR function.

The benchmark portfolio’s IRR is calculated using the cash flows (in or out) that occurred in the actual portfolio. If
the benchmark symbol pays dividends, they are re-invested and contribute to the balances used in the performance
calculation.
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Cash Flows And Balances Used for TWRR and IRR Calculations

When calculating cash flows for a normal, cash-based portfolio, the Summary report considers every “cash in”, “cash
out” “other in” and “other out” transaction as a cash flow. “Shares in” and “shares out” transactions are also considered
cash flows if their “Cash Affected” column is set to true (this corresponds to the “Cash balance” field with a setting of
“Update” in the transaction’s details window). Balances are computed for the first and last days of the report period,
as well as for every day there was a cash flow.

For invested-capital portfolios (i.e. portfolios that don’t use the Cash balance), the Summary report considers every
“buy”, “sell”, “sell short” and “cover short” tranasction as a cash flow. “Shares in” and “shares out” transactions are
also considered cash flows if their “Cash Affected” column is set to true. Cash “dividend”, “capital gain”, “return of
capital” and “interest in” transactions are considered negative cash flows. Balances are computed for the first and last
days of the report period, as well as for every day there was a cash flow.

Cash, Distributions and Purchases Sections

These sections display the totals of various transaction types and activity over the selected time period.

Cash, Interest and Fees Section

This section shows the totals of various cash type transactions over the selected time period. It includes totals for cash
deposits and withdrawals, interest received and paid, and fees.

Distributions Section

This section shows the totals of various distribution type transactions over the selected time period. It includes totals
for dividends (cash and re-invested), capital gain distributions (cash and re-invested) and Return of Capital.
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Purchases and Sales Section

This section shows the total amount of securities purchased and sold over the selected time period.

Portfolios and Transactions

The final 3 sections of the Summary report contain the starting portfolio, the ending portfolio and the transactions
during this period.

Starting Portfolio

This section shows the portfolio as it was at the close of trade on the starting date of the selected time period.

Ending Portfolio

This section shows the portfolio as it was at the close of trade on the ending date of the selected time period.

The “Gain” and “Gain %” columns represent the change in the given holding over the selected time period. If the
stock was purchased during the time period these columns represent the change since purchase.

For the Total line, the “Gain” and “Gain %” columns represent the total value change in the portfolio over the selected
time period, including cash deposits, withdrawals, and market value changes.

Transactions List

This section shows all of the transactions that occurred in this portfolio over the selected time period.

4.5.3 The Gain/Loss Report

The Gain/Loss Report is a record of how well your trades have performed. Each “buy” is matched with the corre-
sponding “sell” transaction and the gain or loss on that trade shown in the report.

To access the Gain/Loss Report, click on the “Reports” button in the toolbar and select the “Gain/Loss” Report type.

You can filter which trades are visible in the report by using the filtering tools to the right of the Report type selector.

• Range - allows you to specify a standard date range (“This Month”, “Last 3 Months”, “Year to Date”, etc) for
the trades that should be shown in the report. If the “Close Date” of the trade falls within the date range, the
trade will be included in the report.
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• From and To - allow you to specify a precise range of dates for the trades that should be shown in the report. If
the “Close Date” of the trade falls within the date range, the trade will be included in the report.

• Symbol - allows you to show only the trades for a specific ticker symbol.

• Include open positions - allows you to include open positions in the report, using the current date as the “Close
Date”.

You can set all of the filtering tools back to their default settings by clicking on the “Reset filters” menu found in the
“More” menu on the right of the toolbar.

Exporting to CSV

You can export your Gain/Loss Report to CSV for use in a spreadsheet like Microsoft Excel or OpenOffice Calc.

1. Use the “More” menu to select the “Export to CSV...” menu.

2. In the “Gain/Loss Export” window, select the file to which the trades will be written.

3. The exported file will contain all of the currently displayed trades with all of the currently configured columns.

4. Press OK to export the Gain/Loss Report to CSV. Clicking on the file’s link in the finished window will open
the file in your spreadsheet application.
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4.5.4 The Back-in-Time Report

The Back-in-Time Report allows you to view your portfolio as it was on the close of trade on a specific day in the
past. StockMarketEye computes how your portfolio looked on the specified day by using the transactions you have
recorded as well as the historical quote data for the items in your portfolio on that day.

To access the Back-in-Time Report, click on the “Reports” button in the toolbar and select the “Back-in-Time” Report
type.

Use the “Portfolio at close on” date tool to set the past date for which you’d like to see your portfolio. You can set the
date tool back to the last day of the previous month by clicking on the “Reset filters” menu found in the “More” menu
on the right of the toolbar.

Exporting to CSV

You can export your Back-in-Time Report to CSV for use in a spreadsheet like Microsoft Excel or OpenOffice Calc.

1. Use the “More” menu to select the “Export to CSV...” menu.

2. In the “Back-in-Time Export” window, select the file to which the trades will be written.

3. The exported file will contain your holdings (including total) as they were at the close of trade on the date
specified on the Back-in-Time Report toolbar.
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4. Press OK to export the Back-in-Time Report to CSV. Clicking on the file’s link in the finished window will open
the file in your spreadsheet application.
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4.6 Portfolio Groups and Investment Categories

4.6.1 Managing Grouped Portfolios

Grouped portfolios are a powerful way to organize and manage your various investment accounts. They can be used
any time you want to see the combination of 2 or more individual portfolios.

Create a Grouped Portfolio

1. Use the menu, Portfolio -> New Portfolio Group...

2. In the “Portfolio Group Properties” window, in the General tab, add a Name and optionally a description.

In the Group tab, you can change the currency and benchmark symbol used by this group.

162 Chapter 4. Portfolios - Tracking Your Investments

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


www.stockmarketeye.com StockMarketEye User’s Guide, Release 4.2

Click “OK” to create the new group.

3. Locate the new group in the folders view on the left-hand side of the StockMarketEye window.
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4. You can now start using your group by moving portfolios and other groups into it.

Managing Your Portfolio Groups

You can drag-and-drop groups and portfolios in the Folders view to arrange them to your needs. Only the top “Portfo-
lios” item can not be moved or deleted.

See the on-line User’s Guide for an animated example.

Delete A Portfolio Group

You can only delete a portfolio group if it does not contain any portfolios or other groups.

1. Select the empty portfolio group.
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2. Right-click (or ctrl-click on Mac) on the empty group to access the context menu, then select “Delete...”.
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3. Confirm that you want to delete the group.

4. The group has been removed.

4.6.2 Using Grouped Portfolios

Using grouped portfolios can help you better understand your investments across multiple portfolios.

When you select a grouped portfolio in the Folders view (left-hand side of the StockMarketEye window), you’ll see
the following view.
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You can switch between the various views of the group portfolio by clicking on the “Totals”, “Prices”, “Fundamen-
tals” and “Reports” buttons in the toolbar.

Clicking on the “Get Quotes” button will refresh the quotes for all portfolios and sub-groups contained under this
group.

Totals View

The Totals view shows a summary of the totals for each portfolio and sub-group contained in this group. The top line
of the view shows the totals of all contained portfolios and sub-groups. Each contained portfolio and sub-group is a
separate line below the top Total line.

Just as in a file browser, the contained portfolios and sub-groups are shown in a “tree” structure. Each portfolio and
sub-group is indented below the top Total line. As a group can contain other sub-groups, which themselves contain
other portfolios and sub-groups, each level of the tree is indented further to the right.

You can add, move, and remove the columns shown in the Totals view, as you would for any other view in Stock-
MarketEye. For a full explanation of how to configure the visible columns, please refer to the section, Configuring
Columns.

The columns available in the Totals view can be seen in the section, Portfolio Group’s Totals View Columns.

Combined Portfolio (Prices and Fundamentals Views)

The Combined Portfolio consists of the “Prices” and “Fundamentals” views. It is a virtual portfolio that combines of
all individual holdings from the contained portfolios and sub-groups.

The Prices and Fundamentals views are very similar to those from a standard portfolio, but you can not buy, sell or
add any other type of transaction.

The columns of the Prices and Fundamental views can be configured, just as they can in a standard portfolio. The
sections, Portfolio Columns, explains which columns are available for these views.

You can also add Investment Categories to the combined portfolio.

Reports

The Reports section allows you to run reports using all transactions from the contained portfolios and sub-groups.

The types of reports available are the same as in a standard portfolio:
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• The Transactions Report

• The Summary Report

• The Gain/Loss Report

• The Back-in-Time Report

Transactions can not be edited from the group portfolio’s Transactions report. You can only edit transactions in the
original portfolio.

4.6.3 Investment Categories

Investment Categories are a powerful tool to improve the organization, tracking and management of your current
holdings. You can add categories to any portfolio’s “Prices” or “Fundamentals” view.

A category can contain individul positions as well as other categories, allowing you to create a hierarchy of categories.

An example portfolio that uses categories can be seen in the following image.

Categories lines in the portfolio are shown in bold and display the totals for the contained positions and sub-categories.

Create A Category

Note: Before you create a new Category, we recommended that you turn off any current column sorting. If the lines in
the portfolio are being sorting by one of the columns, the Category will not appear where you expect it to and moving
items into a Category may not work as you expect. You can turn the sorting back on after you have your Category
setup.

To turn off column sorting, click 3 separate times on one of the column headers: the first time will turn on sorting for
that column, the 2nd time will change the direction of the sort, the 3rd time will turn off sorting.
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1. With your portfolio selected in the folders view, use the menu: Portfolio -> New Category...

2. In the “Category Properties” window, add a Name and optionally a Description. You can also set the currency
to use for the category.

4.6. Portfolio Groups and Investment Categories 169

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

Click “OK” to create the category.

3. Locate the new category in your portfolio.

4. You can now start using your category by moving positions and other categories into it.

Managing Your Portfolio’s Categories

You can drag-and-drop positions and categories in the portfolio to arrange them to your needs. Only the “Cash” and
“Total” lines can not be moved or removed.

See the on-line User’s Guide for an animated example.

Delete A Category

You can only delete a category if it does not contain any positions or other categories.

1. Select the empty category.

2. Right-click (or ctrl-click on Mac) on the empty category to access the context menu, then select “Delete Cate-
gory...”.
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3. Confirm that you want to delete the category.

4. The category has been removed.

4.7 Other Portfolio Related Topics

4.7.1 Rebuild Your Portfolio From Its Transactions

StockMarketEye does its best to automatically keep your portfolio (“Prices” view - i.e. your current holdings) and
the portfolio’s transactions list in sync. However, there are times when the “Prices” and “Transactions” can get out of
sync. For these situations, StockMarketEye provides a way to rebuild the Prices view from the Transactions.

Why do they need to be in sync?

Keeping the Prices view and the Transactions in sync is important in order to keep an accurate view of your cur-
rent holdings. It also is important for calculating the historical values of your portfolio, including those used in the
portfolio’s Market Value chart, the portfolio’s return values in the Summary report, and the Back-in-Time report.
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In these situations, where the historical values of your portfolio are used, StockMarketEye will play back the trans-
actions one day at a time, in order to chronologically build the Prices view and record the resulting values. All
calculations that are based on historical data use these generated values, so keeping the transactions list complete and
correct ensures that StockMarketEye can correctly and accurately calculate historical values and returns.

When might I need to rebuild the Prices view?

There are 2 main situations when portfolio synchronization is necessary.

1. Changing the details of a split, such as its date of execution, or any of the transactions on the split stock can
cause the Prices view to get out of sync with the transactions. In this case you will need to run the rebuild the
Prices view manually.

2. You have added (manually or via import) past transactions that shouldn’t affect your current Prices view, but
due to the way StockMarketEye applies transactions, the Prices view was incorrectly modified.

It’s also possible that a bug in StockMarketEye may have caused your Prices view to get out of sync. In this case, you
may also want to rebuild it from the transactions.

The Portfolio Rebuilding Tool

The portfolio rebuilding tool walks you through the rebuilding process, explaining the steps in separate pages.

Clicking on the “Finish” button on any page will start the rebuilding process using default settings for any options that
have not yet been selected.

You can run the tool manually from the “Portfolio -> Rebuild Portfolio from Transactions...” menu.
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Introductory Page

The tool’s intro page explains a bit about how the tool works. Click “Next” when ready to move on to the next page.
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Rebuild Method Page

On this page you can select the type of rebuilding you would like to run.
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There are normally 2 types of rebuild possible, unless you have split transactions in your portfolio, in which case, only
the first type is available.

1. Rebuild Portfolio from Transactions - Recommended

This method chronologically applies the transactions of your portfolio to build a new portfolio. The new port-
folio will replace the current portfolio (“Prices” view).

You can preview how this new portfolio will look by clicking on the “Preview” button (pointed to by the
red arrow in the image).

After the rebuild is finished, you may need to adjust the portfolio’s cash balance. You can do this using the
menu: Portfolio -> Add Cash Transaction... in order to add or subtract from the cash balance. Be sure to select
the appropriate date for the transaction (typically before the first buy transaction).

2. Rebuild Transactions from Portfolio

This is the opposite of the recommended method. The transactions of your portfolio will be updated to corre-
spond to the items from the current “Prices” view. This method is normally not recommended as differences
can remain between the “Prices” view and the “Transactions” view.

This method can be useful, however, if your transactions and portfolio differ significantly. This could have
occurred with older versions of StockMarketEye which did not maintain the transactions log or allowed trans-
actions to be removed or modified without removing or modifying the corresponding portfolio item.

NOTE: This method will not be available if your transactions contain any splits.

4.7. Other Portfolio Related Topics 175

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

Backup Page

Licensed versions of StockMarketEye will allow you to create a backup of your data before starting the rebuild.

Making a backup is recommended, at least the first time you run the rebuilding tool. Having a backup available allows
you to get your portfolio back to the pre-rebuild form, in case the changes made by the rebuilding tool were not to
your liking.

Click the “Finish” button to start the backup and rebuilding process.

I still see differences and inconsistencies!?!

After rebuilding, the Prices view of your portfolio will correspond to the transactions that are recorded in the Transac-
tions report.

If you still see differences or inconsistencies in any of the related areas (Market Value chart, Back-in-Time chart,
Summary report, etc), there are a couple of things to verify:

1. Double check all of your transactions in the Transactions report. Ensure that all of the transactions have been
entered, and that their values (i.e. number of shares, prices, dates, etc) are consistent and correct. If needed,
make corrections or additions, then re-run the rebuild too.

2. If your portfolio currently contains a symbol for which historical quote data is not available, you may see
different values than you would expect. In this case, when calculating the value of the portfolio on any given day,
StockMarketEye will simply use the purchase price of that position, rather than the actual value of that position
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on that day. If the current value of that position is higher or lower than the purchase value, that difference will
be carried over into the portfolio’s calculated values for that day.

4.7.2 Changing A Holding’s Ticker Symbol

Sometimes you need to change a transaction or holding from one ticker symbol to another.

For example, if a company changes ticker symbols, you’ll want to keep your portfolio up-to-date by changing the
symbol too.

Or, if you’d like to switch from the Yahoo Finance ticker symbol to using the Google Finance ticker symbol for a
particular stock (or vice versa).

To change the ticker symbol, follow the steps described below.

Steps for Changing Ticker Symbols

1. Go to the Portfolio or Watchlist where you have the symbol you want to change. (Note that the screenshots below
are for changing a symbol in a Portfolio, but the same principles apply for changing a symbol in a Watchlist.)

2. Select the item whose symbol you want to change.

3. Click on the “Details” button in the toolbar. The “Enter Purchase Details” window will open.
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4. In the “Enter Purchase Details” window, click on the “Change” link to the right of the symbol.
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5. You can now change the symbol in the Symbol field. Type in the new ticker symbol or click on the “Search”
button.
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6. If you clicked on the “Search” button, the “Symbol Search” window will open and show both Yahoo and Google

symbols. Yahoo Finance symbols have a Yahoo! ( ) icon in the first column. Google Finance symbols have

a Google ( ) icon in the first column. Select the symbol you wish to change to, then click on the OK button
in the search window.
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7. The new symbol will now be in the “Symbol” field. Click on the OK button in the “Enter Purchase Details”
window.
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8. When changing the symbol of a holding in your portfolio, a confirmation window will appear. Click on the
button, “Change All Items and Transactions With The Same Symbol (Recommended)”. It is usually best to
change all items in your portfolio (Prices view) and Transactions that have the same symbol to the new symbol.

If you have an alert setup for the old ticker symbol, you can also choose to update the alert so it uses the new
symbol too.
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9. The symbol has now been updated.
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4.7.3 Changing A Holding’s Currency

By default, StockMarketEye sets the currency of a holding based on the exchange on which the symbol trades. For
example, the symbol, LLOY.L, is recognized as trading on the London Stock Exchange, so StockMarketEye will by
default set the currency to GBP (denoting a denomination in pence). The symbol, TLS.AX, is recognized to trade in
Australia and therefore AUD is chosen as the currency.

However, this automatic currency selection may not always be correct. Some securites can trade in a currency other
than the default currency for the exchange. For example, on the London exchange, securities are usually denominated
in pence, but can also be denoninated in Pounds, US Dollars or even Euros. Expecially with securities on the London
exchange, this can lead to values in your StockMarketEye portfolio that are off by a factor of 100.

If the currency chosen by default is not correct, you can change it to the correct currency as described below.

Steps for Changing A Holding’s Currency

1. In your portfolio, Select the holding that you would like to change and click on the Details button in the toolbar.
The “Enter Purchase Details” window will open.

2. In the “Enter Purchase Details” window, click on the “Currency Options” section to expand it.

3. Click on the “Change” button and select the new currency.

For example, if your security trades on the London exchange, the default currency will be GBP (British Pence).
But if this security is actually denominated in Pounds, you should select GBPD (British Pounds) as the currency.
If it trades in U.S. Dollars, select USD, or EUR if it is denominiated in Euros.

If necessary, you can also specify an exchange rate, or accept the default provided by StockMarketEye, which
will be the closing exchange rate for the purchase date.

4. Click on the OK button. StockMarketEye will save the changes and re-calculate the values.
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4.7.4 Transaction Accuracy and Completeness

Your portfolio’s transactions are recorded in the Transactions report. Transactions are a record of the activity that
occured in your portfolio, from the first deposit of funds or transfer of stock, through all of the sales, purchases,
dividends, interest, fees and other activity that occured since then.

The list of transactions should be as complete and accurate as possible. StockMarketEye uses the transactions in
a number of different situations, and the completeness and accuracy of the transactions affects the calculations that
StockMarketEye makes. If there was activity in the portfolio that was not included in the transactions, or values in the
transactions that are not consistent with the current holdings (Prices view), it will affect what you see in the Portfolio’s
chart, Summary report and Back-in-Time report.

One place where complete and accurate transactions are necessary is when calculating performance, such as in the
Summary report. To compute performance values, StockMarketEye builds your portfolio from scratch using the
transactions recorded in the Transactions report. If the transactions are not consistent with what actually happened in
your portfolio, the performance numbers and balances will be off from what you’d expect.

Another place where StockMarketEye needs complete and accurate transactions is in the Back-in-Time report. Here
again, the transactions are played forward in order to rebuild the portfolio on any given day in the past. If the transac-
tions are not accurate or if there are missing transactions, the resulting back-in-time view will not be accurate.

StockMarketEye tries to correct for certain problems in the transactions when importing from a brokerage. This
can cause placeholder transactions to be created. However, StockMarketEye can not automatically correct for all
inaccurate data so it is best to double check your transactions for accuracy, whether they were entered by hand or
imported from a brokerage or file.
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CHAPTER

FIVE

WATCHLISTS - MONITORING THE MARKETS

Use Watchlists to help keep your eye on the market.

StockMarketEye allows you to quickly and efficiently monitor securities from most major world stock exchanges.

In this section, you’ll learn how you can use the powerful stock tracking capabilities of StockMarketEye’s watchlists
to monitor the markets and start positioning yourself to make better investing decisions.

5.1 Creating and Deleting a Watchlist

Adding your own Watchlists can help you to more effectively track the stocks you are interested in. Create watchlists
for a sector or market cap size. Have watchlists for over/under weighted stocks. StockMarketEye does not limit you
on how many watchlists you can have, nor how many stocks you can have in a watchlist.

5.1.1 Create a Watchlist

In StockMarketEye’s main menu, select File -> New Watchlist.... This will open the “Watchlist Settings” window as
shown below:
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Type a name for your new Watchlist in the field labeled Name. The name you use can be anything you want, but every
Watchlist must be named differently. You may also add a description of your Watchlist in the Description field, but
this is optional.

Click “OK” to save your new Watchlist. Your StockMarketEye window will now look similar to the following:
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You can modify the name of a Watchlist by double-clicking on its name in the list on the left. This will display the
“Watchlist Settings” window where you can change the Name and Description of your Watchlist.

5.1.2 Delete a Watchlist

To delete a watchlist, select the watchlist in the folders area. Then use the main menu, Watchlist -> Delete Watchlist....

When a watchlist is deleted, all of the stocks in that watchlist are also deleted. Deleting can not be un-done, so you
need to confirm that you want to delete the watchlist before StockMarketEye will actually delete it.
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5.2 Getting Current Quotes for your Watchlists

StockMarketEye retrieves current quotes for the symbols in your Watchlists from free servers on the Internet. You can
decide, for each Watchlist, how often you would like to refresh the quotes. There are 2 possibilities:

1. “Streaming” Quotes - Update the current market price for the stocks in your Watchlist automatically at regular
intervals. This is the default setting.

2. On-Demand - Update the current market price for the stocks in your Watchlist when you choose. You can
update the prices simply by clicking on the “Get Quotes” button in the Watchlist toolbar.

5.2.1 Changing the Live Quote Properties

By default, every Watchlist is initially set to use “Streaming” Quotes. You can switch your Watchlist to use On-
Demand quotes or modify the “Streaming” Quote setting in the “Watchlist Properties” window.

To modify your Live Quote properties, in the main menu, select Watchlist -> Properties... The “Watchlist Properties”
window will appear. Then click on “Live Quotes”.
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Under “Live Quotes”, select either the Streaming quote data option or the On-Demand quote data option.

• On-Demand quote data

Retrieves live quote data only when you click on the “Get Quotes” button in the toolbar or in the menu Watchlist
-> Get Quotes.

• Streaming quote data

Retrieves the live quotes automatically on the selected schedule. You can modify the “Update every” settings
to change the frequency at which the quotes will automatically be updated. A schedule anywhere between 15
seconds and 1440 minutes (i.e. 24 hours) is possible.

You can also tell StockMarketEye to reset the previous close values before the start of trade.

• Enable automatic reset of the previous close values before the start of trade

This option is enabled by default and typically it should be left enabled for normal watchlists.

The data providers do not reset a security’s previous close value to the closing price from the previous day until
the first quote of the current trading day is received. This means columns such as the “Day %” will have the
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previous day’s values until the current trading day starts.

For normal stocks and ETFs, this can cause a slight confusion around the start of the trading day. However for
mutual funds, it can be quite confusing as the previous day’s gain/loss will be shown throughout the current
trading day.

With this option enabled, StockMarketEye will reset the previous close value to the closing price from the
previous day at 8am on the next weekday.

However, this option may not be ideal for some, especially if you have European mutual funds or other securities
that are quoted by the data providers 24 hours later. You can see when the last quote was received by adding the
“Last DateTime” column. If you see that the securities you follow have a last quote date over 24 hours in the
past, you may want to consider disabling this option (uncheck it) so that StockMarketEye will not perform the
reset of the previous close values.

Click on the “OK” button to save and activate the property settings.

5.3 Adding and Removing Ticker Symbols

You can quickly and easily add, remove or modify items in your watchlist.

Don’t forget those investing ideas you read about. Add them to a watchlist!

5.3.1 Adding To Your Watchlist

There are several ways to add an item to a Watchlist.

• “Symbol Search” In the upper right corner of the StockMarketEye window you will see the “Symbol Search”
field. Click in the field and type the name of a company, product or symbol. The search results area will appear.

You can add one of the search results to your Watchlist by double clicking it. Alternatively, you can drag-and-
drop it onto one of the Watchlist names in the Folders area on the left side of the StockMarketEye window. You
can read more about searching for ticker symbols here.
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• You can also click on the “Add” button in the Watchlist toolbar to open the “Watchlist Symbol Details” window.

This window allows you to specify the details of the symbol you are adding to your Watchlist, including its
watch price and date.

In the Symbol field, type the stock symbol (or stock ticker) that you are interested in. The defaults for the other
fields are usually fine, but you may wish to add a comment about this stock in the Comments field. When you
have finished, click the “OK” button and your stock will be added to the Watchlist.
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After you have added your stock symbol, your window will look similar to this.
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Note: If you received the message “Sorry. We were not able to find any information about the symbol, ‘XYZ”’, it may
be an indication that need to set your proxy server. See the Setting A Proxy Server section for details.

5.3.2 Modifying A Watchlist Entry

You can modify an item in your watchlist in several ways.

• Double-click - Double click on the item in your watchlist to open its details window.

• Toolbar Details Button - Select the item in you watchlist and click on the “Details” button in the toolbar.

5.3. Adding and Removing Ticker Symbols 195

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

• Direct Edit - Select the item in your watchlist and then click in the cell you would like to change. Not all cells
are editable, but important ones such as “Last” and “Watch Start” are.

An asterisk in the corner of the cell means that the value in that cell has been manually set and is not updated by
StockMarketEye.

5.3.3 Deleting A Watchlist Entry

You can remove an item in your watchlist by selecting the item, then using the main menu, Watchlist -> Remove
Symbol.
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You will have to confirm that you want to delete the item by clicking OK in the confirmation box.

5.4 Bulk Add Symbols To A Watchlist

With the bulk add symbols feature, you can quickly add multiple symbols to a watchlist. All you need to have are the
symbols you want to add. No other information is needed. Just enter the symbols into the bulk add window, separated
by a comma or white space, and click ok.

5.4.1 HowTo Add Multiple Symbols

1. Open the “Bulk Add” window from the menu: Watchlist -> Bulk add symbols...
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2. Enter the symbols you want to add into the field. Be sure to separate the symbols with a comma (,) or white
space.
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3. Checking the option, “Do not add a symbol if it already exists in this Watchlist.”, will ensure that no duplicate
symbols are added to this watchlist.

4. Click “OK” to add the symbols to the watchlist. After the symbols have been added, StockMarketEye will
automatically download the historical quotes for the new symbols.

5.5 Resetting Watchlist Values

Items in a watchlist, in addition to the ticker symbol, have a date and starting “watch” price associated with them.

Typically the date is the date you added the item to the Watchlist, but it can also be any arbitrary date that you choose.
This can be useful, for example, for tracking performance of the items in the Watchlist since a specific date in the past.

The starting “watch” price is, by default, the current price of the symbol when you add the item to the watchlist.
However, you can set the “watch” price to whatever value you want. This can be useful, for example, for tracking the
price changes in the ticker symbol since the price you sold it or the price it was on some date in the past.

You can edit these values individually by selecting the item, then clicking on the “Details” button in the toolbar.

5.5.1 Resetting the Values for All Items in the Watchlist

StockMarketEye lets you update the date and “watch” price for all items, or even for a sub-selection of the items, in
the list at once.
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1. If you want to update just some of the items in the list, select them. If you want to update all of the items in the
list, remove any current selection.

2. Then open the “Reset Watchlist values” window from the menu: Watchlist -> Reset Watchlist values...

3. In the new window, choose the option for how you want to reset the values of the items in the Watchlist.

The available options are the following:

(a) Reset both the “Date Added” and “Watch Start” columns to historical values from a specific day in the
past. StockMarketEye will find the historical value for each item in the watchlist on the selected day. It
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will then set the “Date Added” column for that item to the selected day and will set the “Watch Start” value
for that item to the selected historical value from that day.

(b) Reset both the “Date Added” and “Watch Start” columns to the current date and most recent Last price.
StockMarketEye will set the “Date Added” column for each item in the Watchlist to the current date and
will set the “Watch Start” value for each item to the current Last column value.

(c) Reset just the “Watch Start” columns to the most recent Last price.

(d) Reset just the “Date Added” columns to today’s date.

4. Click “OK” to reset and save the values.

5.6 Importing A Watchlist

You can import ticker symbols into your StockMarketEye Watchlists via Comma-separated values (CSV) files. You
can create CSV files via most spreadsheet applications such as Microsoft Excel or OpenOffice.org Calc.

5.6.1 CSV Import Format

StockMarketEye reads your stock symbols from the CSV file, one symbol per line. Optionally, you may include
additional columns in each line in order to specify additional information for the symbol. The table below lists the
columns accepted by StockMarketEye.

NOTE: The order of the columns in the CSV file must be the same as that specified in the table below.

NOTE: You may include a “header” line, but it is not required. If the “header” line is included, the first cell must
contain the word “symbol” or “ticker”.

Accepted CSV columns for Watchlists

Bold column names are mandatory. Others are optional.

Ticker Symbol Watch Start Price Watch Date Comment Name

You can download an example CSV watchlist file here.

In your spreadsheet application, the file to import will look something like this:
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5.6.2 Column Descriptions

The following table describes the columns of the CSV file in greater detail.

Column Us-
age

Description

Ticker
Symbol

Manda-
tory

The ticker symbol to add to the Watchlist. You can find valid ticker symbols using
StockMarketEye’s built-in ticker symbol lookup. import will not warn about symbols for
which it can not retrieve quotes or historical data. This column is mandatory and must
always contain a value.

Watch
Start
Price

Op-
tional

The starting watch price. If not specified, the current last-trade price will be used.

Watch
Date

Op-
tional

The date on which you started watching this stock. Typically this corresponds to the date on
which the stock traded at the Watch Start Price. If not specified, the current date will be used.

Com-
ment

Op-
tional

Any comments you want to remember about this particular security. This column is optional
and can be left blank.

Name Op-
tional

The name of the company or fund represented by the ticker symbol. This column is optional
and can be left blank.

5.6.3 Importing a CSV Watchlist File

Once you have created a CSV file containing your ticker symbols, you can import it into StockMarketEye with the
following steps.

1. Open StockMarketEye and click on the menu: File -> Import Watchlist from CSV...
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2. Select the CSV file containing the watchlist symbols that you want to import into StockMarketEye. This data
will be imported into a new or existing StockMarketEye watchlist that you select in Step #3. Once you have
entered an existing CSV Watchlist symbols file, click on the “Next” button to move to the next step.
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3. Finish the import of the Watchlist symbols by selecting a Watchlist into which the symbols will be added. You
can either select an existing Watchlist, or create a new one. Click on the “Finish” button to complete the import.
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4. The symbols have now been imported into the selected Watchlist.
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CHAPTER

SIX

STOCK ALERTS

Don’t miss out on important activity. Use Stock Alerts to stay informed.

StockMarketEye provides a built-in alert system that notifies you of important activity in your Watchlists and Portfo-
lios. In this section, you’ll learn how to setup Growl for visualizing the alerts on your desktop.

6.1 Stock Alert Management

StockMarketEye allows you to set alerts on ticker symbols. Currently you can set alerts on 8 different values of a
ticker symbol such as Last Price, % Change or even P/E.

Alerts are created for a ticker symbol. If you have the ticker symbol in more than one location (such as in 2 portfolios
or in 1 portfolio and a watchlist), the alert applies to the ticker symbol in every location. This helps you stay notified
of what’s happening even if you are not focused on one location.

You can create any number of alerts for a ticker symbol. For example, you can create one alert for when the price goes
above a certain value and another for when the price goes below a different value.

6.1.1 Create A Stock Alert

To create an alert, first select the ticker symbol for which you want to set the alert, then click on the “Alerts” button in
the toolbar.

You’ll now see the “Alert Management” window. If you do not yet have any alerts set for this symbol, you will get an
empty window as seen below.

Click on the green plus symbol to create a new alert.
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In the new “Configure Alert” window, you specify the various settings for the alert.

• The “Symbol” is the ticker symbol you selected. The alert will be set on this ticker symbol globally (i.e. in all
portfolios and watchlists) in StockMarketEye.

• In the “Column” dropdown you choose the column on which want to set an alert.

• In the “Comparison” dropdown you choose how you want to compare the current value from the selected
“Column”.

• In the “Value” dropdown you choose the value at which the alert should be triggered.

When you are done setting the values of the alert, click on the “OK” button to add the alert to the “Alert Management”
window.
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Then click on the “OK” button in the “Alert Management” window to activate the alerts for this ticker symbol.

When there is an alert set for a ticker symbol, a blue bell will be shown in the left-most column.

When the alert has triggered, an orange bell will be shown in the left-most column and the line will have an orange
background.
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6.1.2 Examples of Alerts

Alert when the current price goes above 95

1. Column: Last Price

2. Comparison: Greater Than

3. Value: 95

Alert when the current price goes below 95

1. Column: Last Price

2. Comparison: Less Than

3. Value: 95

Alert when the holding has gained more than 5%

1. Column: Position % Gain/Loss (Portfolio only)

2. Comparison: Greater Than

3. Value: 5

Alert when the holding has lost more than 5%

1. Column: Position % Gain/Loss (Portfolio only)

2. Comparison: Less than

3. Value: -5

6.1.3 Modify A Stock Alert

To modify an alert, first select the ticker symbol with the alert you want to modify, then click on the “Alerts” button in
the toolbar.

You’ll now see the “Alerts Management” window with the currently set alerts for this symbol.

Select the alert you want to modify and then click on the pencil button, or double-click on the alert you want to modify.
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Now in the “Configure Alert” window, you can change the values as desired. When you are done, click on the “OK”
button to close the “Configure Alert” window and then click on the “OK” button in the “Alerts Management” window
to active the alerts for this ticker symbol.

6.1.4 Delete A Stock Alert

To delete an alert, first select the ticker symbol with the alert you want to delete, then click on the “Alerts” button in
the toolbar.

You’ll now see the “Alerts Management” window with the currently set alerts for this symbol.

Select the alert you want to delete and then click on the X button.
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Finally, click on the “OK” button in the “Alerts Management” window to activate the change.

6.2 Installing Growl

Growl is a notification system for Mac OS X and Windows that allows applications that support Growl to send you
notifications, typically on your desktop.

• Installing Growl for Mac OS X
• Installing Growl for Windows

The following is an example of a growl notification on Mac OS X:

6.2.1 Installing Growl for Mac OS X

On Mac OS X, you can install Growl from the Mac App Store.
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Once installed, open the Growl Settings window by double clicking on the “Growl” Application. Then in the “General”
tab of the Settings window, make sure that Growl is started at login.

Finally, you should restart StockMarketEye if it is already running so that it can register to send alert notifications
through Growl.

You can find more information on Growl for Mac at the official Growl for Mac website.

6.2.2 Installing Growl for Windows

On Windows, you can download Growl directly from the Growl for Windows website.
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When starting the download, click the “Run” button to automatically start the installer.

Follow the steps outlined in the installer to finish the installation.

Start Growl from the Windows Start menu.
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Open the Growl Settings window by clicking on the additional System Tray icons triangle, then right click on the
Growl paw icon, then click on the “Open Growl” menu.

Make sure that Growl is set to start automatically at startup.
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Finally, you should restart StockMarketEye if it is already running so that it can register to send alert notifications
through Growl.

6.3 Send an Email for each Stock Alert

You can use existing plugins to Growl to send an email each time StockMarketEye notifies of a Stock Alert.

If you have not already done so, you’ll first need to install Growl.

NOTE: StockMarketEye needs to be running in order for alerts to be forwarded.

• Mac OS X - Email Alerts Configuration
• Windows - Email Alerts Configuration

6.3.1 Mac OS X - Email Alerts Configuration

Open the Growl Preferences window by double clicking on the “Growl” Application. Then cick on the “Displays” tab
and click on the “MailMe” Action.

Enter the email address to which you would like to forward the notifications in the “To” field. Fill in the other fields
as necessary. For the “SMTP Server” settings, you should use the settings provided by your email provider.
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Configure StockMarketEye in Growl to use the mail forwarding

Now click on the “Applications” tab and scroll the list of applications to find StockMarketEye and click on it.

In the Application Settings tab, under the “Application’s Display Style” section, in the “Actions” dropdown, check the
MailMe action.
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In the “Notifications” tab, under the “Actions” section, check the MailMe action.

Now, every time that StockMarketEye sends a stock alert, it will be forwarded to your email account. If you are not
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receiving the email messages, first check that the settings of the growl MailMe or MailMeToo plugin are correct. You
may also want to check your spam folder in case your spam filter is overzealous.

6.3.2 Windows - Email Alerts Configuration

Open the Growl Settings window by clicking on the additional System Tray icons triangle, then right click on the
Growl paw icon, then click on the “Open Growl” menu.

Go to the “Network” tab and check the option, “Forward notifications to other computers”. Then click on the green,
plus icon at the bottom.
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In the “Forward Notifications” window, click on the “Click here to forward notifications to an email account”.

Then enter a Description and Email Address to which the notifications will be forwarded. Then click on the “edit”
link to enter the information about your email settings (aka. SMTP Settings).
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Next, enter your email account settings, including the email server you use to send messages through. You can get this
information from your email provider. If you are using GMail, you can use the settings as shown in the image below.
Be sure to enter your Username and Password. When you have entered all of the information, click on the “done” link.

Finally, click on the “Save” button to enable the forwarding to email.
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Now, every time that StockMarketEye sends a stock alert, it will be forwarded to your email account. If you are not
receiving the email messages, first check that the settings of the email forwarding, especially the “SMTP Settings”,
are correct. You may also want to check your spam folder in case your spam filter is overzealous.
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CHAPTER

SEVEN

STOCK CHARTS

Stock charts help you get perspective on market movement.

In StockMarketEye, any time you select an item in a watchlist or portfolio, that item’s chart will be displayed in the
chart area.

You can control the various settings and options of the chart via the “Chart Options” menu in the upper-right corner of
the chart area.

You can add technical indicators from the “Technical Indicators” menu just to the left of the “Chart Options” menu.

7.1 Comparison Charting

You can compare the chart of one stock against another. In StockMarketEye, this is called comparison charting.

Comparison charting in StockMarketEye consists of adding a “comparison” symbol to the chart. This comparison
symbol stays in the chart, just like a technical indicator, even when you switch the main chart symbol.

7.1.1 Adding A Comparison Symbol To The Chart

You can add a comparison symbol to the chart with these steps:

1. Click on the chart menu: Compare to
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2. Enter a custom comparison symbol in the “Comparison Symbol” field. You can compare against any symbol,
be it a stock, ETF or fund. For example the “SPY” ETF.

Or choose from one of the indexes listed in the “Comparison Index” dropdown (click on the down arrow to view
the list of indexes).

For example, if you wanted to compare against the S&P 500 Index, you would choose the “^GSPC” symbol
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from the dropdown list.

3. The comparison symbol’s chart will be added. The comparison symbol itself is shown in the upper-left side of
the chart.
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7.1.2 Removing A Comparison Symbol From The Chart

You can remove the comparison symbol from the chart by clicking on the small, red “X” that is just to the left of the
comparison symbol in the upper-left portion of the chart.

7.2 Importing Historical Quotes

StockMarketEye portfolios can include holdings for which quotes are not available. These type of holdings are referred
to as non-quoted items and do not have live quotes or historical quotes available for automatic download from any of
the data providers supported by StockMarketEye.

StockMarketEye provides for manually importing historical prices from a CSV file for any symbol. This feature is
typically used to support non-quoted items. However it can also be used to replace automatically downloaded historical
quotes when those quotes are known to be faulty.

7.2.1 Manual Import

1. Open the “Chart Options” menu, then click on Advanced -> Import Historical Quotes. This will open the
“Import Historical Quote Data” window.
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2. Click on the “Browse” button and select the CSV file containing the historical quotes to import.
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The import CSV file can be in one of 2 formats:

• 7-Column format (OHLC data)

The 7 columns of the CSV file must be as follows:

Ticker Symbol Date Open High Low Close Volume

– Ticker Symbol - The symbol of the security to which the quote data belongs.

– Date - The date of the historical quote.

– Open - The opening price on the date.

– High - The high price on the date.

– Low - The low price on the date.

– Close - The closing price on the date.

– Volume - The trading volume on the date.

• 3-Column format (Close only)

The 3 columns of the CSV file must be as follows:

Ticker Symbol Date Close Volume (optional)
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– Ticker Symbol - The ticker symbol of the security to which the quote data belongs.

– Date - The date of the historical quote.

– Close - The closing price on the date.

– Volume (optional) - The trading volume on the date.

The open, high and low values for the date will be set to the same value as the open value.

3. There are 2 types of import modes:

• Replace the historical quotes with the quotes from the file.

In this mode, the current historical data in StockMarketEye, for any symbol found in the imported CSV
file, will be deleted before the import starts. The historical data from the import file will then be imported
to replace the data that was just deleted.

• Add the historical quotes from the import file.

In this mode, historical quotes from the imported CSV file are only imported into StockMarketEye if they
do not already exist in StockMarketEye’s historical data. Existing historical quotes are not overwritten and
duplicate quotes for a date will not be saved. More precisely, if the imported symbol and date match an
existing symbol and date in StockMarketEye’s historical quote data, the imported data for that date will be
discarded and not used.

4. Once you have chosen the CSV file and the import mode, click on the OK button to start the import.

5. When the import is finished, StockMarketEye will display an informational window with details about what was
imported and the chart will be reloaded.

If the symbol, for which you imported the historical quotes, is not currently shown in the chart, click on it now
to see its chart.

Note: Manually imported historical data is saved in the StockMarketEye backup files.

Note: Manually imported historical data is currently not synchronized across devices with our on-line synchronization
service. We may offer this feature in the future, however. If you are interested in this feature, please let our support
team know.
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7.3 Reload Chart Data

StockMarketEye automatically downloads the data necessary to display a stock’s chart.

However, in certain cases, the automatic download may not work properly and you may see a chart that is not up-to-
date or not shown at all.

7.3.1 Force Reload

You can force StockMarketEye to reload the data for a chart by using the chart menu: Gear -> Reload Chart Data.

This will remove any existing data for the currently selected ticker symbol, then download it again from the data
provider.
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CHAPTER

EIGHT

GENERAL FEATURES AND DOCUMENTATION

8.1 Backup / Restore / On-Line Sync

8.1.1 Backing Up and Restoring Your Data

We recommend that you backup your StockMarketEye data on a regular basis. There are 2 ways of backing up your
data in StockMarketEye:

1. Creating a backup file on your computer as explained below.

2. Using our free, on-line synchronization service.

Note: The Backup/Restore and On-line Synchronization features of StockMarketEye are not activated in the trial
version.

Note: Licensed versions of StockMarketEye also create automatic backups each time you quit StockMarketEye.

Back Up Your Data

1. Use the menu: File -> Back Up... to start the backup process.
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2. Select the location and name of the backup file to write. StockMarketEye will create a ZIP file that contains the
backed up data. You should never need to open or unzip this file yourself. You can also choose to encrypt the
data in the ZIP file for extra security. An encrypted backup file can only be restored by StockMarketEye on your
computer.

3. Click OK and the backup process will run. This may take several minutes depending on how much data you
have in StockMarketEye and how fast your computer is.
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4. StockMarketEye will let you know when the backup process is finished.

Restore Your Data From Backup

1. Use the menu: File -> Restore Backup... to start the restoration process.
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2. Select the backup file with which you want to restore. This must be a file that you created with StockMarketEye.
Typically you’ll want to use the most recent backup file that you created.

3. Click Open to start the recover process.

4. Before the recover process begins, you must confirm that you want to run the recover process. During the
recover process, all of the current data in StockMarketEye will be deleted and then the data from the backup file
restored. The current data that StockMarketEye deletes during the restore process is not recoverable.
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5. Click OK to confirm and the restore process will run. The restore process will take a few seconds to complete.

6. After the restore is finished, you must restart StockMarketEye. Click Restart.

7. After the restart, StockMarketEye is ready to use.

8.1.2 Automatic Backup

We recommend making regular backups of your StockMarketEye data and storing those backup files in a secure
location.

StockMarketEye can also make automatic backups of your data. (Note that the automatic backup feature is not
activated in the trial version.)

You can turn this feature on or off in the Preferences window, under the “Advanced” tab.
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The automatic backup files are created just before StockMarketEye shuts down.

The backup files are encrypted and can only be used in StockMarketEye installations that use the same license key.

Where are the Automatic Backup Files Saved?

You’ll find the automatic backup files on your computer in this folder:
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Mac OS X: /Users/<your user>/Library/Application Support/StockMarketEye40/autobkup
Windows 8/7/Vista C:\Users\<your user>\AppData\Roaming\StockMarketEye40\autobkup
Windows XP C:\Documents and Settings\<your user>\Application Data\StockMarketEye40\autobkup
Linux /home/<your user>/.StockMarketEye40/autobkup

8.1.3 On-line Synchronization

StockMarketEye’s on-line synchronization feature allows you to easily share your data between computers and iOS
devices.

When you want to use or update your data on another computer or iOS device, you synchronize, downloading more
recent data from the service and uploading your changes to the service. The synchronization service merges the data
you send to it with what you have previously sent it and returns the most recent version of the data.

Note: The On-line Synchronization feature of StockMarketEye is not activated in the trial version.

• Creating An Account
• Login to an existing account
• Synchronize Your Data
• Other Synchronization Actions
• What Data Is Synced?
• What Data Is Not Synced?
• Is It Secure?

Creating An Account

The synchronization service works with an account, which you can create from within the desktop version or the iOS
version. You can create this account using any email address that you own.

The email address is used to link you to the data you store in the synchronization service. You should use the same
email address in any desktop or iOS version of StockMarketEye with which you want to synchronize your data.

To create an account, open the menu File -> On-line Synchronization.
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Then click the “Create a free account>>” link.

Enter your email address and choose a password. Then click “Register”.
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When the account is created, you will be automatically logged in and can start the synchronization process. More
details on the synchronization process can be found below.

Login to an existing account

If you already have created an account on another computer or device, you can login with that same account on your
current computer in order to synchronize your data.

To login with an existing account, open the menu File -> On-line Synchronization.
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Enter the email address and password you used when you created the account. Then click “Login”.

Once you are logged in, you can start the synchronization process. See the next section for more details on the
synchronization process.
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Synchronize Your Data

The standard StockMarketEye synchronization is called the “merge” synchronization.

When you synchronize (i.e. click the “Start synchronize now” button), StockMarketEye uploads your data to our
synchronization service. The synchronization service compares the data it receives to any data you have already sent,
saving the most recent version of your data (either from the data you just sent or from the previously saved data). It
then sends back the merged (i.e. most recent) version of that data, replacing the data you have in StockMarketEye so
you work with the most recent version available.
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When the synchronization is complete, StockMarketEye will be working with the most recent data available.

Other Synchronization Actions

StockMarketEye also offers other synchronization actions. These actions can be accessed from the “Other Synchro-
nization Actions>>” link.
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Besides the standard “merge” synchronization described above, StockMarketEye also offers “download” and “upload”
actions.
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Download From Account

This action downloads all of the data from your on-line sync account, using that data to completely replace the data
in StockMarketEye on your computer. This can be useful if you have already used the on-line synchronization service
and are now loading your data on a new computer.

Upload To Account

This action uploads all of your data in StockMarketEye to your account in the on-line synchronization service. All of
the old data in your account is replaced with the newly uploaded data. This can be useful if you synced incorrect data
from another device or computer and want to replace that data with the correct version from your current computer.

Logout

You can logout of the StockMarketEye synchronization service using the “Logout” button. If you want to use the
synchronization service on this computer again, you will have to re-login.

What Data Is Synced?

StockMarketEye syncs the following data:

• Watchlists and their contents

• Portfolios, their holdings and transactions

• Alerts

• Any custom names, sectors, industries that you have set for a ticker symbol.

244 Chapter 8. General Features and Documentation

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


www.stockmarketeye.com StockMarketEye User’s Guide, Release 4.2

What Data Is Not Synced?

StockMarketEye does not sync the following data:

• General preferences

• Column configurations

• Brokerage information (username, password, account number, etc)

Is It Secure?

The StockMarketEye on-line synchronization service secures your data by encrypting it when sent over the internet,
storing it in an encrypted format, and using secure tokens for authentication.

• Your data is encrypted using the industry standard SSL (Secure Sockets Layer) when sent over the internet to
and from the StockMarketEye synchronization service.

• The synchronization service encrypts your data using the industry standard Advanced Encryption Standard
(AES, 256-bit).

• Authentication with the synchronization service is done using a secure token, eliminating the need to store your
password on your computer or iOS device.

8.1.4 Synchronizing Data in the Desktop Version with the iOS Version

Follow the steps below to synchronize your investment data between the StockMarketEye desktop software and the
iOS (iPhone/iPad) version.

Note: The On-Line Synchronization feature is not available in the trial version of the StockMarketEye desktop
software.

Note: You can purchase the iOS version of StockMarketEye on your iOS device (iPhone/iPad) from Apple’s App
Store. In the App Store, search for “stockmarketeye” to find the app.

The following steps assume that you have your data already entered into the desktop version of StockMarketEye and
would like to synchronize it to the iOS device.

1. On your desktop computer, create an account in StockMarketEye’s on-line synchronization service as described
in the “Creating An Account” section of the On-Line Synchronization guide. The email/password that you
choose for this account will be used in both the desktop and iOS versions.

2. Go to the Other Synchronization Actions and use the “Push to Account” action. Wait till the push synchroniza-
tion is finished.

3. Now on your iOS device, open the StockMarketEye app, and go to the “Synchronization” tab.

4. Tap the “I already have an account” button and login with the same email and password that you created and
used in the desktop version.

5. On the main “Synchronize” screen, tap the “Other Synchronization Actions” button at the bottom of the screen.

6. Now on the “Other Sync Options” screen, tap the “Pull From Account” button.

7. When the pull synchronization is finished, your investment data will be on both the desktop and iOS versions of
StockMarketEye.
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When you need to synchronize in the future, you can use the standard “Start synchronize now” button on the desktop
and the “Synchronize now” button in iOS.

8.1.5 Synchronizing Data in the Desktop Version with the Android Version

Follow the steps below to synchronize your investment data between the StockMarketEye desktop software and the
Android version.

Note: The On-Line Synchronization feature is not available in the trial version of the StockMarketEye desktop
software.

Note: You can purchase the Android version of StockMarketEye on your Android device on Google Play. You can
get the direct link to the StockMarketEye for Android app in the Google Play store on our dedicated Android version
page.

The following steps assume that you have your data already entered into the desktop version of StockMarketEye
and would like to synchronize it to the Android device.

1. On your desktop computer, create an account in StockMarketEye’s on-line synchronization service as described
in the “Creating An Account” section of the On-Line Synchronization guide.
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Remember the email/password that you choose for this account as you will use them in both the desktop
and Android versions.

2. Once the account has been created, go to the Other Synchronization Actions and use the “Push to Account”
action. Wait till the push synchronization is finished.
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3. Now on your Android device, open the StockMarketEye app, and go to the “Synchronization” screen.
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4. Tap the “I already have an account” button and login with the same email and password that you created and
used in the desktop version.
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5. Once you are logged in, on the main “Synchronize” screen, tap the “Advanced options” button at the bottom of
the screen.
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6. Now on the advanced options screen, tap the “Pull From Account” button.
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7. When the pull synchronization is finished, your investment data will be on both the desktop and Android versions
of StockMarketEye.

When you need to synchronize in the future, you can use the standard “Start synchronize now” button on the desktop
and the “Synchronize now” button in Android.
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8.1.6 Synchronizing Data Between Two Desktop Versions

Follow the steps below to synchronize your investment data between StockMarketEye running on one computer and
StockMarketEye running on another computer.

Note: The On-Line Synchronization feature is not available in the trial version of the StockMarketEye desktop
software.

The following steps assume that you have your data already entered into StockMarketEye on one of the computers and
would now like to synchronize it to the other computer.

1. On your first computer where you have already entered your investments into StockMarketEye, create an account
in StockMarketEye’s on-line synchronization service as described in the “Creating An Account” section of the
On-Line Synchronization guide. The email/password that you choose for this account will be used in both
computers.

2. Go to the Other Synchronization Actions and use the “Push to Account” action. Wait till the push synchroniza-
tion is finished.

3. Now run StockMarketEye on your other computer. Note you will need to have your license key installed in
StockMarketEye on this computer in order to use the on-line synchronization service.

4. Use the menu File -> On-Line Synchronization to open the synchronization window.

5. Enter the email address and password you used on the first computer and click “Login”.

6. Go to the Other Synchronization Actions and use the “Pull from Account” action. Wait till the pull synchroniza-
tion is finished.

7. When the pull synchronization is finished, your investment data will be on both the computers.

When you need to synchronize in the future, you can use the standard “Start synchronization now” button on either
computer.

8.1.7 Synchronizing Data from one iOS Device to Another

Follow the steps below to synchronize your investment data between the StockMarketEye app on one iOS
(iPhone/iPad) device to StockMarketEye on another iOS (iPhone/iPad) device.

Note: You can purchase the iOS version of StockMarketEye on your iOS device (iPhone/iPad) from Apple’s App
Store. In the App Store, search for “stockmarketeye” to find the app.

The following steps assume that you have your data already entered into StockMarketEye on one of the iOS devices
and would like to synchronize it to the other iOS device.

1. In StockMarketEye on the iOS device with your data already entered, create an account in the on-line synchro-
nization service. You can do this in the “Synchronization” tab. Note that the email/password that you choose
for this account will be used in both iOS devices. If you already have an account, go to the “Synchronization”
tab and tap the “I already have an account” to login.

2. Once the account is created and you are logged in, tap the “Other Synchronization Actions”.

3. On the “Other Sync Options” screen, tap the “Push to Account” action. Wait till the push synchronization is
finished.

4. Now on your other iOS device, open the StockMarketEye app, and go to the “Synchronization” tab.
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5. Tap the “I already have an account” button and login with the same email and password that you created and
used on the other iOS device.

6. On the main “Synchronize” screen, tap the “Other Synchronization Actions” button at the bottom of the screen.

7. Now on the “Other Sync Options” screen, tap the “Pull From Account” button.

8. When the pull synchronization is finished, your investment data will be in StockMarketEye on both iOS devices.

When you need to synchronize in the future, you can use the standard “Start synchronize now” button in StockMar-
ketEye in either of the iOS devices.

8.2 Editing Data

8.2.1 Editing Values In-Line

Some values in StockMarketEye can be edited via the “Details” window. Others may be edited in-line (i.e. directly in
the table), while some can be edited in both places.

The following sections describe the various types of in-line editing.

Numerical Value Editing

To edit a numerical value in-line, first select the line to edit, then click in the cell of that line that you want to change.
Enter the new number and press return.

If there was a value for this column that was downloaded (such as for the “Last” or “Dividend” column) you can go
back to the original, un-edited number. To do this, edit the value again, deleting the current value so that field is empty.
Then press return.

See the on-line User’s Guide for an animated example.

Predefined Value Editing

To edit a cell with predefined values, first select the line to edit. Then click in the cell of that line. A dropdown field
will then be shown. Click on the arrow on the right side of the field to open the dropdown and view the options. Select
a new option from the list and press return.

To go back to the original, un-edited value, open the dropdown again. Then select the “<default>” option from the
bottom of the list and press return.

See the on-line User’s Guide for an animated example.

Some columns that have predefined values can additionally have custom values. To edit these, first select the line to
edit, then click in the cell of that line. A dropdown field will be shown. Click on the arrow on the right side of the
field to open the dropdown and view the options. Delete the text in the field and enter your custom value. Then press
return.

To go back to the original, non-custom value, edit the value again, selecting the “<default>” option from the bottom
of the dropdown list. Then press return.

See the on-line User’s Guide for an animated example.
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8.2.2 Overiding The Last Price

If you have followed the guide for Tracking Bonds and Other Non-Quoted Securities, or if you simply want to experi-
ment with different prices for a stock, you can change the value in the “Last” column.

When you have changed the “Last” value, a small asterisk will appear in the cell denoting that the value has been
edited manually. The other values in that line that are calculated from the “Last” price will also update.

To edit the “Last” price, first select the line to edit, then click in the cell of that line. Enter the new Last price and press
return.

If you no longer want the manually entered value, but would like to return to the current price for this stock, edit the
value again, deleting the manually entered value so that the field is empty. Then press return.

See the on-line User’s Guide for an animated example.

8.2.3 Changing The Name Of A Security

If you have followed the guid for Tracking Bonds and Other Non-Quoted Securities, or if you simply want to specify
a name for a security that is different from the default, you can edit the value of the “Name” column.

To edit the “Name” column, first select the line to edit, then click in the cell of that line. Enter the new name and press
return.

If you want to go back to the default name, edit the value again, deleting the manually entered name so that the field is
empty. Then press return.

See the on-line User’s Guide for an animated example.

8.3 Configuring Columns

8.3.1 Configuring Columns

The columns of the watchlist and portfolio tables can be changed to show you more and/or different data. You can
add/remove columns as well as change the column’s order.

To change the columns of a table, right-click (ctrl-click for Mac users) on the header of any column in the table and
select Configure Columns....
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The “Configure Columns” window will open. This is where you decide which columns should be visible and in what
order they should be displayed.
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The list on the left-hand side of the window, titled “Available Columns”, contains the columns that are available to be
added to the table. At the bottom of this list you’ll find the description of the column that is selected in the list above.

The list on the right-hand side of the window, titled “Visible Columns”, contains the columns that will be visible in
the table. The order of the columns in this list will be the order in which they will be displayed in the table.

When you have finished with your changes, click the “OK” button to enable the changes. Click on “Cancel” to keep
the current settings.
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Add a Column

To add a column, select it in the “Available Columns” list and click the right-pointing arrow to move it to the “Visible
Columns” list.

Re-order the Columns

Once in the “Visible Columns” list, you can change where the column will appear in the list by using the up/down
arrows to move the selected column to the desired location.

Remove a Column

To remove a column from the “Visible Columns” list, select it and click on the left-pointing arrow to move it back to
the “Available Columns” list.
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Restore Default Columns

You can restore the columns to the default StockMarketEye columns by clicking on the “Restore Defaults” button.

Notes on Column Configuration

• Each type of view has its own set of “Available Columns”. Many columns can be used in both Watchlists and
Portfolios. But portfolios, for example, will have additional columns for information such as purchase price and
cost basis, while watchlists will have columns for watch start and watch %.
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• The visible columns can be the same for every table of the same type or different for individual tables. When the
“Apply these column settings to all ...” option is checked, the column settings will be applied to every table of
the same type. For example, when you change the watchlist’s “Prices” view columns and this option is checked,
you change the columns of every Watchlist’s “Prices” view. When this option is not checked, only the current
table will be affected.

• The order and size of the columns can be different for every table.

• You can resize a column by dragging the column separator to the left or right.

• You can re-order columns in an individual watchlist by dragging the column header and dropping it in the desired
location.

• You can sort on any column by clicking on the header of the column you wish to sort by. Click a 2nd time to
sort in the opposite direction. Click a 3rd time to leave unsorted.
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8.3.2 Watchlist Columns

You can setup the columns in the Watchlist’s “Prices” and “Fundamentals” views to show the data that is useful for
your investment analysis.

Right-click (ctrl-click for Mac users) any Watchlist column header and select Configure Columns.... You can read
more about configuring columns in the section, Configuring Columns.

Watchlist’s “Prices” and “Fundamentals” views support the following columns.

Column Name Column Description
Symbol Stock or Ticker Symbol
Symbol* Stock or Ticker Symbol without the Google Finance exchange prefix.
Name Company name
Date Added Date added to the list
Comment User Comment
Alert An icon depicting whether an alert is set on this item. An empty field means no alert is set. Set alerts and raised alerts have different icons.
Currency The currency of the item.
Ask Asking price
Ask Size Asking price size
Bid Bidding price
Bid Size Bidding price size
Day% Today’s percentage change
Change Today’s point change
Day Hi Today’s high
Day Lo Today’s low
Last Price of the most recent quote
Last Date Date of most recent quote
Last DateTime Date and time of most recent quote
Last Size Size of last trade
Open Price at open
Close Previous closing price
OpenSignal Last trade price minus open price. Used for determining the daily trend of a stock.
OpenSignal % Last trade price minus open price as a percentage of the open price. Used for determining the daily trend of a stock.
Gap Open price minus previous close price. Used for determining the daily trend of a stock.
Gap % Open price minus previous close price as a percentage of the open price. Used for determining the daily trend of a stock.
Volume Today’s volume

Continued on next page
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Table 8.1 – continued from previous page
Column Name Column Description
Vol Avg 3M Average daily volume of the last 3 months. (YF only)
Vol % Avg 3M Today’s volume as a percentage of the average 3 month daily volume (YF only)
52Wk Lo 52 week low price
52Wk Hi 52 week high price
52Wk % Current price as percentage of 52 week high/low range. 100% means stock is at 52 week high; 0% means stock is at 52 week low.
% < 52Wk Hi The percentage that the stock has fallen since reaching its 52 week high price.
% > 52Wk Lo The percentage that the stock has risen since reaching its 52 week low price.
Price Tgt 1Y 1 year price target (YF only)
50D MovAvg 50 day moving average (YF only)
200D MovAvg 200 day moving average (YF only)
DivPay Date Dividend pay date (YF only)
ExDiv Date Ex-dividend date (YF only)
Dividend Trailing 12 month dividend per share
Yield Trailing 12 month dividend yield
DivPayoutRatio The percentage of earnings paid to shareholders in dividends, using current EPS and trailing 12-month dividends.
FwdDiv Forward 12 month dividend per share, computed from the last known dividend payment.
FwdYield Forward 12 month dividend yield, computed from the last known dividend payment.
FwdPayoutRatio The percentage of earnings paid to shareholders in dividends, using current EPS and the forward 12-month dividends.
Mkt Cap Market capitalization
Float Float: number of shares of a company that are freely bought and sold without restrictions by the public. (YF only)
Shares Outstanding Shares outstanding: number of stocks issued by a company, both public and restricted. (YF only)
Short Ratio Short ratio (YF only)
EPS Earnings per share
EPS Est Cur Yr Current year EPS estimate (YF only)
EPS Est Next Yr Next year EPS estimate (YF only)
EPS Est Next Qtr Next quarter EPS estimate (YF only)
P/E Price to earnings ratio
Fwd PE (Cur Yr) Forward PE current year (YF only)
Fwd PE (Next Yr) Forward PE next year (YF only)
PEG Price to earnings over growth (5 year) ratio (YF only)
PEG (1Yr) Price to earnings over growth (1 year) ratio (YF only)
Book Val Book value
Price/Book Price to book
Sales/Share Sales (i.e. revenue) per share
Price/Sales Price to sales
EBITDA Earnings before interest, taxes, depreciation and amortization
Exchange Stock exchange
1W % Percentage change in share price over the last 1 week
4W % Percentage change in share price over the last 4 weeks
3M % Percentage change in share price over the last 3 months
6M % Percentage change in share price over the last 6 months
9M % Percentage change in share price over the last 9 months
YTD % Percentage change in share price since the beginning of the year
1Y % Percentage change in share price over the last year
2Y % Percentage change in share price over the last 2 years
5Y % Percentage change in share price over the last 5 years
10Y % Percentage change in share price over the last 10 years
Contract High The highest price at which this option contract has traded
Contract Low The lowest price at which this option contract has traded
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Table 8.1 – continued from previous page
Column Name Column Description
Exp Date The option’s expiration date
Open Interest Total number of option contracts that have not closed on a particular day
Strike Price The price at which the option contract can be exercised
Current Ratio The stocks current ratio. (GF only)
LT Debt to Assets Long term debt to assets ratio (GF only)
Total Debt to Assets Total debt to assets ratio (GF only)
LT Debt to Equity Long term debt to equity ratio (GF only)
Total Debt to Equity Total debt to equity ratio (GF only)
Return on Avg Equity Return on average equity ratio (GF only)
Return on Avg Assets Return on average assets ratio (GF only)
ROI Return on investment (GF only)
Beta The stocks current beta (GF only)
Net Profit Margin The company’s net profit margin (GF only)
Gross Margin The company’s gross margin (GF only)
EBITD Margin The company’s Earnings Before Interest, Tax and Depreciation margin (GF only)
Operating Margin The company’s operating margin (GF only)
Employees The company’s employee count (GF only)
Revenue The company’s revenue (GF only)
Net Income The company’s net income (GF only)
Sector The general segmemt (sector) of the economy in which this company operates.
Industry The specific segment of the general sector of the economy in which this company operates.
MktCap The market cap type (Mega, Large, Small, Micro, Nano).
:-) A graphical importance setting for this ticker symbol.
Sec Type The security type (stock, bond, etf... or custom value) for this ticker symbol.
Target An editable numerical value representing the target price of the security.
Target % The current Last price as a percentage of the Target price.
Target Dsct The target discount - difference between the Target price and the Last price as a percentage.
Watchlist Name of the watchlist to which this item belongs.
Watch Start Price at which you started watching this item.
Watch Change Change since you started watching
Watch % Percentage change since you started watching
Watch Yield Dividend yield based on today’s dividend / watch start price
Watch Days Number of days since the item was added to the watchlist (Date Added column).

8.3.3 Portfolio Columns

You can setup the columns in the Portfolio’s “Prices” and “Fundamentals” views to show the data that is useful for
your investment analysis.

Right-click (ctrl-click for Mac users) any Portfolio column header and select Configure Columns.... You can read
more about configuring columns in the section, Configuring Columns.

Portfolio’s “Prices” and “Fundamentals” views support the following columns.

Column Name Column Description
Symbol Stock or Ticker Symbol
Symbol* Stock or Ticker Symbol without the Google Finance exchange prefix.
Name Company name
Date Added Date added to the list
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Table 8.2 – continued from previous page
Column Name Column Description
Comment User Comment
Alert An icon depicting whether an alert is set on this item. An empty field means no alert is set. Set alerts and raised alerts have different icons.
Currency The currency of the item.
Ask Asking price
Ask Size Asking price size
Bid Bidding price
Bid Size Bidding price size
Day% Today’s percentage change
Change Today’s point change
Day Hi Today’s high
Day Lo Today’s low
Last Price of the most recent quote
Last Date Date of most recent quote
Last DateTime Date and time of most recent quote
Last Size Size of last trade
Open Price at open
Close Previous closing price
OpenSignal Last trade price minus open price. Used for determining the daily trend of a stock.
OpenSignal % Last trade price minus open price as a percentage of the open price. Used for determining the daily trend of a stock.
Gap Open price minus previous close price. Used for determining the daily trend of a stock.
Gap % Open price minus previous close price as a percentage of the open price. Used for determining the daily trend of a stock.
Volume Today’s volume
Vol Avg 3M Average daily volume of the last 3 months. (YF only)
Vol % Avg 3M Today’s volume as a percentage of the average 3 month daily volume (YF only)
52Wk Lo 52 week low price
52Wk Hi 52 week high price
52Wk % Current price as percentage of 52 week high/low range. 100% means stock is at 52 week high; 0% means stock is at 52 week low.
% < 52Wk Hi The percentage that the stock has fallen since reaching its 52 week high price.
% > 52Wk Lo The percentage that the stock has risen since reaching its 52 week low price.
Price Tgt 1Y 1 year price target (YF only)
50D MovAvg 50 day moving average (YF only)
200D MovAvg 200 day moving average (YF only)
DivPay Date Dividend pay date (YF only)
ExDiv Date Ex-dividend date (YF only)
Dividend Trailing 12 month dividend per share
Yield Trailing 12 month dividend yield
DivPayoutRatio The percentage of earnings paid to shareholders in dividends, using current EPS and trailing 12-month dividends.
FwdDiv Forward 12 month dividend per share, computed from the last known dividend payment.
FwdYield Forward 12 month dividend yield, computed from the last known dividend payment.
FwdPayoutRatio The percentage of earnings paid to shareholders in dividends, using current EPS and the forward 12-month dividends.
Mkt Cap Market capitalization
Float Float: number of shares of a company that are freely bought and sold without restrictions by the public. (YF only)
Shares Outstanding Shares outstanding: number of stocks issued by a company, both public and restricted. (YF only)
Short Ratio Short ratio (YF only)
EPS Earnings per share
EPS Est Cur Yr Current year EPS estimate (YF only)
EPS Est Next Yr Next year EPS estimate (YF only)
EPS Est Next Qtr Next quarter EPS estimate (YF only)
P/E Price to earnings ratio
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Table 8.2 – continued from previous page
Column Name Column Description
Fwd PE (Cur Yr) Forward PE current year (YF only)
Fwd PE (Next Yr) Forward PE next year (YF only)
PEG Price to earnings over growth (5 year) ratio (YF only)
PEG (1Yr) Price to earnings over growth (1 year) ratio (YF only)
Book Val Book value
Price/Book Price to book
Sales/Share Sales (i.e. revenue) per share
Price/Sales Price to sales
EBITDA Earnings before interest, taxes, depreciation and amortization
Exchange Stock exchange
1W % Percentage change in share price over the last 1 week
4W % Percentage change in share price over the last 4 weeks
3M % Percentage change in share price over the last 3 months
6M % Percentage change in share price over the last 6 months
9M % Percentage change in share price over the last 9 months
YTD % Percentage change in share price since the beginning of the year
1Y % Percentage change in share price over the last year
2Y % Percentage change in share price over the last 2 years
5Y % Percentage change in share price over the last 5 years
10Y % Percentage change in share price over the last 10 years
Contract High The highest price at which this option contract has traded
Contract Low The lowest price at which this option contract has traded
Exp Date The option’s expiration date
Open Interest Total number of option contracts that have not closed on a particular day
Strike Price The price at which the option contract can be exercised
Current Ratio The stocks current ratio. (GF only)
LT Debt to Assets Long term debt to assets ratio (GF only)
Total Debt to Assets Total debt to assets ratio (GF only)
LT Debt to Equity Long term debt to equity ratio (GF only)
Total Debt to Equity Total debt to equity ratio (GF only)
Return on Avg Equity Return on average equity ratio (GF only)
Return on Avg Assets Return on average assets ratio (GF only)
ROI Return on investment (GF only)
Beta The stocks current beta (GF only)
Net Profit Margin The company’s net profit margin (GF only)
Gross Margin The company’s gross margin (GF only)
EBITD Margin The company’s Earnings Before Interest, Tax and Depreciation margin (GF only)
Operating Margin The company’s operating margin (GF only)
Employees The company’s employee count (GF only)
Revenue The company’s revenue (GF only)
Net Income The company’s net income (GF only)
Sector The general segmemt (sector) of the economy in which this company operates.
Industry The specific segment of the general sector of the economy in which this company operates.
MktCap The market cap type (Mega, Large, Small, Micro, Nano).
:-) A graphical importance setting for this ticker symbol.
Sec Type The security type (stock, bond, etf... or custom value) for this ticker symbol.
Target An editable numerical value representing the target price of the security.
Target % The current Last price as a percentage of the Target price.
Target Dsct The target discount - difference between the Target price and the Last price as a percentage.
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Table 8.2 – continued from previous page
Column Name Column Description
Portfolio Name of the portfolio to which this item belongs.
Last Ccy Price of the most recent quote converted to the currency of the portfolio using the current exchange rate.
BuyPrice Price paid per share
Shares Number of shares owned
Shares Simple Number of shares owned, with any fractional shares rounded to the nearest whole share
DayGain Today’s gain or loss
BuyVal Original purchase value (does not include transaction costs)
BuyVal Ccy Original purchase value (does not include transaction costs) converted to the currency of the portfolio using the exchange rate recorded in the purchase transaction.
MktVal Current market value of position
MktVal w/o Cash Current market value of position, not including the cash balance.
MktVal Ccy Current market value of position converted to the currency of the Portfolio
Gain Gain or loss from the cost basis
Gain % Gain or loss percentage from the cost basis
Gain/Share Gain or loss from the cost basis divided by the number of shares.
Chg/Share Change per share from the BuyPrice to the current Last price.
GainYTD Gain or loss from beginning of the year or from date of purchase if purchased since the beginning of the year.
GainYTD Ccy Gain or loss from beginning of the year or from date of purchase if purchased since the beginning of the year, converted to the currency of the Portfolio, including exchange rate changes.
GainYTD % Gain or loss percentage from beginning of the year or from date of purchase if purchased since the beginning of the year.
GainYTD % Ccy Gain or loss percentage from beginning of the year or from date of purchase if purchased since the beginning of the year, including exchange rate changes.
Buy FX Exchange rate between the currency of the item and the currency of the Portfolio on the date of purchase.
FX Exchange rate between the currency of the item and the currency of the Portfolio
FX Inv The inverse of the exchange rate between the currency of the item and the currency of the Portfolio
Gain Ccy Gain or loss from the costs basis converted to the currency of the Portfolio, including exchange rate changes
Gain % Ccy Gain or loss percentage from the cost basis converted to the currency of the Portfolio, including exchange rate changes
DayGain Ccy Today’s gain or loss converted to the currency of the Portfolio
CostBasis Cost basis of this position (either standard cost basis [SCB] or the average cost basis [ACB])
CostBasis Ccy Cost basis of this position (either standard cost basis [SCB] or the average cost basis [ACB]) converted to the currency of the Portfolio using the exchange rate from the purchase transaction
CostBasis/Share The per share cost basis of this position.
SCB SCB of this position (buy val + costs)
SCB Ccy Standard cost basis of this position (buy val + costs) converted to the currency of the Portfolio using the exchange rate from the purchase transaction
SCB/Share The per share cost basis of this position calculated using the standard cost basis.
ACB Average cost basis of this position
ACB Ccy Average cost basis of this position converted to the currency of the Portfolio using the exchange rate from the purchase transaction
ACB/Share The per share cost basis of this position calculated using the average cost basis.
TR The Total Return gain/loss value for this position including transaction costs and distributions
TR Ccy The Total Return gain/loss value for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes.
TR % The Total Return gain/loss percentage for this position including transaction costs and distributions
TR % Ccy The Total Return gain/loss percentage for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes.
Ann. TR % The annualized Total Return gain/loss percentage for this position including transaction costs and distributions
Ann. TR % Ccy The annualized Total Return gain/loss percentage for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes.
TR YTD The Total Return gain/loss value for this position including transaction costs and distributions since the start of the year
TR YTD Ccy The Total Return gain/loss value for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes since the start of the year
TR % YTD The Total Return gain/loss percentage for this position including transaction costs and distributions since the start of the year
TR % YTD Ccy The Total Return gain/loss percentage for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes since the start of the year
CAGR The Compounded Annual Growth Rate (CAGR) that this item has returned since purchase, including transaction costs.
TWRR The compounded annual Time Weighted Rate of Return (TWRR) that this item has returned since purchase.
IRR The Internal Rate of Return (IRR) (also known as the Dollar/Money-Weighted Return) that this item has returned since purchase.
Port.% The percentage of the total portfolio value represented by this item.
Port.% w/o Cash The percentage of the total portfolio value represented by this item, not including the cash balance.
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Table 8.2 – continued from previous page
Column Name Column Description
Days Held The number of days the shares have been held
Weekdays Held The number of weekdays the shares have been held. Includes holidays that fall on a weekday.
DivVal The yearly value of the current TTM dividend (Dividend * number of shares)
YTD Income The total value of dividends and capital gains paid by this lot in the year-to-date as recorded in the transactions, including re-invested amounts.
1Y Income The total value of dividends and capital gains paid by this lot in the last 12 months as recorded in the transactions, including re-invested amounts.
Total Income The total value of dividends and capital gains paid by this lot since purchase as recorded in the transactions, including re-invested amounts.
BuyValYield The dividend yield on purchase value of the item, computed as ((Annual Dividend Value/Buy Val)*100).
YOC Yield On Cost for this holding, computed as (Annual Dividend Value / CostBasis) * 100.
Benchmark Symbol The symbol used for benchmark comparisons in this portfolio.
Benchmark Shares The number of shares that would be held if the invested amount was made in a benchmark, and all dividends were re-invested.
Benchmark MktVal The current market value if the invested amount had been made in a benchmark, and all dividends were re-invested.
Benchmark Day Gain The gain in value if yesterday’s closing value of this investment was invested in a benchmark today.
Benchmark Percent Today’s percentage change for the benchmark, a benchmark.
Benchmark TR The total return since purchase, including transaction costs and dividends, if the invested amount had been made in a benchmark and all dividends had been re-invested.
Benchmark TR % The percentage total return since purchase, including transaction costs and dividends, if the invested amount had been made in a benchmark and all dividends had been re-invested.
Benchmark CAGR The Compounded Annual Growth Rate (CAGR) that the invested amount would have returned since purchase, if the investment had been made in a benchmark, including transaction costs/fees, and all dividends paid had been re-invested.
Benchmark IRR The Internal Rate of Return (IRR) (also known as the Dollar/Money-Weighted Return) that the invested amount would have returned since purchase, if the investment had been made in a benchmark, including re-invested dividends.
Benchmark TWRR The compounded annual Time Weighted Rate of Return (TWRR) that the invested amount would have returned since purchase, if the investment has been made in a benchmark, including re-invested dividends.

8.3.4 Portfolio Group’s Totals View Columns

You can setup the columns in the Totals view of a Portfolio Group to show the data that is useful for your investment
analysis.

Right-click (ctrl-click for Mac users) any column header and select Configure Columns.... You can read more about
configuring columns in the section, Configuring Columns.

The Totals view in the Portfolio Group supports the following columns.

Column Name Column Description
Name Name of the Watchlist or Portfolio
Currency The currency of the portfolio
Day Gain Today’s gain or loss
Day Gain Ccy Today’s gain or loss converted to the currency of the Portfolio Totals
Percent Today’s percentage change
Buy Val Original purchase value
BuyVal Ccy Original purchase value converted to the currency of the top-level group using the exchange rate at the time of purchase.
CostBasis Cost basis of this portfolio (buy val + costs)
CostBasis Ccy Cost basis of this portfolio (buy val + costs) converted to the currency of the top-level group using the exchange rate at the time of purchase.
Gain Gain or loss from the cost basis
Gain Ccy Gain or loss from the costs basis converted to the currency of the Portfolio, including exchange rate changes
Gain % Gain or loss percentage from purchase value including transaction costs
Gain % Ccy Gain or loss percentage from the cost basis converted to the currency of the Portfolio, including exchange rate changes
TR The Total Return gain/loss value for this position including transaction costs and distributions
TR Ccy The Total Return gain/loss value for this position including transaction costs and distributions converted to the currency of the Portfolio
TR % The Total Return gain/loss percentage for this position including transaction costs and distributions
TR % Ccy The Total Return gain/loss percentage for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes.
Ann. TR % The annualized Total Return gain/loss percentage for this position including transaction costs and distributions
Ann. TR % Ccy The annualized Total Return gain/loss percentage for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes.

Continued on next page

268 Chapter 8. General Features and Documentation

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


www.stockmarketeye.com StockMarketEye User’s Guide, Release 4.2

Table 8.3 – continued from previous page
Column Name Column Description
TR YTD The Total Return gain/loss value for this position including transaction costs and distributions since the start of the year
TR YTD Ccy The Total Return gain/loss value for this position including transaction costs and distributions converted to the currency of the Portfolio since the start of the year
TR YTD % The Total Return gain/loss percentage for this position including transaction costs and distributions since the start of the year
TR YTD % Ccy The Total Return gain/loss percentage for this position including transaction costs and distributions, converted to the currency of the Portfolio, including exchange rate changes since the start of the year
MktVal Current market value of position
MktVal Ccy Current market value of position converted to the currency of the Portfolio
MktVal w/o Cash Current market value of position, not including the cash balance.
MktVal w/o Cash Ccy Current market value of position, not including the cash balance, converted to the currency of the Portfolio with the current exchange rate.
FX Exchange rate between the currency of the Portfolio and the currency of the Portfolio Totals
FX Inv Inverse of the exchange rate between the currency of the Portfolio and the currency of the Portfolio Totals
YearlyDivVal The yearly value of the current dividend for the holdings in this portfolio
YearlyDivYield The yearly yield of the current dividend for the holdings in this portfolio
Group % The percentage of the total group value represented by this item.
YTD Income The total value of dividends and capital gains paid by the current holdings of this portfolio in the year-to-date as recorded in the transactions
1Y Income The total value of dividends and capital gains paid by the current holdings of this portfolio in the last 12 months as recorded in the transactions
Total Income The total value of dividends and capital gains paid by the current holdings of this portfolio since their purchase as recorded in the transactions
Cash The amount of cash in this portfolio.
Cash Ccy The amount of cash in this portfolio converted to the currency of the Group.
Cash % The percentage of this portfolio represented by its cash holdings.
TWRR The compounded annual Time Weighted Rate of Return (TWRR) that this item has returned since purchase.
IRR The Internal Rate of Return (IRR) (also known as the Dollar/Money-Weighted Return) that this item has returned since purchase.
GainYTD Gain or loss from beginning of the year
GainYTD Ccy Gain or loss from beginning of the year converted to the currency of the Portfolio
GainYTD % Gain or loss percentage from beginning of the year
Benchmark Symbol The symbol used for benchmark comparisons in this portfolio.
Benchmark MktVal The current market value of this portfolio, had the current investments been made in a benchmark, and all dividends had been re-invested.
Benchmark TR The total return since purchase, including transaction costs and dividends, if the portfolios current investments had been made in {0} instead and all dividends paid to {1} had been re-invested.
Benchmark TR % The percentage total return since purchase, including transaction costs and dividends, if the portfolios current investment had been made in {0} instead and all dividends paid to {1} had been re-invested.
Benchmark IRR The Internal Rate of Return (IRR) (also known as the Dollar/Money-Weighted Return) that the invested amount would have returned since purchase, if the investment had been made in a benchmark, including re-invested dividends.
Benchmark TWRR The compounded annual Time Weighted Rate of Return (TWRR) that the invested amount would have returned since purchase, if the investment has been made in a benchmark, including re-invested dividends.

8.3.5 Transactions Report Columns

You can setup the columns in the Transactions report to show the data that is useful for your investment analysis.

Right-click (ctrl-click for Mac users) any column header and select Configure Columns.... You can read more about
configuring columns in the section, Configuring Columns.

The Transactions report supports the following columns.

Column Name Column Description
Portfolio Name of the portfolio to which this transaction belongs.
Type Type of the transaction
Date Date of the transaction
Symbol Stock or Ticker Symbol
Name Company Name
Shares Number of shares in transaction or split ratio
Price Transaction’s price per share
Costs Costs or commissions paid on this transaction
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Table 8.4 – continued from previous page
Column Name Column Description
Fees Fees paid on this transaction
Taxes Taxes paid on this transaction
Credits Credits associated with this transaction
Value Value of the transaction, before costs
NetTotal Total value of the transaction, including costs
FX Exchange rate from the transactions currency to the portfolios currency at the time of the transaction
FX Inv Inverse of the exchange rate from the transaction’s currency to the portfolio’s currency at the time of the transaction
FX Currency The exchange rates destination currency (i.e. the currency of the portfolio).
Value Ccy Value of the transaction, before costs, converted to the portfolio’s currency using the transaction’s exchange rate.
NetTotal Ccy Total value of the transaction, including costs, converted to the destination currency (i.e. the currency of the portfolio) using the transaction’s exchange rate.
Costs Ccy Costs or transaction fees, converted to the destination currency (i.e. the currency of the portfolio) using the transaction’s exchange rate.
Fees Ccy Fees paid on this transaction, converted to the destination currency (i.e. the currency of the portfolio) using the transaction’s exchange rate.
Taxes Ccy Taxes paid on this transaction, converted to the destination currency (i.e. the currency of the portfolio) using the transaction’s exchange rate.
Credits Ccy Credits associated with this transaction, including costs, converted to the destination currency (i.e. the currency of the portfolio) using the transaction’s exchange rate.
Distribution The value of the distribution per share.
Shares Affected The number of shares affected by the dividend.
Description The description of the transaction, automatically generated by StockMarketEye.
Cash Affected Was the proceeds of the transaction applied to the cash balance of the Portfolio.
Comment User Comment
Currency Original transaction currency
Brokerage Id Unique identifier assigned to this transaction by your brokerage.
ACB/Share Average cost per share at the time of sale.
CashBalance The cash balance of the portfolio after the transaction was applied.

8.3.6 Gain/Loss Report Columns

You can setup the columns in the Gain/Loss report to show the data that is useful for your investment analysis.

Right-click (ctrl-click for Mac users) any column header and select Configure Columns.... You can read more about
configuring columns in the section, Configuring Columns.

The Gain/Loss report supports the following columns.
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Column
Name

Column Description

Symbol Stock or Ticker Symbol
Name Company Name
Portfolio Portfolio in which this gain/loss occurred.
Shares Number of shares.
Currency The currency of the symbol
Open Date Date that the position was opened.
Open Price Price paid per share when the position was opened.
Open Costs Costs/commissions of the opening transaction.
Open Fees Fees of the opening transaction.
Open Total Total amount paid when the position was opened.
Open FX Exchange rate at time the position was opened.
Open Total
Ccy

Total amount paid when the position was opened, converted using the exchange rate at the time
the position was opened.

Close Date Date that the position was closed.
Close Price Price received per share when the position was closed.
Close Costs Costs/commissions of the closing transaction.
Close Fees Fees of the closing transaction.
Close Total Total amount received when the position was closed.
Close FX Exchange rate at time the position was closed.
Close Total
Ccy

Total amount received when the position was closed, converted using the exchange rate at the
time the position was closed.

Gain Total gain including transaction costs.
Gain % Total percentage gain including transaction costs.
Gain Ccy Total gain including transaction costs and exchange rate changes.
Gain % Ccy Total percentage gain including transaction costs and exchange rate changes.
Days Held Number of days this position was held.
Weekdays
Held

The number of weekdays the shares have been held. Includes holidays that fall on a weekday.

8.3.7 Back-In-Time Report Columns

You can setup the columns in the Back-In-Time report to show the data that is useful for your investment analysis.

Right-click (ctrl-click for Mac users) any column header and select Configure Columns.... You can read more about
configuring columns in the section, Configuring Columns.

The Back-In-Time report supports the following columns.

Column Name Column Description
Symbol Stock or Ticker Symbol
Symbol* Stock or Ticker Symbol without the Google Finance exchange prefix.
Name Company name
Date Added Date added to the list
Comment User Comment
Currency The currency of the item.
Close Previous closing price
Open Price at open
Day Hi Today’s high
Day Lo Today’s low
Last Price of the most recent quote

Continued on next page

8.3. Configuring Columns 271

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

Table 8.5 – continued from previous page
Column Name Column Description
Last Date Date of most recent quote
Day% Today’s percentage change
Change Today’s point change
DayGain Today’s gain or loss
OpenSignal Last trade price minus open price. Used for determining the daily trend of a stock.
OpenSignal % Last trade price minus open price as a percentage of the open price. Used for determining the daily trend of a stock.
Gap Open price minus previous close price. Used for determining the daily trend of a stock.
Gap % Open price minus previous close price as a percentage of the open price. Used for determining the daily trend of a stock.
Shares Number of shares owned
Shares Simple Number of shares owned, with any fractional shares rounded to the nearest whole share
BuyPrice Price paid per share
BuyVal Original purchase value (does not include transaction costs)
BuyVal Ccy Original purchase value (does not include transaction costs) converted to the currency of the portfolio using the exchange rate recorded in the purchase transaction.
MktVal Current market value of position
MktVal w/o Cash Current market value of position, not including the cash balance.
Gain Gain or loss from the cost basis
Gain % Gain or loss percentage from the cost basis
GainYTD Gain or loss from beginning of the year or from date of purchase if purchased since the beginning of the year.
GainYTD Ccy Gain or loss from beginning of the year or from date of purchase if purchased since the beginning of the year, converted to the currency of the Portfolio, including exchange rate changes.
GainYTD % Gain or loss percentage from beginning of the year or from date of purchase if purchased since the beginning of the year.
GainYTD % Ccy Gain or loss percentage from beginning of the year or from date of purchase if purchased since the beginning of the year, including exchange rate changes.
Buy FX Exchange rate between the currency of the item and the currency of the Portfolio on the date of purchase.
FX Exchange rate between the currency of the item and the currency of the Portfolio
FX Inv The inverse of the exchange rate between the currency of the item and the currency of the Portfolio
MktVal Ccy Current market value of position converted to the currency of the Portfolio
Gain Ccy Gain or loss from the costs basis converted to the currency of the Portfolio, including exchange rate changes
Gain % Ccy Gain or loss percentage from the cost basis converted to the currency of the Portfolio, including exchange rate changes
DayGain Ccy Today’s gain or loss converted to the currency of the Portfolio
CostBasis Cost basis of this position (either standard cost basis [SCB] or the average cost basis [ACB])
CostBasis Ccy Cost basis of this position (either standard cost basis [SCB] or the average cost basis [ACB]) converted to the currency of the Portfolio using the exchange rate from the purchase transaction
CostBasis/Share The per share cost basis of this position.
SCB SCB of this position (buy val + costs)
SCB Ccy Standard cost basis of this position (buy val + costs) converted to the currency of the Portfolio using the exchange rate from the purchase transaction
SCB/Share The per share cost basis of this position calculated using the standard cost basis.
ACB Average cost basis of this position
ACB Ccy Average cost basis of this position converted to the currency of the Portfolio using the exchange rate from the purchase transaction
ACB/Share The per share cost basis of this position calculated using the average cost basis.
TR The Total Return gain/loss value for this position including transaction costs and distributions
TR % The Total Return gain/loss percentage for this position including transaction costs and distributions
Ann. TR % The annualized Total Return gain/loss percentage for this position including transaction costs and distributions
TR YTD The Total Return gain/loss value for this position including transaction costs and distributions since the start of the year
TR % YTD The Total Return gain/loss percentage for this position including transaction costs and distributions since the start of the year
CAGR The Compounded Annual Growth Rate (CAGR) that this item has returned since purchase, including transaction costs.
TWRR The compounded annual Time Weighted Rate of Return (TWRR) that this item has returned since purchase.
IRR The Internal Rate of Return (IRR) (also known as the Dollar/Money-Weighted Return) that this item has returned since purchase.
Port.% The percentage of the total portfolio value represented by this item.
Port.% w/o Cash The percentage of the total portfolio value represented by this item, not including the cash balance.
Days Held The number of days the shares have been held
Weekdays Held The number of weekdays the shares have been held. Includes holidays that fall on a weekday.

Continued on next page
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Table 8.5 – continued from previous page
Column Name Column Description
YTD Income The total value of dividends and capital gains paid by this lot in the year-to-date as recorded in the transactions, including re-invested amounts.
1Y Income The total value of dividends and capital gains paid by this lot in the last 12 months as recorded in the transactions, including re-invested amounts.
Total Income The total value of dividends and capital gains paid by this lot since purchase as recorded in the transactions, including re-invested amounts.
Benchmark Symbol The symbol used for benchmark comparisons in this portfolio.
Benchmark Shares The number of shares that would be held if the invested amount was made in a benchmark, and all dividends were re-invested.
Benchmark MktVal The current market value if the invested amount had been made in a benchmark, and all dividends were re-invested.
Benchmark Day Gain The gain in value if yesterday’s closing value of this investment was invested in a benchmark today.
Benchmark Percent Today’s percentage change for the benchmark, a benchmark.
Benchmark TR The total return since purchase, including transaction costs and dividends, if the invested amount had been made in a benchmark and all dividends had been re-invested.
Benchmark TR % The percentage total return since purchase, including transaction costs and dividends, if the invested amount had been made in a benchmark and all dividends had been re-invested.

8.4 Preferences

8.4.1 Password Protecting Your StockMarketEye Data

StockMarketEye allows you to set a password to protect access to your data. Setting a password provides 2 levels of
security:

1. Password required before StockMarketEye opens - After enabling password protection in StockMarketEye,
you will be required to enter the password before StockMarketEye will open.

2. Your StockMarketEye data is encrypted - After enabling password protection, your StockMarketEye data
files will be encrypted. This means that even if someone has access to the data files themselves, they can not
be read (unless they also have the password). The data files are encrypted with industry standard, AES 128 bit
encryption.

Note: Once you have enabled password protection, do not lose or forget your password.

It is not possible to recover the data without the password!!

Losing the password also means losing your StockMarketEye data. Without the password, it is impossible to access
your data. If this happens, you will have to start from scratch and re-enter the data.

Enabling Password Protection

To enable password protection, open the Preferences window and go to the “General” tab. Then click on the “Enable
Password Protection” button.
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This will open the “Enable Password Protection” window as seen below.
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Enter and confirm the password you would like to use. The password must be between 6 and 48 characters long and
can not contain any spaces, tabs or other white space.

You can also enter a hint to help you remember in case you lose or forget the password. Do not make this too obvious!
It should be a hint that only you will understand.

After you click OK, StockMarketEye must be restarted to finish enabling password protection.
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Now, when StockMarketEye starts, you will first be required to enter your password.

In case you need a hint, click the “Get Hint” button to show the hint you entered when enabling the password.

Disabling Password Protection

You can disable password protection at any time through the Preferences window. Go to the “General” tab and click
on the “Disable Password Protection” button.
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This will open the “Disable Password Protection” window where you enter your current password.

8.4. Preferences 277

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

After entering the password, you will have to restart StockMarketEye in order to completely disable password protec-
tion.

When starting up StockMarketEye no longer requires you to enter the password.

8.4.2 Changing the Font Size

You can change the size of the text displayed in all Portfolio and Watchlist tables via the Preferences window, in the
“Visuals” tab.
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Use the “Font size” selector to choose how large you would like the text to be. The text, “Actual text size in Portfolio
and Watchlist tables,” will change size to match the chosen font size.
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To go back to the default text size, click on the “Reset to default” button.

To apply the text size to all Portfolio and Watchlist tables, click on the Preference’s OK button.

Note: Changing from a larger text size to a smaller text size can sometimes cause the spacing of items in the tables
to be inconsistent. If this happens to you, restart StockMarketEye to correct the spacing.

8.5 Other Features

8.5.1 Installing Your StockMarketEye License Key

You can activate your copy of StockMarketEye by entering your license key using the “Enter License Key” window.

You can open the “Enter License Key” window from the trial period warning window by clicking on the “I Want To
Enter My License Key” button:
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Or from the menu, Help -> Enter License Key... :

Enter License Key Window

We recommend that you copy-paste your license key from the email to the license key window. Copy-pasting is faster
and less error prone than typing by hand.

After the license key has been validated, we recommend that you restart StockMarketEye.
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CHAPTER

NINE

OTHER FEATURES AND DOCUMENTATION

9.1 Network Proxy Configuration

StockMarketEye gets stock quotes from the Internet. As is often the case in a corporate setting, you may be required
to pass through a proxy server in order to access the Internet. This guide will show you how to tell StockMarketEye
to use a proxy server when accessing the Internet.

If you don’t know what a proxy server is, you can skip this section.

9.1.1 Setting A Proxy Server

In the main menu, select File -> Preferences... This will open the StockMarketEye “Preferences” window.

Open the StockMarketEye “Preferences” window. On a Mac you can do this by going to the “StockMarketEye” menu
and choose “Preferences. . . ”. On Windows or Linux, go to the File menu and choose “Preferences. . . ”.
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If you are behind an authenticating proxy, select the “Enable proxy authentication” option and enter your username
and password in the appropriate fields.

Click “OK” to save and activate the settings.

9.2 Changing the Location of Your Data Files

StockMarketEye data files contain all of the investing information that you have entered into StockMarketEye. Watch-
lists, Portfolios, Transactions and even historical stock prices are stored in a special set of files on your computer.

Some users, however, may wish to keep their investing information in a different location. For example...

• You want to keep your investing information on a USB key or external hard drive so you can take the data with
you.

• You want to keep your investing information on a separate disk that is backed up regularly.
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• You want to keep your investing information on an encrypted partition.

StockMarketEye allows you to do any of these by making it easy to change the location of the data files that it uses.

9.2.1 Default Location

By default, StockMarketEye stores its data files in a folder called “db” in a standard location on your computer.

Mac OS X (non-Mac Store version) /Users/<your user>/Library/Application
Support/StockMarketEye40/db
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Mac OS X (Mac Store version) /Users/<your-user>/Library/Containers/com.stockmarketeye.mac/Data/Library/Application
Support/StockMarketEye40/db
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Windows 10/8/7/Vista C:\Users\<your user>\AppData\Roaming\StockMarketEye40\db
Windows XP C:\Documents and Settings\<your

user>\Application
Data\StockMarketEye40\db

Linux /home/<your user>/.StockMarketEye40/db

9.2.2 Changing the Data File Location

You can follow these steps to change the location of the data files that StockMarketEye uses.

Note: The data file location can not be changed when using the Mac App Store version of StockMarketEye. This is
due to sandboxing restrictions built-into Mac OS X.

1. We strongly suggest using StockMarketEye’s Backup/Restore feature to backup your data before you change
the data file location. This will ensure that you can recover from any problems that might happen while working
through the steps below.

2. Make sure that StockMarketEye is not running!

Attention: Always quit StockMarketEye before ejecting or unmounting any removable media on which you store
the StockMarketEye data files.
If you remove a USB key or external hard drive where the StockMarketEye data base is stored before quitting
StockMarketEye, your data will be corrupted.

3. Copy the “db” folder from the default location (listed above) to the place you want to store the data. This can be
a removable drive, a network drive or simply a different location on your computer.

4. Use a text editor to edit the following file. NOTE: this file may not yet exist. In this case, you will have to create
a new file. Be sure that the file is called “sme_overrides.properties”. There should not be any other ending
(such as ‘.txt’, which Windows Notepad adds) on the file name.

9.2. Changing the Location of Your Data Files 285

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme
http://logic-pro-expert.com/logic-pro-blog/2014/12/19/show-the-user-library-folder-in-os-x-yosemite.html
http://logic-pro-expert.com/logic-pro-blog/2014/12/19/show-the-user-library-folder-in-os-x-yosemite.html


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

Mac OS X (non-Mac Store version) /Users/<your user>/Library/Application
Support/StockMarketEye40/sme_overrides.properties
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Mac OS X (Mac Store version) /Users/<your user>/Library/Application/Users/<your
user>/Library/Application
Support/StockMarketEye40/sme_overrides.properties
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Windows 10/8/7/Vista C:\Users\<your user>\AppData\Roaming\StockMarketEye40\sme_overrides.properties
Windows XP C:\Documents and Settings\<your

user>\Application
Data\StockMarketEye40\sme_overrides.properties

Linux /home/<your user>/.StockMarketEye40/sme_overrides.properties

5. Add the following line to the sme_overrides.properties file, replacing <db-folder-location> with the new location
of the “db” folder (from step #1).

sme.db.dir=<db-folder-location>

Here are some examples:

Mac OS X sme.db.dir=/Volumes/MyUSBKey/StockMarketEye_data/db
Windows 10/8/7/Vista sme.db.dir=C:\Users\john\My Encrypted

Stuff\StockMarketEye_data\db
Note: Spaces in the path name can sometimes cause
problems. If you’re having issues with it not recognizing
the folder correctly, try a path without spaces.

Windows XP sme.db.dir=E:\StockMarketEye_data\db
Linux sme.db.dir=/media/MyUSBKey/StockMarketEye_data/db

6. Save the sme_overrides.properties file.

7. Start StockMarketEye.

9.2.3 Trouble Shooting

Here are some of the common problems you might see and how you can fix them.

• When starting StockMarketEye you see a window that says “We have detected another instance of StockMar-
ketEye running on your computer.”

This most likely means that StockMarketEye could not read the data files from the new location. Ensure that
you can view the contents of the “db” folder and that the location specified in the sme_overrides.properties file
is correct.

• When starting StockMarketEye you see the default StockMarketEye window, containing only the default Watch-
lists and Portfolios. Your Watchlists and Portfolios are not there.

This happens when the location specified in the sme_overrides.properties file does not exist. StockMarketEye
will create new data files at this location and use them. You can solve this problem by setting the location in
sme_overrides.properties to the correct location of your StockMarketEye data files (“db” folder).

9.2.4 Questions or Problems

If you have any questions or problems, don’t hesitate to contact our support team.
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9.3 How To Run From A Portable/External Drive

StockMarketEye can be installed and run from a portable hard disk (ex. USB Flash Drive / jump drive / thumb drive,
external hard drive, etc.). It can be setup so that all of the data that it stores will be kept on the portable disk.

To get StockMarketEye setup and running from your portable storage device, follow the steps below.

1. Download the StockMarketEye installer from the website. You can save it to your computer’s main hard drive
(such as in your Downloads folder).

2. Run the installer.

3. In the “Choose Install Location” step, select a folder on your portable drive. For example, if your portable drive
is F:, then choose F:\StockMarketEye. This is the installation folder.

4. Finish the installation.

5. Download the file, sme_overrides.properties, and save it in the installation folder that you choose in step #3
above. For example, if you choose F:\StockMarketEye in the step #3 above, save the file (or move it after
download) here: F:\StockMarketEye\sme_overrides.properties.

6. Start StockMarketEye from the portable drive. Double click on the StockMarketEye.exe file that is in the
installation folder that was specified in step #3 above.

7. StockMarketEye will store its data in sub-folders of the installation folder. Particularly important is the “db”
folder. This folder holds the StockMarketEye data files that contain your investment data.

Be sure that you always quit StockMarketEye before ejecting the portable/external drive. Data corruption
can occur if you eject the drive before quitting StockMarketEye.

9.3. How To Run From A Portable/External Drive 287

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme
http://www.stockmarketeye.com/download
http://www.stockmarketeye.com/sme_overrides.properties


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

9.4 Moving Your Data to a New Machine

You can copy your StockMarketEye data from one computer to another using the steps outlined below. Your Stock-
MarketEye data is portable and can be used on any computer, regardless if it’s a Mac, Windows or Linux.

1. On the old computer, make a backup of your StockMarketEye data by following the steps outlined in the
Backup/Restore page of our User’s Guide.

2. Copy the backup file created in step #1 to the new computer and save it somewhere convenient, such as on your
Desktop.

3. On the new computer, run StockMarketEye.

4. Enter your license key into StockMarketEye using the steps outlined in the Installing Your StockMarketEye
License Key page of the User’s Guide. If you have any problems with the license key validation, please contact
our support team.

5. After the license key has been validated, restart StockMarketEye.

6. Still on the new computer, use the menu, File -> Restore Backup... giving it the backup file that you copied from
your old computer in step #2.

7. Restart StockMarketEye when the restore process has completed.

8. You should now have a complete copy of your StockMarketEye data on your new machine.

9.5 Starting From Scratch Using a Backup File

Some technical problems are best solved by starting from scratch and then restoring your data from a backup file.

9.5.1 Before You Start

Be extra certain that you have a recent backup file of your StockMarketEye data. If you do not have a backup file on
hand, there are 2 options for getting one:

1. Create a backup file manually by following the instructions in the section, Backing Up and Restoring Your Data,
of our User’s Guide.

2. Use one of StockMarketEye’s automatic backup files, described in the section, Automatic Backup.

9.5.2 Solution Steps

1. Make sure you have your backup file in a convenient location, such as on your Desktop or in your Documents
folder.

2. Based on what type of computer you have, move the following folder (the “db” folder) to the trash:
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Mac OS X (non-Mac Store version) /Users/<your user>/Library/Application
Support/StockMarketEye40/db
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Mac OS X (Mac Store version) /Users/<your-user>/Library/Containers/com.stockmarketeye.mac/Data/Library/Application
Support/StockMarketEye40/db
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Windows 10/8/7/Vista C:\Users\<your user>\AppData\Roaming\StockMarketEye40\db
Windows XP C:\Documents and Settings\<your

user>\Application
Data\StockMarketEye40\db

Linux /home/<your user>/.StockMarketEye40/db

NOTE: Moving the “db” folder to the trash means you are removing your StockMarketEye data files. Be sure you
have a recent backup before doing this.

3. Start StockMarketEye. You will now have the default StockMarketEye portfolios and watchlists, and you will
be running under the trial license.

4. Install your StockMarketEye license key as described on this page of our user’s guide. Be sure to restart Stock-
MarketEye after the license key has been validated. If you have problems with the license key validation, please
contact our support team.

5. Restore your StockMarketEye data using the menu: File -> Restore Data... You’ll find more information on
restoring from backup here.

6. After the restore is finished and you have restarted, you should have your StockMarketEye data back and ready
to use.

9.6 “We have detected another instance of StockMarketEye running
on your computer.”

You may, in rare circumstances, see this error window when starting StockMarketEye. There are 2 general situations
in which this can happen.

In the first situtation, StockMarketEye is still running on your computer, but its window is not visible. In this case, the
best option is to re-boot your computer, which will quit the already running version of StockMarketEye and allow it
to be started again after the computer restarts.

However, if you reboot but still see this error message window, you will need to follow the steps in the next section to
get back up-and-running.

9.6. “We have detected another instance of StockMarketEye running on your computer.” 289

http://www.stockmarketeye.com/?utm_source=usersguidepdf&utm_medium=pdf&utm_content=pageheader&utm_campaign=sme
http://logic-pro-expert.com/logic-pro-blog/2014/12/19/show-the-user-library-folder-in-os-x-yosemite.html
http://logic-pro-expert.com/logic-pro-blog/2014/12/19/show-the-user-library-folder-in-os-x-yosemite.html
http://www.stockmarketeye.com/contact


StockMarketEye User’s Guide, Release 4.2 www.stockmarketeye.com

9.6.1 Recovering From Corrupted Data Files

Unfortunately the most typical reason for seeing this error window is that your StockMarketEye data files have become
corrupted.

The data files can become corrupted for a number of reasons, such as power outages, unannounced computer shut-
downs or reboots, or if StockMarketEye quits or is killed unexpectedly.

However, you can easily recover from this issue by removing the corrupted data files and restoring the data from a
backup file.

Removing Corrupted Data Files

The first step in the recovery process is to remove the corrupted StockMarketEye data files. They need to be removed
to make room for the new un-corrupted files.

In the error window, click on the “Open StockMarketEye Config Folder” button.

Clicking this button will open a new window as shown below.

If you are on Windows, the path to the folder is * C:Users<your-user>AppDataRoamingStockMarketEye40 * and the
window will look like this:

If you are on Mac, the path to the folder is * /Users/<your-user>/Library/Application Support/StockMarketEye40 *
and the window will look like this:
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In that window, you must drag the “db” folder to the Trash. Alternatively, you can right-click on the “db” folder and
select “Delete” (on Windows) or “Move to Trash” (On Mac).

Run StockMarketEye in Trial Mode and Enter Your License Key

You can now run StockMarketEye again to get the default watchlists and portfolios. If you’re not using the latest
version of StockMarketEye, you can download it from the website.

As StockMarketEye is now running in trial mode, you should enter your license key to enable all of the features. If
you don’t remember your license key, contact our support staff. The license key can be entered from the menu: Help
-> Enter license key... or you can follow the steps in the section on entering your license key.

Getting A Backup File

Finally, you’ll need to restore your old data from a backup file.

If you have a backup file that you made yourself, you can restore it via the menu: File -> Restore Backup...

If you don’t have a backup file, you can use one of the automatic backup files that StockMarketEye creates for you.

To use an automatic backup file, go to the window where you first saw the “db” folder. Then go into the “autobkup”
folder there. Copy the most recent “auto-sme-backup” file to your Desktop.

On Windows the window will look like this:
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On Mac, the window will look like this:

Then go to StockMarketEye and use the menu: File -> Restore Backup... and select the auto backup file that you just
copied to the Desktop.
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When the backup has finished, you’ll need to restart StockMarketEye. After it starts, you should have your data back
and StockMarketEye running as before.

9.7 Recovering from Fatal Errors

You may, in rare circumstances, see this error window when starting StockMarketEye. Typically this means that
StockMarketEye has encountered an error in the data files from which it can not recover.

You can easily recover from this issue by removing the corrupted data files and restoring the data from a backup file.
The steps in the next section will show you how to do that and get back-up-and-running.

9.7.1 Removing Corrupted Data Files

The first step in the recovery process is to remove the corrupted StockMarketEye data files. They need to be removed
to make room for the new un-corrupted files.

In the error window, click on the “Open StockMarketEye Config Folder” button.
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Clicking this button will open a new window as shown below.

If you are on Windows, the path to the folder is * C:Users<your-user>AppDataRoamingStockMarketEye40 * and the
window will look like this:

If you are on Mac, the path to the folder is * /Users/<your-user>/Library/Application Support/StockMarketEye40 *
and the window will look like this:

In that window, you must drag the “db” folder to the Trash. Alternatively, you can right-click on the “db” folder and
select “Delete” (on Windows) or “Move to Trash” (On Mac).
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9.7.2 Run StockMarketEye in Trial Mode and Enter Your License Key

You can now run StockMarketEye again to get the default watchlists and portfolios. If you’re not using the latest
version of StockMarketEye, you can download it from the website.

As StockMarketEye is now running in trial mode, you should enter your license key to enable all of the features. If
you don’t remember your license key, contact our support staff. The license key can be entered from the menu: Help
-> Enter license key... or you can follow the steps in the section on entering your license key.

9.7.3 Getting A Backup File

Finally, you’ll need to restore your old data from a backup file.

If you have a backup file that you made yourself, you can restore it via the menu: File -> Restore Backup...

If you don’t have a backup file, you can use one of the automatic backup files that StockMarketEye creates for you.

To use an automatic backup file, go to the window where you first saw the “db” folder. Then go into the “autobkup”
folder there. Copy the most recent “auto-sme-backup” file to your Desktop.

On Windows the window will look like this:

On Mac, the window will look like this:
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Then go to StockMarketEye and use the menu: File -> Restore Backup... and select the auto backup file that you just
copied to the Desktop.

When the backup has finished, you’ll need to restart StockMarketEye. After it starts, you should have your data back
and StockMarketEye running as before.

9.8 The StockMarketEye Log File

The StockMarketEye log file contains technical information about what StockMarketEye is doing while it runs. This
file is often helpful in determining the cause of problems you might be having with StockMarketEye.

You can access the StockMarketEye log file via the “About StockMarketEye” window, in the “System” tab.
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The StockMarketEye support team will often ask you to send the log file to them in order to help diagnose any
problems you might be having. If you know what action causes the problem, before sending the log file, please repeat
that action in the StockMarketEye window.

To send the log file to the StockMarketEye support team, the preferred way is to attach the “sme.log” file to an email.
You can also copy-paste the contents of the file into an email.

The log file can also be accessed directly on your hard drive. Depending on your computer, here’s where you can find
the StockMarketEye log file.
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Mac OS X (non-Mac Store version) /Users/<your-user>/Library/Application
Support/StockMarketEye40/log/sme.log
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Mac OS X (Mac Store version) /Users/<your-user>/Library/Containers/com.stockmarketeye.mac/Data/Library/Application
Support/StockMarketEye40/log/sme.log
Note: On Lion and later, the Library folder is hidden by
default. See this page for how to unhide it.

Windows 10/8/7/Vista C:\Users\<your user>\AppData\Roaming\StockMarketEye40\log\sme.log
Windows XP C:\Documents and Settings\<your

user>\Application
Data\StockMarketEye40\log\sme.log

Linux /home/<your user>/.StockMarketEye40/log/sme.log

9.9 How To Enable Debug Logging

To get extended technical information about what StockMarketEye is doing while it runs, you can enable the debug
logging option. Enabling this option will cause StockMarketEye to write detailed technical details (aka. debugging
information) into the StockMarketEye log file.

The StockMarketEye support team will often ask you to “enable debug logging” in order to help them track down and
fix a reported problem.

To enable debug logging, first open the Preferences window and go to the “Advanced” tab. Then:

1. At the bottom of the window, click the box to enable the option entitled “Enable debugging information in the
StockMarketEye log file.“

2. When the box is checked, click on the “OK” button.

Finally, restart StockMarketEye for the change to take effect.

After restart, perform the same action that caused the problem originally. The debugging information will be written
to the StockMarketEye log file. You can then send this “sme.log” file to our support team.
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9.10 How To Change Memory Usage Settings

StockMarketEye is a Java application and as such, its memory usage is constrained to the amount of memory specified
when it starts. This is useful as you know that StockMarketEye will never take more memory than specified.

By default, StockMarketEye is configured to use a maximum of 1024MB (i.e. 1G) of memory. The default 1024MB
setting could potentially be too small if you have a large number of items in your watchlists and portfolios. If this is
the case, StockMarketEye will run very slowly. It will take much longer than normal to update the prices. It will also
be unresponsive to your input (clicking and typing).
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If your computer has enough physical memory (RAM), you can raise StockMarketEye’s memory limit which may
help things to run normally. Here’s how.

• Changing Memory Settings on Windows
• Changing Memory Settings on Max OS X
• Changing Memory Settings on Linux

9.10.1 Changing Memory Settings on Windows

1. Quit StockMarketEye.

2. Go to the folder where StockMarketEye was installed. The default install location is:

Windows 8/7/Vista C:\Users\<your user>\AppData\Local\StockMarketEye
Windows XP C:\Documents and Settings\<your user>\Local Settings\Application Data\StockMarketEye

3. In this folder, is a file called: StockMarketEye.ini. Note that this is a hidden file so when you search for it, you’ll
need to include system/hidden files.

On Windows 7, searching for hidden files is slightly different than the image from Windows Vista below. See
this page for how to include hidden files in search on Windows 7.

4. Open this file with Wordpad and change the following line:

vmarg.1=-Xmx1024m

to read:

vmarg.1=-Xmx1300m

Note that if you set it higher than about 1300m, StockMarketEye may not start.

5. The edited file should now look like this.

vmarg.1=-Xmx1300m

6. Save the file and start StockMarketEye.

7. StockMarketEye should run smoothly now. However, if it still seems noticeably slow, you can change the setting
to an even higher number. The number can be as high as you want but can not exceed the amount of physical
memory (RAM) you have in your computer. Typically you will want to at least have a margin of 1G memory
between this setting and the physical memory of your computer.
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9.10.2 Changing Memory Settings on Max OS X

1. Quit StockMarketEye.

2. Using the Finder, go to the Applications folder or the folder where you have StockMarketEye installed.

3. Ctrl-click (or right-click) on the Application and select with “Show Package Contents”

4. In the new Finder window, navigate to the Info.plist file as shown below. Ctrl-click (or right-click) and open it.
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5. The TextEdit editor will open. Navigate down to the item shown in the image below.
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6. Change the “-Xmx1024M” to “-Xmx2048M”.
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7. Save the file (menu: File -> Save).

8. Start StockMarketEye.

9. StockMarketEye should run smoothly now. However, if it still seems noticeably slow, you can change the setting
to an even higher number. The number can be as high as you want but can not exceed the amount of physical
memory (RAM) you have in your computer. Typically you will want to at least have a margin of 1G memory
between this setting and the physical memory of your computer.

9.10.3 Changing Memory Settings on Linux

1. Quit StockMarketEye.

2. Go to the folder where StockMarketEye was installed. The default install location is:

Linux /home/<your_user>/StockMarketEye

3. In this folder, you’ll find a file called: StockMarketEye.sh

4. Open this folder with a text editor (gedit, emacs, etc) and change the following line:

JAVAMEM=-Xmx1024m

to read:

JAVAMEM=-Xmx2048m

5. Save the file and start StockMarketEye.

6. StockMarketEye should run smoothly now. However, if it still seems noticeably slow, you can change the setting
to an even higher number. The number can be as high as you want but can not exceed the amount of physical
memory (RAM) you have in your computer. Typically you will want to at least have a margin of 1G memory
between this setting and the physical memory of your computer.

9.11 How To Change The Locale

StockMarketEye formats dates and numbers based on your computer’s location settings. Theses settings are appro-
priate for most users. However, you may wish to change them to get a formatting that is more appropriate for your
needs.

Note: The number of decimal places to be displayed as well as if a thousands separator should be displayed can be
changed in the Preferences -> Visuals tab.

By setting a specific locale, you can determine how numbers and dates will be formatted. For example, in English,
the period (.) is used as the decimal separator and the comma (,) is used as the thousands separator. However in many
non-English locales the comma (,) is used as the decimal separator and a period (.) is used as the thousands separator.

StockMarketEye will autmatically choose a locale based on your computer’s location settings. If you want to use a
different locale in StockMarketEye, you first need to determine which locale you want to use.

A locale is made up of 2 parts; a language and a country. Language is specified as a lowercase 2 letter abreviation, i.e.
‘en’ for English, ‘de’ for German, ‘sv’ for Swedish. Country is specified as an uppercase 2 letter abreviation, i.e. ‘US’
for the United States, ‘DE’ for Germany, ‘SE’ for Sweden.

For example, if you wanted to use French number and date formatting, you would choose ‘fr’ as the language and
‘FR’ as the country. If you wanted to use Canadian French number and date formatting, you would choose ‘fr’ as the
language and ‘CA’ as the country.
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Note: You can see a full list of locales on the following page. In the “Locale ID” column the first 2 lowercase letters
are the language and the last uppercase letters are the country.

List of supported Locales

• Changing Locale on Windows
• Changing Locale on Max OS X
• Changing Locale on Linux

9.11.1 Changing Locale on Windows

1. Quit StockMarketEye.

2. Go to the folder where StockMarketEye was installed. The default install location is:

Windows 8/7/Vista C:\Users\<your user>\AppData\Local\StockMarketEye
Windows XP C:\Documents and Settings\<your user>\Local Settings\Application Data\StockMarketEye

3. In this folder, is a file called: StockMarketEye.ini. Note that this is a hidden file so when you search for it, you’ll
need to include system/hidden files.

On Windows 7, searching for hidden files is slightly different than the image from Windows Vista below. See
this page for how to include hidden files in search on Windows 7.

4. Open this file with Wordpad and add the following lines. Be sure to change the language and country abrevia-
tions to your chosen language and country.

vmarg.8=-Duser.language=<language abreviation>
vmarg.9=-Duser.country=<country abreviation>

5. Save the file and start StockMarketEye.

6. StockMarketEye should now display numbers and dates in the format appropriate to the language and country
settings you have choosen. If you would like to try different settings, you can change the language and country
to different values. If you want to go back to the default setting, letting StockMarketEye automatically choose
the settings, remove the 2 entries you just added from the ini file.
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9.11.2 Changing Locale on Max OS X

1. Quit StockMarketEye.

2. Using the Finder, go to the Applications folder or the folder where you have StockMarketEye installed.

3. Ctrl-click (or right-click) on the Application and select with “Show Package Contents”

4. In the new Finder window, navigate to the Info.plist file as shown below. Ctrl-click (or right-click) and open it.
Be sure to open it with “TextEdit.app” (Open With -> Other -> Applications -> TextEdit).
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5. The TextEdit editor will open. Navigate down to the bottom of the file and add the following 2 lines in the
location shown in the next screenshot.

<string>-Duser.language=language-abreviation</string>
<string>-Duser.country=country-abreviation</string>

Remember to change the language-abreviation and country-abreviation to your chosen language and country.

6. Save the file (menu: File -> Save).

7. Start StockMarketEye.

8. StockMarketEye should now display numbers and dates in the format appropriate to the language and country
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settings you have choosen. If you would like to try different settings, you can change the language and country
to different values. If you want to go back to the default setting, letting StockMarketEye automatically choose
the settings, remove the 2 entries you just added from the ini file.

9.11.3 Changing Locale on Linux

1. Quit StockMarketEye.

2. Go to the folder where StockMarketEye was installed. The default install location is:

Linux /home/<your_user>/StockMarketEye

3. In this folder, you’ll find a file called: StockMarketEye.sh

4. Open this folder with a text editor (gedit, emacs, etc) and change the following line near the top:

JAVAOTHERS=

to read:

JAVAOTHERS=”-Duser.language=<language-abreviation> -Duser.country=<country-abreviation>”

5. Save the file and start StockMarketEye.

6. StockMarketEye should now display numbers and dates in the format appropriate to the language and country
settings you have choosen. If you would like to try different settings, you can change the language and country
to different values. If you want to go back to the default setting, letting StockMarketEye automatically choose
the settings, remove the 2 entries you just added from the ini file.
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